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Chapter 1
Overview

Welcome to the Tracker User Guide for Property and Casualty users.

This chapter describes:

• Document Conventions on page 20

• Tracker on page 21

• The Tracker Modules on page 22

• SERFF Integration on page 26

• Using a DMS with Tracker on page 27

• Tracker Training on page 28

• Tracker Documentation on page 29

• Using the Online Help on page 30
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Document Conventions

Tips, Notes, Important Notes and Warnings

Tip: A Tip provides a better way to use the software.

Note: A Note contains special information and reminders.

Important: An Important note contains significant information about the use and 
understanding of the software.

Warning: A Warning contains critical information that if ignored, may cause errors or result 
in the loss of information.

Other Document Conventions
• Microsoft Window names, buttons, tabs and other screen elements are in 

bold, for example: Click Next.

• paths, URLs and code samples are in the Courier font, for example:  
C:\Windows

• values that you need to enter or specify are indicated in the italicized 
Courier font, for example, server_name

• values that are optional are indicated with square brackets, for example 
[reserved] 
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Tracker

Tracker is compliance automation software that automates and accelerates the 
state filing processes. 

Tracker’s filing automation includes:

• Ability to manage filings in a centralized repository providing a single point 
of access to compile and store all documentation. 

• Access to a full comprehensive regulatory filing knowledge base covering 
55 states and jurisdictions. The knowledge base provides all filing forms and 
filing regulations and is maintained and updated by Oracle’s insurance 
compliance professionals. 

• Ability to access a wide range of management and production reports to 
view filings, rates, rules, or forms, and monitor productivity and speed to 
market.

• Ability to record and monitor a filing’s history through customizable 
activities. 

Tracker provides the only third party direct integration with SERFF, (the System 
for Electronic Rate and Form Filings). Tracker leverages and extends SERFF. It 
enables carriers to further accelerate speed to market by automating the product 
development and state filing preparation process and utilize SERFF for electronic 
filings with the Departments of Insurance. Tracker provides a quicker way to get 
your filings to the Departments of Insurance utilizing a start to finish process. 
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The Tracker Modules

Tracker the following interrelated modules:

• Filing Module on page 22

• Publications on page 24

• Reports on page 24

• Regulatory Specialist on page 24

• Administration on page 25

Filing Module
The Filing Module is comprised of three levels in which you can create, store and 
track filing submissions to the Departments of Insurance. These levels are:

• the Top level

• the Filing Group level

• the Filing level

The Top level allows you to select the programs that you want to work with and 
identifies a filing at its broadest level as a part of one of your company's overall 
insurance programs. The second level, called the Filing Group, stores high-level 
information regarding a group of related filings that are part of that program. The 
third level, called the Filing level, stores individual filings within a filing group.

Individual filings are classified by the State, Line of Business, Company and 
filing content (form, rate, rule) with which they are related. There may be multiple 
filings within a single filing group and multiple filing groups within a single 
program. 

Imagine a filing cabinet where the cabinet is identified as the program you are 
working with. The drawers in this cabinet are the filing groups that store high 
level information about a group of related filings. In each drawer you would store 
individual file folders that can represent the filings classified by State, Line of 
Business, Company and filing content.



THE TRACKER MODULES

TRACKER P&C VERSION 6.6 USER GUIDE  23

Finding a particular filing record is both quick and easy. When you first log in to 
Tracker, the Top level allows you to specify a program, and to view a list of all the 
filing groups within that program. You can then select a filing group and move to 
the next level — the Filing Group level. Here you can view a list of all the filings 
within that particular filing group. You can then select a filing and move to the 
third level — the Filing level. Here you can view detailed information pertaining 
to that filing alone.

Additional My Filings tabs, found at the Top level and Filing Group level of the 
system, organize your Tracker filings further by listing the filings specific to you 
alone. They can even be filtered to show only filings of a particular status, or only 
filings showing a suspense date (indicating a pending activity), so that you can see 
immediately what you need to do, and where to find it.

For more information, see:

• Programs and Filing Groups on page 115

• Working with Filings on page 125

• Working with Common Filing Tasks on page 211

• Working with Activities on page 229

• Understanding Filing Letters on page 351

• Working with Filing Profiles on page 375

Filing Groups

Filing Letters
Rates, Rules, Forms
Supporting 
Documentation
Filing Forms
Activities

Filings

Program
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Publications
The Publications section of the system (accessible via the View menu) stores all 
of the information about the publication you receive and refer to in one well-
organized place. Here you can view detailed information about a single 
publication record, or browse through your publication records to locate the 
information you need.

Publications such as bulletins, regulations, advance and approved laws as well as 
circulars issued by rating and advisory organizations can be entered into Tracker 
as they are received by your company to track state insurance changes as well as 
rating/advisory organization actions that impact your programs and practices. 
Such publications can be linked to each other and they can also be linked to 
related filings which might be necessary to comply with the legislative changes or 
to adopt the rating/advisory organization changes.

See Working with Publications on page 359 for more information.

Reports
Tracker has a robust reporting module, allowing users, managers and 
administrators to generate a number of reports to meet a variety of needs. 

The main Reports module in Tracker is divided into three categories: Status, 
Historical and Management Reports. 

Other reports in Tracker are located in the Admin Menu (available only to Tracker 
administrators) and in the Regulatory Specialist. 

For more information, see: 

• Searching, Reporting, and Filing Summary on page 423

• Administrative Reports on page 106

• Working with the Regulatory Specialist on page 401

Regulatory Specialist
The Regulatory Specialist module is used to keep all the state regulatory 
information you require for filings at hand in an easy to read tab format. The 
Regulatory Specialist is a knowledge based database which contains 
comprehensive state by state, line of business-specific regulatory information 
crucial to the filing process. 

This database:

• provides background logic information that is used in creating filings

• is searchable, to provide additional information to you whenever you need it 
during your day to day filing processes.

Regulatory Specialist updates are provided as frequently as required. You access 
the updates from a secure server. You can schedule the days and times for 
downloading the updates, or you can access the updates whenever you choose.

See Working with the Regulatory Specialist on page 401 for more information.
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Administration
You use the Administration module to configure Tracker. This module includes:

• System Defaults on page 35

• Security Access Levels on page 50, including user security

• Company Information on page 54

• User Profiles on page 75

• Custom Tables on page 83

See The Administration Module on page 33 for more information.



OVERVIEW

26 TRACKER P&C VERSION 6.6 USER GUIDE

SERFF Integration

Tracker is fully integrated with SERFF (System for Electronic Rate and Form 
Filing) a Web-based filing service maintained by the NAIC. Instead of having to 
log on to the SERFF application to submit and manage your filings, you only need 
to use Tracker to submit and manage all aspects of your SERFF filings. All 
communication between the state Departments of Insurance (DOI) is contained 
and managed within Tracker.

Help with SERFF Functionality
If you are having problems with submitting SERFF filings in Tracker, please 
contact Customer Support: see  on page 32. Please do not contact the NAIC or the 
state DOI directly because they will not be able to help you with any issues related 
to SERFF functionality in Tracker.
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Using a DMS with Tracker

Your system administrator may have configured Tracker to allow you to store 
filing attachments (forms, rates, and rules) in a document management system like 
Oracle IDM. Oracle IDM is a document management system where you and other 
Tracker users can open and save certain files.

If you are configured to use a DMS, a Browse DMS button will be included on 
specific screens that appear when working with attachments.

Note: When you browse the DMS from Tracker, the last folder that was accessed is 
displayed. This includes the last folder that was accessed when a filing is 
generated and moved to the Filing Package tab.
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Tracker Training

Tracker training courses are regularly offered by Oracle at our Mississauga, Ontario 
offices. Alternatively, if you prefer, our training staff can come to your offices and 
present the training course there. Each training course is aimed specifically at 
your segment of the insurance industry, and is designed to take new and 
experienced Filing Analysts through every step of a filing and every facet of 
Tracker. For more information regarding Tracker training, please contact Oracle 
Global Customer Support.
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Tracker Documentation

Tracker includes the following documents and online help files. If you need a 
copy of any of these documents, please contact your system or product 
administrator.

• The Tracker User Guide contains overviews, step-by-step procedures and 
descriptions of the screens and fields.

• The Tracker Online Help contains the same information as the User’s 
Guide, but in an online help format with a search tool, an index and a table 
of contents.

• The Tracker Release Notes include general product information, product 
enhancements and new features, supported platforms and third-party 
software, assorted considerations, and known issues and limitations.

• The Tracker Installation Guides contain system requirements and detailed 
installation and configuration information. Guides are supplied for new 
installations and upgrades, and for both Oracle and SQL environments.

• The Tracker Technical Guide is for system administrators and includes 
information about the optional DMS, maintaining DMS components, log 
files, error levels and Tracker Monitor, technical information about the 
Regulatory Specialist files and validation process, and troubleshooting 
information.
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Using the Online Help

This section describes how to use the Online Help and includes information about 
these topics:

• The Contents of the Online Help on page 30

• Searching the Help on page 30

• Using the Help Index on page 31

• Using the Help Table of Contents on page 31

• Navigating the Help on page 31

• Printing a Help Topic on page 32

The Contents of the Online Help
The Online Help contains the same contents as the related PDF document, but in 
an online Help format.

To open the Online Help, click the Help menu.

The Help is divided into two frames:

• the left frame displays the navigation tools: Contents, Index and Search

• the right frame contains the contents of each Help topic

There are different ways to find a Help topic:

• Searching the Help on page 30

• Using the Help Index on page 31

• Using the Help Table of Contents on page 31

• Navigating the Help on page 31

Searching the Help
You can search the entire Help contents to find a specific topic.

Method: Search the Help

1. In the left pane of the Help, click the Search tab.

2. Enter the word(s) you want to search for, then click Go! or press Enter.

3. A list of Help topics is displayed in descending order by Rank. The Rank 
indicates how many times the word(s) you searched for appears in a Help 
topic. It can help indicate how relevant the topic may be in your search.

Tip: Use specific words in your search, for example: model document. Avoid using 
plurals, for example, “sections,” because this may limit your search results.
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Using the Help Index
The Help Index contains a listing of all the Help topics in alphabetical order.

Method: Use the Help Index

1. In the left pane of the Help, click the Index tab.

2. Click the letter that corresponds to the topic you are searching for. You 
cannot select a letter that is greyed out, because it contains no index entries.

3. A list of all index entries beginning with the letter you selected is displayed.

4. Scroll to the index entry of the topic you are searching for.

5. Click the topic to view its contents in the main body of the Help.

Using the Help Table of Contents
When you open the Help, the Contents are displayed. The Contents contain main 
topics and their subtopics.

Each main topic appears as a book icon:

Each subtopic appears as a page icon:

Subtopics can also appear as book icons. In other words, books can appear within 
other books.

You can open a book by clicking a book icon or the text next to the book icon. 
This will expand the book and display the topics within that book. 

To close an open book, click the book icon. The book “collapses”, hiding the 
topics within the book.

Tip: When a Help topic is displayed, you can click the “Show in Contents” button to 
open the corresponding book that contains the displayed Help topic:

Navigating the Help
To go to the next or previous Help topic in the Contents, use the Next and 
Previous buttons in the right pane of the Help:

To go to the next or previous topic that you have viewed, use the Forward and 
Back buttons in your Web Browser.
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Printing a Help Topic
You can print a Help topic in case you want to refer to it later.

Method: Print a Help topic

1. Click the Print icon in the upper-right corner of the Help:

2. The Print dialog box is displayed.

3. Click Print to print the Help topic. 

 

     



TRACKER P&C VERSION 6.6 USER GUIDE  33

Chapter 2
The Administration Module

This chapter provides background information and complete instructions for using 
all of the features of the Administration menu. As the name implies, the 
Administration menu is your access point to Tracker’s system-wide and user-
specific settings. This is where the information specific to your company is 
entered and maintained in the Tracker system. This chapter is recommended 
reading for anyone involved in setting up or maintaining a Tracker system.

Note: The Admin menu is available only to users whose security level provides access. 
It will not appear on the screen for users not designated to access it.

Important: It is recommended that administrators limit access to this menu. Changes made to 
central system tables and records here can have a widespread impact throughout 
your Tracker system.

This chapter describes:

• Initial Setup on page 34

• System Defaults on page 35

• Security Access Levels on page 50

• Company Information on page 54

• SERFF Settings on page 66

• User Profiles on page 75

• Custom Tables on page 83

• Reassigning Activities on page 105

• Administrative Reports on page 106



THE ADMINISTRATION MODULE

34 TRACKER P&C VERSION 6.6 USER GUIDE

Initial Setup

Because Tracker is designed to be highly flexible and to conform to the needs of 
your company, you need to perform customization on the following screens after 
completely installing Tracker before you allow users to begin working in it:

1. System Defaults: see System Defaults on page 35

2. System Security: see Security Access Levels on page 50

3. Company Information: see Company Information on page 54

4. SERFF System Defaults: see SERFF Settings on page 66

5. RS Update Settings: see Regulatory Specialist Updates on page 41

6. User Profiles: see User Profiles on page 75

7. Custom Tables: see Custom Tables on page 83

For some of the required information, you may need to contact your IT 
department.

Note: Oracle Global Support can help you with the system setup process.
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System Defaults

This section describes how to define certain system default settings that will apply 
to every Tracker user. These settings are found on the System Defaults dialog. 
Access the System Defaults dialog by clicking Admin > System Information > 
System Defaults.

There are five tabs on the System Defaults dialog:

• Settings on page 35

• Custom Field Labels on page 38

• RS Custom Field Labels on page 40

• Regulatory Specialist Updates on page 41

• Profile Affiliation Criteria on page 48

Settings
On this tab you can perform the following tasks:

• Defining a Group Name on page 35

• Configuring the Display of Filings with Suspense Activities on page 36

• Displaying or Hiding Canadian Provinces on page 36

• Setting User ID and Password Authentication on page 37

Defining a Group Name
The field Group Name is included within the System Defaults tab. If this field is 
populated, Tracker will pass the value in this field to SERFF.

Method: Define a group name

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

2.  Enter the Group Name.

3. Click OK.
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Configuring the Display of Filings with Suspense Activities
Using the Show all suspended check box, you can set up Tracker to always 
display, in the My Filings and Filings tabs, one of the following sets of filings 
with suspense activities:

• filings with suspense activities that require action, regardless of date

OR

• filings with suspense activities that require action, up to the current date

The second option is the default setting when Tracker is first installed.

Method: Configure the display of filings with suspense activities

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

2. To show in the My Filings and Filings tabs filings with suspense activities 
regardless of date that require action, select the Show all suspended check 
box.

OR

To show in the My Filings and Filings tabs only those filings with suspense 
activities up to the current date that require action, clear the Show all 
suspended checkbox.

3. Click OK to save the settings.

Displaying or Hiding Canadian Provinces
Tracker allows you to create, submit, and track filings for Canadian provinces. 
There is a check box in System Defaults which allows you to specify if Canadian 
provinces appear in Tracker. By default, this check box is not selected. If you need 
to create filings for Canadian provinces, you will need to select this check box. 

If provinces are displayed, then provinces are available within most parts of 
Tracker just as states are. This means they are available when companies are being 
created in Tracker, and within filings. However, note that no regulatory 
information on provincial filings is maintained within Tracker.
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Method: Display or hide Canadian provinces

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

2.  To display Canadian provinces, select Show Canadian Provinces.

3. To hide Canadian provinces, deselect Show Canadian Provinces.

4. Click OK to save your changes and close System Defaults.

Setting User ID and Password Authentication
You can select a Windows Authentication option for the Tracker logon. With this 
option, a user’s Windows ID and password are used to access Tracker. Users will 
no longer need a separate user ID and password for Tracker.

In addition to ease of use for users, the main benefit of this option is that your 
company can systematically enforce your password update policy, without any 
additional set up or configuration in Tracker.

By default, the Windows Authentication option is not enabled. 

Method: Enable Windows Authentication

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2.  Select the Use Windows Logon check box.

3. Click OK to save your changes and close System Defaults.

Note: If you do not select Use Windows Logon, no password change will automatically 
occur or be enforced in Tracker. When a user changes their Windows password, it 
will not be passed into Tracker; the user’s Tracker password would stay the same 
until changed. See Changing Your Tracker Login Password on page 113. 

Important: The logon setting applies to all Tracker users. A user cannot select their own logon 
preference. The logon setting selected at the Admin level controls which fields are 
then enabled on each user’s profile. 

Custom Field Labels
Custom fields allow you to capture and store additional information pertinent to 
your company and the way you perform filings.

You are able to change the label name of the custom fields to reflect the value 
captured in those fields. The value you enter for the custom field label is the text 
that will appear beside the corresponding custom field in Tracker. The custom 
field labels are organized according to where they are located in Tracker.

Method: Define or edit custom field labels

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2.   Click the Custom Field Labels tab.

Each field on the tab corresponds to custom fields in that part of the Tracker 
system. In each custom field box, enter the name that you would like to 
appear as the field label in that part of the system.

For example, to store your company’s courier account number, enter a value 
of “Courier Acc” in Company. When you view the Company Information 
window, there will be a new field label of Courier Acc.

3. When finished, click OK.

Note: You will have to log out of Tracker and log back in to see any changes made in the 
custom field labels at the Filing Group level.
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RS Custom Field Labels
You can assign a custom name to the tab and to each of the free format fields in 
the RS Custom Fields within the Regulatory Specialist.

Method: Change RS custom field labels

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

2. Click the RS Custom Field Labels tab.

3. Make any necessary changes.

4. When finished, click OK.

For more information about these fields, see RS Custom Fields on page 413.

Enter custom 
tab name here Enter custom field 

labels here
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Regulatory Specialist Updates
Regulatory Specialist updates are provided as frequently as required. You access 
the updates from a secure server. You can schedule the days and times for 
downloading the updates, or you can access the updates whenever you choose.

The Regulatory Specialist update server can trigger emails (from your email 
server) to let your users know that an update has occurred. The email will include 
a Read Me file with information about the update.

The following sections describe how to configure Tracker to use Ad Hoc 
Regulatory Specialist Updates.

• Configuring Ad Hoc Regulatory Specialist Updates on page 41

• Manually Accessing Regulatory Specialist Updates on page 44

• Configuring Tracker to Access the Regulatory Specialist Update Server on 
page 45

Configuring Ad Hoc Regulatory Specialist Updates
Complete the following steps to activate and configure Ad Hoc Regulatory 
Specialist updates.

Method: Configure Ad Hoc regulatory specialist updates

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

2. Click the RS Update Settings tab. 

The RS Update Settings tab displays.
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3. Check the Use Ad Hoc Regulatory Specialist Update check box to activate 
the Regulatory Specialist Update feature.

Important: When you select this check box, it disables the previous manual monthly 
download option. You cannot revert back to the monthly option once you have 
successfully performed an ad hoc download.

4. In the Login Settings to Access the Update Server section: 

• You can view the URL of the Regulatory Specialist update server where 
the updates are stored and accessed: the default path is:
https://trackerupdate.insystems.com/TrackerServices2/
CabUpdate.asmx

• Enter the User Name and Password provided by Oracle that Tracker 
will use to access the Regulatory Specialist update server. The password 
is encrypted before being transmitted to ensure security.

5. Enter the Subscription Update Settings:

• Send status emails from – The email address of the person within your 
organization from whom the emails regarding an update should be sent. 

• Keep logs for __ days – The number of days that the system should 
retain the logs which contain the download history for each update. We 
recommend that you enter a value of 30. The system will automatically 
delete the logs after the specified number of days. 
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6. Select your schedule preferences in the Schedule Automatic Updates 
section:

• Use schedule – Select Use schedule if you want the system to 
automatically retrieve the updates. If you do not select this option, you 
will still be able to access the Regulatory Specialist update server and 
apply the updates, but you will need to use the manual process: see 
Manually Accessing Regulatory Specialist Updates on page 44.

• Start time and End time – The time range and day(s) in which you 
want the system to download any available updates.

Note: We recommend that you allow for a period of at least two hours during which all 
users must be logged out of Tracker.

If any users are logged into Tracker when the download is scheduled to 
occur, the download process will fail but the system will periodically 
retry the download during this time range. If the users log out before the 
download period ends, the system will process the available downloads. 

If any user remains logged into Tracker during the entire time range, no 
downloads will be applied. An email will be sent to the users indicating 
that a download was attempted but failed. The user(s) logged in will not 
be identified in the email. You can then decide if you want to attempt to 
manually obtain the downloads or simply wait until your next regularly 
scheduled interval.

• Occur every _ weeks - Enter the frequency with which you want your 
system to automatically query the Regulatory Specialist update server 
and download any available updates. You can select 1, 2, 3 or 4 weeks. 

You also need to specify the day(s) of the week on which you want this 
update process to occur. For example, suppose you choose:

Occurs every 1 week(s) on Sunday, Tuesday and Thursday

In this case, your system will query the Regulatory Specialist Update 
Sever once a week, every Sunday, Tuesday and Thursday. If there any 
available updates during this time, the system will automatically update 
your system with the revised information. If there are no updates during 
this time, no downloads will occur. 
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Note: If you select to use the schedule, you must make a selection for 
both the number of weeks and the day(s). If you fail to make both these 
selections, the system will prompt you with a warning and you will be 
unable to close the tab until you make a selection.

If there are downloads available which you try to access according to 
your schedule, the system will send you a download status email 
indicating the number of downloads that were attempted, and whether 
each attempt was successful. If there is more than one download 
attempted within a single scheduled period, only one email will be sent 
for that download session.

Manually Accessing Regulatory Specialist Updates
If you do not want to configure the system to automatically retrieve and apply the 
updates on a scheduled basis, you can still retrieve and apply the updates, but you 
will need to do this manually.

If you do use scheduled updates but you need to retrieve and apply an update 
outside of the schedule you have set up, you need to complete the following 
procedure and select the available update(s).

Method: Manually access the Regulatory Specialist updates

1. Select Admin > Load >Subscription. 

The Update Regulatory Specialist displays.
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The update files listed here are all the updates that Oracle has published to 
the Regulatory Specialist update server since your last download (manual or 
scheduled), and any previous updates you didn’t download.

2. Select the update(s) that you want to download by highlighting them while 
holding the Shift key. 

Note: You cannot select updates out of order or skip any updates.

3. Click Start Update.

The selected updates will begin downloading.

If you click Cancel during the download, the update file currently being 
downloaded will still be processed. Any remaining updates will not be 
downloaded.

When the download is completed, a status email will be sent. It will indicate 
whether the download session was successful or not, and include a 
cumulative ReadMe file.

Configuring Tracker to Access the Regulatory Specialist 
Update Server
This section describes the information that Tracker requires for the 
communication between your server and the Regulatory Specialist Update server.

There are two areas within Tracker that you need to configure with the required 
information:

• Tracker Monitor Settings on page 45

• Proxy Settings on page 46

These settings correspond to the tabs on the Server Settings dialog.

Tracker Monitor Settings
The Tracker Monitor is a Windows Service application which controls the 
communication between Tracker and the Regulatory Specialist Update Server. 
When set to use Automatic Updates, the Tracker Monitor queries the Regulatory 
Specialist Update Server for any available updates and if it finds an update, 
retrieves it and applies it to your system.

The Tracker Monitor also connects with your mail server to send emails to your 
users about the number of downloads that were attempted and their success or 
failure.

The following procedure is used to configure the Tracker Monitor connection 
settings.

Method: Configure the Regulatory Specialist Tracker Monitor 
settings

1. Select Admin > System Information > System Defaults.
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The System Defaults dialog displays with the Settings tab displayed.

2. Click the RS Update Settings tab.

3. Click Advanced Settings.

The Server Settings dialog displays.

4. In the Tracker Monitor Settings tab, enter a unique Server Name and set 
Server Port to 8989 for the Tracker Monitor Service.

5. Enter the name of the Mail Server that will be used to notify users 
regarding the Regulatory Specialist updates.

Proxy Settings

If you use a proxy server to access the Internet, you will need to configure the 
proxy settings.

Method: Configure the proxy settings

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.
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2. Click the RS Update Settings tab. 

3. Click Advanced Settings.

The Server Settings dialog displays.

4. Click the Proxy Settings tab.

5. Select the Use Proxy Server check box.

The Proxy Server settings become active.

6. If you are using a proxy server script, select the Proxy Script check box and 
enter the URL of the script. For example, http://host_name/PAC/proxy.pac.

7. If you are using manual proxy settings, select the Manual check box and 
enter the proxy Server Name and Port.

8. Select the Authentication type used by your organization:
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• For basic username/password security, select Basic Authentication. 
Enter the user name and password which the proxy uses to access the 
Internet. Your IT department will have this information.

• To use Windows Authentication, simply select this option.

9. Click OK.

If you use a proxy server to access the Internet, the information entered here 
will be used to populate the Proxy Settings tab within the SERFF System 
Defaults tab.

10. Click OK.

The System Defaults dialog closes.

Profile Affiliation Criteria
You can set up Tracker so that users will only see the filing profiles for the LOBs 
or states that are assigned to them. To assign specific LOBs or states, see 
Configuring Profile Affiliation on page 77.

You can also set the maximum number of hours a filing profile can be outstanding 
before it is automatically displayed when the user logs on.

1. Select Admin > System Information > System Defaults.

The System Defaults dialog displays with the Settings tab displayed.

2. Click the Profile Affiliation Criteria tab.
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3. To select which profiles that all users will see, select one of the following 
items in the Affiliate Profiles By area: 

• if you want all users to see the filing profiles that only contain the LOBs 
assigned to them, select LOB

• if you want all users to see the filing profiles that only contain the states 
assigned to them, select State

• if you want all users to see all the filing profiles, select None

4. To specify the maximum number of hours a filing profile can be outstanding 
before it is categorized as outstanding, enter a value in the View all profiles 
outstanding for more than _hours field.

This value applies only to user levels that have been configured to view 
unassigned and outstanding filing profiles. For more information, see Security 
Access Levels on page 50.
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Security Access Levels

Initially, you determine what functional user levels are required at your company 
location, and then assign various security settings for these user levels.

This section describes

• Understanding Security Settings on page 50

• Configuring Security Access Levels on page 51

Understanding Security Settings
Each security access level has three types of security settings: generic, SERFF-
specific, and Filing Profile-specific.

Generic security settings
• Read/View filing data

• Edit/Modify/Append filing data

• Add/New/Create filing data

• Delete/Erase filing data

• View administrative functions

• Perform administrative functions

• Perform subscription loading

• Remove from Filing Package tab (activities)

• Add/Edit content in Regulatory Specialist custom fields

SERFF-specific security settings
• Delete My SERFF Messages (from the SERFF messages tabs)

• Delete All SERFF Messages (from the SERFF messages tabs)

• Set EFT Authority Level

Filing profile-specific security settings
• Accept/Reject/Suspend filing profiles

• View filing profiles

If a user accepts the filing profile, Tracker creates the appropriate filings 
automatically, including the filing documents attached to the filing profile and any 
required state filing forms. 

If a user rejects the filing profile, a reason for the rejection is required and the 
filing profile is returned to Launcher for revision and resubmission to Tracker. 

If a user suspends the filing profile, they can defer reviewing the filing profile.
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If enabled, users can view filing profiles based on the states or LOBs affiliated 
with them. See Profile Affiliation Criteria on page 48.

Configuring Security Access Levels
Tracker employs a flexible security system that allows your company to 
customize each of 10 access levels to reflect the hierarchy of your organization. 
Each level can be configured to allow access to a given set of Tracker tasks, so 
that users can see and use only the functions necessary to them, streamlining the 
access and processes and enabling tight control of the filing process within your 
departments.

This section describes:

• Defining Security Access Level Titles on page 51

• Defining Security Access Levels on page 52

• Assigning User Access Levels on page 53

Defining Security Access Level Titles
You can change the default access level titles to match titles used in your 
organization.

Method: Define an access level title

1. Select Admin > System Information > System Security.

The Security Access Levels dialog displays.
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2. Click Rename Levels.

The Rename Security Levels dialog displays.

3. Click the title you want to rename and click Rename.

4. Type in the desired new level title and press Enter.

5. Repeat steps 3 and 4 to rename other security levels.

6. When finished, click Close.

Your changes are saved.

7. Click OK to exit the Security Access Levels dialog.

Defining Security Access Levels
For each access level, you can define which activities can be performed within 
Tracker. 

Method: Define a security access level

1. Select Admin > System Information > System Security.

The Security Access Levels dialog displays.
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2. Click the tab for the security access level for which you want to define 
permitted functions.

3. Select the check boxes beside all the functions you want this level of user to 
be able to perform. 

Note: As indicated in this dialog, message suppression functionality applies only to 
SERFF filings created in Tracker 6.1 and 6.3.

4. Repeat steps 2 and 3 for each security access level you have defined.

5. Click OK to save your information and exit the dialog box.

Assigning User Access Levels
Users are assigned a specific security access level on their User Profile dialog 
screens. See Adding New User Profiles on page 75 for details.     
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Company Information

This section describes:

• Understanding Company Information on page 54

• Adding New Companies on page 54

• Understanding Company Codes on page 56

• Entering or Editing General Information for Companies on page 56

• Entering or Editing Authority Information for Companies on page 59

• Entering or Editing Resource Information for Companies on page 62

• Deleting Companies on page 63

• Accessing Existing Company Information Records on page 64

Understanding Company Information
The Company Information screens are where you enter all of the pertinent 
information about the companies for which your company prepares filings. There 
is a separate company information record for each company, office, or location. 
This information is divided into the following types, located on the corresponding 
tabs: 

• General information, which includes basics such as address and company 
code

• Authority information, which includes the states and lines of business in 
which each company is licensed to sell insurance

• Resources, which lists the names of personnel occupying various positions 
within the company

Important: All company information must be entered into the Tracker system during the 
initial system set up. You cannot begin to create and manage filings within 
Tracker until this information is in place.

Adding New Companies
You must add at least one company before you can start working with filing 
groups and filings.

Method: Add a new company 

1. Select Admin > Company Information.

The Companies dialog displays.
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2. Click Add.

The Company Information dialog displays.
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3. Enter General Information and Authority Information. (See detailed 
directions in Entering or Editing General Information for Companies on 
page 56 and Entering or Editing Authority Information for Companies on 
page 59).

4. Assign Resources. (See detailed instructions in Enter resource information 
for a new company on page 62).

5. Click OK to save your data and return to Companies.

6. Repeat steps 2 to 5 to add additional companies.

7. When finished, click Close.

Understanding Company Codes
Each company you file for must be assigned a unique two-character code for easy 
identification within Tracker. When you enter a new company into the system, be 
sure to choose a new code which you have not already used to identify another 
company. Any combination of numbers and letters in the two-digit code is 
acceptable (with the exception of the reserved system code (CG).

In addition, each company can have an NAIC Code. If you enter an NAIC Code, 
Tracker ensures that it is 5 digits long and that you have not already used the same 
NAIC Code to identify another company. 

Note: In the absence of an NAIC Code, SERFF will use the company’s Federal 
Employer Identification Number (FEIN). 

Entering or Editing General Information for 
Companies
This section provides detailed directions for entering general information on a 
new company or updating the general information for an existing company.

Method: Enter or edit general information for a company

1. Select Admin > Company Information.

The Companies dialog displays.
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2. Click Add to create a new company, or select an existing company and click 
Edit.

3. On the General tab of the Company Information dialog, enter the Name of 
the company and a unique, two-digit Company Code.

4. Enter the company’s Main Address, and then the company’s secondary or 
Alternate Address if applicable.

5. Enter Contact information for the company:

• Enter company’s main Phone Number, Toll-Free Phone Number, Fax 
Number, and URL. (Formatting rules apply.)

• Enter the company’s NAIC Group Code and the NAIC Code (the 
NAIC company code), if applicable.

• Enter the company’s Federal Employer Identification Number (FEIN). 
The correct format is NN-NNNNNNN, where N is a numerical digit.

• Enter the company’s State of Domicile.

6. Enter Company Type. If populated, the field will be passed to SERFF on 
each filing. This field can be used to capture information about what type of 
insurance a company is licensed to write. Typical values include Property & 
Casualty, Life, Health, and so on.

7. If you have registered with the NAIC to pay filing fees by EFT for this 
company, enter the UNID number assigned by the NAIC in Payer UNID.

8. If you want this company to be the default company to which the EFT filing 
fee payment is allocated for company group filings in states which charge 
the filing fee on a per company basis, select the Primary EFT check box.
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If you want to allocate the filing fee across several companies in such 
filings, leave this check box cleared. 

9. Click Edit Departments.

The Departments dialog displays.

10. To create a new department, click Add, or select an existing department and 
click Edit. 

The Company Department dialog displays.

11. Enter the Name of this department. Modify any other information as 
required. 

12. Click OK to save the department information.

13. Repeat steps 10 to 12 until you have made all required additions or 
modifications.

14. When finished, click Close.

15. Click Apply to save the information you have just entered.

16. If finished entering information, click OK, then click Close. 

OR
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To continue setting up a new company, select the Authority tab, and 
proceed to enter authority information. (See Entering or Editing Authority 
Information for Companies on page 59.)

Entering or Editing Authority Information for 
Companies
This section provides detailed instructions for entering authority information 
when adding a new company. This method can also be used to update the 
authority information for an existing company.

Method: Enter authority information for a new company

1. Select Admin > Company Information.

The Companies dialog displays.

2. Click Add to create a new company, or select an existing company and click 
Edit.

3. Click the Authority tab.

The Authority tab displays.
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4. Click Add (located below State ID).

The Company State Authority dialog displays.
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5. On the list of Available States, select the states in which this company is 
licensed to sell insurance and move them to the Licensed States list by 
using the right arrow button.

Clicking on the double arrows will move all entries.

6. When all of the states for which the company is licensed appear in the 
Licensed States list field, click OK to return to the Authority tab. 

The selected licensed states will now appear in the list field at the left of the 
tab.

7. To enter or modify the State ID for a state, click the state in the list, enter the 
state identification code for this company in the text box, and click Update.

 If entered, the State ID will be sent to SERFF.

8. To add LOBs to a state for this company, click the Add button located near 
the bottom of the tab.

9. The Company LOB Authority dialog displays.

10. From the Available LOB list, select the lines of business for which this 
company is licensed to sell insurance in this state and move them to the 
Licensed LOB list using the right arrow button.

Clicking on the double arrows will move all entries.

11. When all of the lines of business for which the company is licensed in this 
state appear in the Licensed LOBs list field, click OK to return to the 
Authority tab.

The selected licensed lines of business will now appear attached to the 
selected state in the list on the left.

12. Repeat steps 7 through 11 for each state listed.
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13. To remove a state (and all lines of business attached to it) from the list, 
select the state and click Delete. Click Yes to confirm.

14. When finished, click OK to save your information, and then click Close.

Entering or Editing Resource Information for 
Companies
This section provides detailed instructions for entering resource information when 
adding a new company. This method can also be used to update the resource 
information for an existing company.

Note: Resource information can be added to a company record only after user profiles 
have been entered into the system. See User Profiles on page 75.

Method:  Enter resource information for a new company

1. Select Admin > Company Information.

The Companies dialog displays.

1. Select a company and click Edit.

2. Click the Resources tab.
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3. For each resource applicable to this company, select a name from the related 
drop-down list.

4. Click OK to save your resource information and exit Company 
Information.

Deleting Companies
You can delete an existing company, as long as it does not have any filings 
associated with it.

Important: Companies already associated with filings should never be deleted, as this might 
cause record tracking difficulties. Contact Oracle Global Support if you have any 
questions.

Method: Delete a company

1. Select Admin > Company Information.

The Companies dialog displays.
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2. Click the company you want to delete.

3. Click Delete.

If this company does not have any filings associated with it, a confirmation 
dialog displays.

4. Click Yes to confirm the deletion (or No to cancel).

The updated Companies list displays.

5. Repeat steps 2 to 4 for other companies you want to delete.

6. When finished, click Close.

Note: If you attempt to delete a company that is in use (that is, it already has filings 
attached to it), a message displays:

Unable to delete this company; it may be in use.

Accessing Existing Company Information Records
You can access existing company information records to review them.

Method: Access an existing company information record

1. Select Admin > Company Information.

The Companies dialog displays.
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2. Select a company from the list and click Edit, or double-click the company 
you want to access.

The Company Information dialog displays.

3. When finished examining the company information, click Cancel, then 
click Close.
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SERFF Settings

In order to submit filings using SERFF, the Tracker administrator must configure 
the Tracker-to-SERFF communication settings. Certain information is mandatory 
for use with SERFF. When you first start Tracker, these SERFF System Defaults 
fields will be blank.

On the SERFF Defaults dialog there are two tabs: System and Attachment 
Format. The following sections describe the settings available and how to 
configure the information within these tabs:

• Understanding the SERFF System Defaults on page 66

• Configuring SERFF System Defaults and SERFF Filing Default Options on 
page 68

• Configuring SERFF Schedule Item Attachment Formats on page 72

Understanding the SERFF System Defaults
The following section describes the fields on the SERFF Defaults dialog.

SERFF SPI Log On ID and SERFF SPI Password
When you have fully registered with the NAIC and have activated your SERFF 
account there, the NAIC will assign you a SERFF SPI Log On ID and 
Password. This combination of log on ID and password is unique to your 
organization, and you will be assigned only one log on ID and password 
regardless of the number of companies you are licensed to file under or the 
number of companies included in a single filing.
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Tracker automatically passes the SERFF SPI Log On ID and Password with 
each filing submitted to SERFF. (The password is encrypted before being 
transmitted to ensure security.) 

Because the SERFF SPI Log On ID and Password are unique to your 
organization, they are used to validate and authenticate your company information 
for filings before they are transmitted to the relevant state DOIs through SERFF. 
The SERFF SPI Log On ID is also used to identify and track your filings in 
SERFF, including tracking the number of transactions you have performed 
through SERFF. Because your filings are uniquely identified within SERFF, 
SERFF can automatically transfer messages on your filings from the relevant state 
DOIs back to you in Tracker.

Filing Rule, State Filing and Attachment URLs
The three URLs listed on the System tab of the SERFF Defaults dialog are for 
SERFF’s production servers. 

The Filing Rule URL is the address of the server where all SERFF filing 
requirements all stored. The states are responsible for entering and updating the 
data on the Filing Rule server. The NAIC is responsible for the actual 
maintenance of this server.

The State Filing URL is the address of the server where your actual state filings 
are stored. The State Filing server is located at the NAIC and maintained by them.

The Attachment URL is also required by the NAIC.

Values for these URLs are provided directly by NAIC upon receipt of a signed 
NAIC SERFF agreement.

Note: The NAIC periodically performs maintenance on the SERFF servers. When this 
occurs, Oracle will email you in advance with the approximate times that the 
maintenance will occur so that users can schedule their SERFF filings 
accordingly.

Hide All Messages After [ ] Days
As you receive messages from SERFF about the status of your filings, they will be 
logged in the Log Entries subtab within the SERFF tab of the filing, and in the 
My SERFF Messages and All SERFF Messages tabs (collectively referred to as 
the Message Center) at the top level of Tracker.

The value you enter in this field is the number of days messages will be displayed 
after the date they were received by Tracker in the Message Center tabs. Messages 
and their contents will always be available for viewing in the filing and within the 
Log Entries subtab of the filing to which they apply. Certain message types such 
as Note to Filer, Objection Letters and Disposition Reports will also appear under 
the Correspondence tab within the filing to which they apply. 

SERFF Filing Default Options
This section contains three settings. Default values can be set by making choices 
from drop-down menus: 
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The default value for Project # has the following choices:

• Company Reference #

• Filing Custom Field

• Filing Group Custom Field

• Filing Description

• Filing Group Description

• Filing Group name

• None

• Tracker Filing ID

The default value for Project Name has the following choices:

• Filing Description

• Filing Group Description

• Filing Group name

• None

• Program Description

The default value for Product Name (for SERFF filings) has the following 
choices:

• Custom

• Filing Description

• Filing Group Description

• Filing Group Name

• None

• Program Description

Configuring SERFF System Defaults and SERFF Filing 
Default Options
To set or make changes to the SERFF System Defaults and SERFF Filing Default 
Options, follow these steps:

Method: Configure the SERFF system defaults settings and SERFF 
Filing Default options

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.



SERFF SETTINGS

TRACKER P&C VERSION 6.6 USER GUIDE  69

2. On the System tab, complete the following fields:

SERFF System Defaults:

• SERFF SPI Log On ID

• SERFF SPI Password

• Filing Rule URL

• State Filing URL

• Attachment URL

• Hide All Messages After # Days

SERFF Filing Default Options:

• Project #

• Project Name

• Product Name

3. If required, configure the EFT Fee Authority Levels. See EFT Fee 
Authority Levels on page 70.

4. Click OK.

The data is saved, and will be applied to every SERFF filing created in 
Tracker.
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EFT Fee Authority Levels
If you will be using EFT to pay filing fees where permitted in SERFF, in addition 
to entering the Payer UNID for each of your companies, (see Entering or Editing 
General Information for Companies on page 56), you need to enter:

• a description for each level within your organization that you want to be 
able to authorize EFT filings

and

• the maximum dollar amount for an EFT filing that the specified level can 
authorize

Important: You can enter as many levels as you need, however, you must enter at least one 
authorization level and maximum amount for the one level. If you do not enter 
any information in this section, the system assumes that EFT has not been 
authorized and no one will be able to use the EFT functionality. 

Note: The EFT Fee Authority level information you enter here controls the options 
which display in the EFT Fee Authorization Level field on the Security Access 
Levels and which then can be affiliated with each access level.

Method: Establish an EFT Fee authority level

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.

2. In the EFT Fee Authority Levels area, click Add. 
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The Authority Level Description field unlocks with a prompt of “Please 
enter the range name for the EFT authority level here,” and a Maximum 
Amount of $0.00.

3. Click the description and type in a meaningful name for this authority level.

4. Click the value to the right and type in the Maximum Amount for this 
level.

Note: This is a per-EFT transaction per-filing maximum. It is not a cumulative 
maximum per user or per filing.

5. Press Enter.

The level is added.

6. Repeat steps 3 to 5 to add additional levels.

7. When finished, click OK.

Configuring Proxy Server Settings (Advanced Settings)

Note: Complete this procedure only if you use a proxy server to access the Internet. If 
you are not sure if you use a proxy server, contact your IT department.

Method: Configure the proxy server settings

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.
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2. On the System tab, click the Advanced Settings button.

The Proxy Settings dialog displays.

3. Select the Use Proxy Server checkbox.

4. Select the Authentication type used by your organization:

• For basic username/password security, select Basic Authentication, 
enter the user name and password which the proxy uses to access the 
Internet. Your IT department will have this information.

• To use Windows Authentication, simply select this option.

5. When finished, click OK.

Configuring SERFF Schedule Item Attachment 
Formats

By default, all schedule item attachments sent to SERFF are converted to PDF 
when you select the Move to Filing Package check box in the Submit to SERFF 
activity dialog box. However, you can use the Attachment Format tab to have 
Excel and/or text schedule item attachments sent in their native file format. 
Specifically, for each state, you can select whether to send such files in their 
native format (Excel or text), and/or as PDFs. If you select PDF and another 
format for a state, the attachments are sent on the same schedule item to SERFF.

Method: Configure the SERFF default schedule item attachment 
formats

1. Select Admin > System Information > SERFF System Defaults.

The SERFF Defaults dialog displays.



SERFF SETTINGS

TRACKER P&C VERSION 6.6 USER GUIDE  73

2. Click the Attachment Format tab.

The SERFF Attachment Formats dialog displays.

3. Configure the default schedule item attachment format(s) sent:

For most states, the SERFF default schedule item attachment format is PDF.
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To change the default schedule item attachment format(s), select or clear the 
Excel and/or Txt Native check boxes for the required states. If required, 
clear the PDF check box after selecting other check boxe(s).

Based on your selections:

• attachments will be converted and sent as PDF files if the PDF check 
box is selected

• Excel files will be sent if the Excel check box is selected

• text files will be sent if the Txt Native check box is selected

Note: You must select at least one check box per state.
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 User Profiles

The Users section contains a listing of all the people at your company who use 
Tracker. Each person must have a detailed user profile in the Tracker 
administrative tables in order to be able to use the system. Each user’s profile 
contains basic identification and contact information for that user.

Adding New User Profiles
User profiles contain essential data about the user, including their security access 
level. The user level determines what they can do in Tracker. (See Security Access 
Levels on page 50.)

Method: Add a new user profile

1. Select Admin > Users.

The Users list dialog displays.

2. Click Add.

A blank User Profile dialog displays.
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3. Select the prefix for this person (for example Mr. or Ms.) from the Prefix 
drop-down list.

4. Enter the Name, Initials, Title and any professional Designations (such as 
CPCU, JD or ACS) for this person.

5. If you want to configure this user as an available selection for a filing group 
manager, check the FG Manager check box.

(A filing group manager is the person responsible for a particular filing 
group, and is assigned when creating a filing group.)

If you want to configure this user as an available selection for a filing 
manager, check the Filing Manager check box.

(A filing manager is the person responsible for a particular filing, and is 
assigned when creating a filing.)

6. In the upper portion of the Logon Authentication section:

• You can set the security Access Level for this person. For more 
information about access levels, see Security Access Levels on page 50.

• You can set the EFT Fee Authority Level for this person. For more 
information, see EFT Fee Authority Levels on page 70.

7. In the lower portion of the Logon Authentication section, enter the unique 
user ID for this person. This will be used as their logon user name. The 
information you need to enter here depends on whether you have enabled 
Windows authentication for your users.



USER PROFILES

TRACKER P&C VERSION 6.6 USER GUIDE  77

• If you have enabled Windows authentication for your users, Use 
Windows is selected. Enter the person’s unique Windows User ID.

• If you have not enabled Windows authentication for your users, Use 
Tracker is selected. Enter the Tracker User ID and temporary 
Password for this person. You should supply each user with an initial 
password and have them change it to a password meaningful to them 
alone the first time they log in to Tracker.

See Setting User ID and Password Authentication on page 37 for more 
information about Windows authentication.

8. Enter this person’s Department information. Address information will be 
automatically populated according to the department entered. You can 
change this information if necessary. (See Entering or Editing General 
Information for Companies on page 56.)

9. Enter this person’s contact information, including their Phone numbers, 
Extension, Address and E-Mail address. (Formatting rules apply.)

10. If this person should receive Regulatory Specialist update notification 
emails, check Receive RS e-mail updates. If checked, Suppress RS 
ReadMe becomes active. Check Suppress RS ReadMe if you do not want 
to include the Regulatory Specialist ReadMe file for this person when a 
Regulatory Specialist update is performed.

11. To enable an electronic signature for this user (for use in certain custom 
letters and filing forms):

a. Check the Signing Authority check box. This activates the other fields 
in this section.

b. Click the browse button  to browse for the file where this user’s 
electronic signature has been stored. Select Browse DMS if the file is 
located in a DMS.

Note: The signature must be in BMP or JPG format. The size of the signature on Tracker 
filing forms will be adjusted to 1.5 inches wide by 0.5 inches high (a ratio of 3:1). 
Electronic signature files with a different dimensional ratio will appear stretched 
or compressed.

12. Enter this user’s User Type and State License information (if applicable). 
The User Type is used to assign Company Resource information (to be used 
on filing forms). See Enter resource information for a new company on page 
62 for details.

13. Click OK to save this information and return to the User list dialog.

14. Repeat steps 2 to 13 for other users you want to add.

15. When finished, click Close.
 

Configuring Profile Affiliation

Note: This topic only applies to installations using Launcher.
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Profile Affiliation Criteria on page 48 describes how you can configure Tracker so 
that users will see only the filing profiles for the LOBs or states that are assigned 
to them. If you have configured Tracker for this, a Profile Affiliation tab will be 
displayed in the User Profile dialog. You can use this tab to then assign specific 
states or LOBs to a user.

Method: Configure profile affiliation for a user

You can configure Tracker so that users will see the filing profiles for either the 
LOBs or states assigned to them, but not both.

Configuring Profile Affiliation by State
1. Select Admin > Users.

The Users list dialog displays.

2. Highlight the user name for which you want to affiliate states and click Edit.

3. On the User Profile dialog, click the Profile Affiliation tab.

4. Click Add.

The list of Available States opens.
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5. From the list of Available States, select the states to affiliate with this user 
and move them to the Selected States list using the right arrow button. 

Clicking on the double arrow will move all entries.

6. When you have affiliated all of the applicable states for this user, click OK 
to return to the User screen.

7. Repeat steps 2 to 6 for other users you want to affiliate with states.

8. When finished, click Close.

Configuring Profile Affiliation by LOB
1. Select Admin > Users.

The Users list dialog displays.
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2. Highlight the user name for which you want to affiliate LOBs and click 
Edit.

3. On the User Profile dialog, click the Profile Affiliation tab.

4. Click Add.

The list of Available LOBs displays.

5. Click the Add button to open User LOB Authority.

6. From the list of Available LOBs, select the lines of business to affiliate with 
this user and move them to the Selected LOBs list using the right arrow 
button. 

Clicking on the double arrows will move all entries.

7. When you have affiliated all of the applicable lines of business for this user, 
click OK to return the User screen.

8. Repeat steps 2 to 7 for other users you want to affiliate with states.

9. When finished, click Close.

Changing User Profile Information
You can change user profile information.

Method: Change user profile information

1. Select Admin > Users.

The Users list dialog displays.
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2. Click the user record whose information you want to change.

3. Click Edit to open the related User Profile dialog box.

4. Make any necessary changes.

5. Click OK to save your changes and return to the Users list dialog.

6. Click Close to exit the Users list dialog.

Deleting User Profiles
You can delete a user profile if that user is no longer required to access your 
Tracker system.

Note: You cannot delete any user associated with filings. This is any of the following 
users:

• a filing group manager

• a filing manager

• any user who has performed an activity on a filing.

If you try to delete a user affiliated with a filing, an error message appears stating:

This user is linked to filings and cannot be deleted.

Method: Delete a user profile

1. Select Admin > Users.

The Users list dialog displays.
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2. Click the user record you want to delete.

3. Click Delete.

A message appears confirming whether you really want to delete this user.

4. Click Yes to confirm the deletion (or No to cancel the deletion) and return to 
Users.

The deleted user will no longer appear on the list.

5. Repeat steps 2 to 4 for other users you want to delete.

6. When finished, click Close.
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Custom Tables

Tracker contains a number of custom tables which you can configure with values 
and terminology used in your organization 

The following sections discuss custom tables:

• Understanding Custom Tables on page 83 contains overview information on 
custom tables.

• Performing Custom Table Tasks on page 87 describes how to work with 
custom tables.

• Activity Codes on page 90 describes how to work with activity codes.

• Recurrent Filing Activities (Calendar Filings) on page 98 describes how to 
create recurring filing activities.

• Mapping Custom LOBs to Standard LOBs on page 99 describes how to use 
your company’s own LOBs with Tracker.

Important: All custom tables must be configured and all necessary information entered before 
you begin to use the Tracker system to prepare and manage filings.

Understanding Custom Tables
The following section lists each custom table, with a brief description of its 
purpose in the system. For the tasks you can perform with custom tables, see the 
topics starting with Performing Custom Table Tasks on page 87.

Each custom table consists of:

• a list box, listing the default members of that table

• a series of dialog boxes which are activated when you want to add, edit or 
delete an entry in the custom table

The tables which can be customized within Tracker are:

• Activity Codes on page 84

• Advisory Organizations on page 84

• Attachment Types on page 84

• Filing Method (Rate) on page 84

• Filing Types on page 84

• Form Types on page 85

• Publication Status on page 86

• Publication Type on page 86

• LOB Mapping on page 87

• Print Status on page 87
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Activity Codes
This table contains a listing of all of the activity codes active in the Tracker 
system. Tracker comes with a set of default activity codes which you can use to 
perform a wide variety of tasks, from making notes to recording instructions and 
responses to generating complete filings. You can edit, rename, or add to these 
standard activities. You can also delete or obsolete activity codes if required.

See also Activity Codes on page 90

Advisory Organizations
This table contains a listing of the default Advisory Organizations from which 
your company receives publications, or with which your company deals, such as 
ISO, AAIS, and so on.

Attachment Types
This table contains a listing of the default other attachment types for documents 
other than rates, rules, and forms that you might need to include in your filings.

The default other attachment types included with the system are:

• Actuarial Memorandum

• Certification

• Check List

• Filing Form

• Other

(See Other Attachments on page 195 for more details on working with other 
attachment types.)

Filing Method (Rate)
This table contains a list of the options for the Filing Method field drop down 
menu on the Rate tab. The standard filing methods included with the system are:

• File and Use

• Prior Approval

• Use and File

• Flex Rate

Note: You can add, modify and delete custom filing methods, but the standard ones 
cannot be deleted.

Filing Types
This table contains a list of the default filing types available for use. The standard 
types included with the system are:

• (a) Rate/Consent To
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• Advisory

• Automatic Adoption

• Biannual

• Deferral

• Deviation

• Final Printed Page

• General Reference

• Independent

• Informational

• Letters to File

• Loss Cost

• Other

• Other Special

• Special Reference

Form Types
This table contains a listing of the default types of forms which may be required to 
be used in filings. The standard types included with the system are:

• Application

• Covers/Jackets

• Declaration Page

• Endorsement

• Enrollment Form

• Notice

• Policy Form

• Policy Holder Notification

• Schedule

• Supplement

The Form Type Description field contains the name you use to describe the form 
type in your organization. While Tracker allows for customization, SERFF has 
predefined choices that you must use so you will need to map your custom choices 
to one of the pre-defined SERFF choices so that the correct value is passed to 
SERFF.

The list of SERFF form types is a follows:

• ADV - Advertising

• ABE - Application/Binder/Enrollment
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• BND - Bond

• CNR - Canc/NonRen Notice

• CER - Certificate 

• DEC - Declarations/Schedule 

• DSC - Disclosure/Notice 

• ERS - Election/Rejection/Supplemental Applications

• END - Endorsement/Amendment/Conditions

• OTH - Other

• PCF - Policy/Coverage Form

Note: The default form types provided are all mapped to Other. Therefore, even if you 
do not add your own custom form types, you should still map the system-provided 
form types to the appropriate SERFF form type.

Publication Status
This table contains a listing of the default statuses of publications that you receive 
and enter into your system. The default types included with the system are:

• Administrative

• Advisory

• Approved

• Filed

• To Be Effective

Publication Type
This table contains a listing of the types of publications that you receive and enter 
into your system. The default types included with the system are:

• Line Circular

• Premium Comparison

• Statistical Plan
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LOB Mapping
You may have defined line of business codes in Tracker to correspond to your 
organization’s products and traditional codes. For example, you may have coded 
the Private Passenger Auto line of business as PA, PPA, or AUT.

Tracker, however, does not recognize organization-specific LOB codes. Before 
people in your organization can create filings using these codes, you must “map” 
them to equivalent standard lines of business. See Mapping Custom LOBs to 
Standard LOBs on page 99.

Print Status
This table contains a listing of the default print statuses used by your company in 
the Tracker system. Print Status codes are established in Tracker to help monitor 
the production process. Here, the term Print Status refers to the various stages 
involved in printing and sending a completed filing. Standard Print Status codes 
include:

• First Proof

• Forms Available

• Mailing Completed

• Mailing Schedule

• Not Applicable

• Orig. Copy Sent

• Project Complete

• Proof Approved

• Second Proof

• Sent To Printing

• Third Proof

•

Performing Custom Table Tasks
The method for entering and altering custom tables information is similar for most 
of the tables. The basic set of tasks is:

• Viewing Custom Tables on page 87

• Entering Information into Custom Tables on page 88

• Changing Information in Custom Tables on page 88

• Deleting Custom Table Elements on page 89

Viewing Custom Tables
You view all custom tables in the same way.
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Method: View a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the list.

The selected custom table is displayed.

3. To view the properties of an entry, select the entry and click Edit.

4. When finished viewing the entry, click Cancel.

5. Repeat steps 2 to 4 to view other entries in a custom table.

6. When finished, click Close.

Entering Information into Custom Tables
When Tracker is installed, the custom tables have default data entered already. 
You can also add more information to a custom table.

Method: Enter information into a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the menu list.

The selected custom table is displayed.

3. Click Add. 

The Add dialog displays.

4. Enter information for the new item.

5. Click OK to save the information and return to the custom table.

6. Repeat steps 3 to 5 for additional new items.

7. When finished, click Close.

Changing Information in Custom Tables

Warning: While each table can be added to or edited using function buttons by users having 
the appropriate security access levels, changes to the custom tables can have far 
reaching effects on the Tracker system and your Tracker environment. Please 
contact Oracle Global Support before making changes to these tables following 
initial system set-up.

Method: Change information in a custom table

1. Select Admin > Custom Tables.
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2. Select the custom table you want to work with from the menu list.

The selected custom table is displayed.

3. Click the record you want to change.

4. Click Edit.

The form for that custom table item is displayed.

5. Make any required changes.

6. Click OK to save your changes and return to the list box.

7. Repeat steps 3 to 6 to change any other items in this custom table.

8. When finished, click Close.

Deleting Custom Table Elements

Warning: While items can be deleted from custom tables by users that have the appropriate 
security access levels (provided the item has not been used in a filing), deleting 
items from some custom tables is not recommended because of the potential 
effects on the Tracker system and your Tracker environment. Please contact 
Oracle Global Support before making changes to the default entries in the 
following custom tables:

• Activity Codes

• Advisory Organizations

• Filing Types

• LOB Mappings

Method: Deleting information from a custom table

1. Select Admin > Custom Tables.

2. Select the custom table you want to work with from the menu list.

The selected custom table is displayed.

3. Click the record you want to delete.

4. Click Delete.

A confirmation message appears.

5. Click Yes to delete the record or No to cancel.

6. Repeat steps 3 to 5 for other records you want to delete.

7. When finished, click Close.
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Activity Codes
Activity codes are accessed via Admin > Custom Tables > Activity Codes. You 
can add, obsolete and delete activity codes. To use activity codes to work with 
recurrent activities, see Recurrent Filing Activities (Calendar Filings) on page 98.

This section describes

• Adding Passive Activity Codes on page 90

• Adding Active Activity Codes on page 91

• Changing Activity Codes on page 94

• Obsoleting and Reactivating Activity Codes on page 95

• Deleting Activity Codes on page 96

Adding Passive Activity Codes
Passive activities are activities that do not update or generate any data inside your 
filings. It is possible to set passive activities to occur in the future (that is, post 
activities), and also to recur over a given time period.

Method: Adding a passive activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click Add.

The Activity - Add dialog displays.
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3. Enter a short Activity Code by which the activity can be easily identified, 
such as MEM for a Create Memo activity.

4. Enter a brief Description of the activity.

5. In the Applies To field, enter the level of the Tracker system from which 
this activity may be accessed – All, Filing Group, Filing, or Publication.

6. Select Future Allowed if this activity will be used as a post activity.

7. Click OK to save your addition and return to Activity Codes.

8. Repeat steps 2 to 7 for additional Activity Codes.

9. When finished, click Close.

Adding Active Activity Codes

Active activities are activities that update or generate data inside your filings. 
Activity codes associated with active activities can only be applied to filings.

Method: Add an active activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.
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2. Click Add.

The Activity - Add dialog displays.

3. Enter a short Activity Code by which the activity can be easily identified, 
such as MEM for a Create Memo activity.

4. Enter a brief Description of the activity.

5. Click the Applies To drop-down menu and select Filing.

6. Select Is Active.
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7. In the Activity Functions section, select the appropriate options to define 
the parameters and actions of the activity:

• Update Status – select the status to assign to the filing after this activity 
is performed

• Move to Filing Package Tab – select this option if you want the filing 
to be moved to the filing package when this activity is performed

• Generate Letter – select this option if you want to generate, view, and 
print a filing letter when this activity is performed

• Generate Filing Forms – select this option if you want to generate, 
view, and print a filing form when this activity is performed

• Include Attachments – select this option if you want to allow 
attachments to be added to the filing when this activity is performed

• Lock Fee Details – select this option if you want to stop filing fee 
payment information from being changed after this activity is performed

8. In the Update Dates section, to affiliate a date with an activity, make a 
selection from one, two, or three of the drop-down lists.

Note: If you affiliate Requested Effective Date or Requested Renewal Effective Date 
with an active activity, a check box is displayed that lets you choose On 
Approval. If you select the On Approval check box, a user who performs the 
activity will have a choice between selecting a date or selecting On Approval. If 
you do not select the On Approval check box, a user who performs the activity 
must select a date; the user will not see the On Approval check box.

Drop-
down 
lists
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9. Click OK to save your changes and return to Activity Codes.

10. Repeat steps 2 to 9 for additional activity codes.

11. When finished, click Close.

Changing Activity Codes
You can change an activity code. This includes the name of the code, the 
parameters and actions of the activity, and you can mark unused or no longer 
needed activity codes as Obsolete. Activity codes that are not obsolete are In 
Force. You can only change activity codes that are In Force.

Important: Changing activity codes that are part of the default Tracker installation can have 
far-reaching effects on the Tracker system and your Tracker environment. Please 
contact Oracle Support before changing default activity codes following initial 
system setup.

Method: Change an activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the activity code you want to change.

3. Click Edit. 
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The Activity – Edit dialog displays.

4. Make any necessary changes.

5. Click OK to save your changes and return to Activity Codes.

6. Repeat steps 2 to 5 for other activity codes you want to change.

7. When finished, click Close.

Obsoleting and Reactivating Activity Codes
If you have an activity code that you are no longer using or do not need, you can 
mark it as obsolete. Obsoleting an activity code removes it from the list of 
currently available activities; it does not actually delete it from the Tracker 
database.

Activities that are not obsolete are called In Force. You can only edit or delete 
activity codes that are In force.

Method: Obsolete an activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the activity code you want to obsolete.

3. Click Obsolete.

The selected Activity Code is made obsolete. It is removed from the In 
Force list. It can be found in the Obsolete list.

4. Repeat steps 2 and 3 for other activity codes you want to obsolete.

5. When finished, click Close.
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Method: Reactivating an obsolete activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the Obsolete list selector.

The list of obsolete activity codes is displayed.

3. Click the Activity Code you want to reactivate.

4. Click Reactivate.
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The Activity Code is reactivated. It is removed from the Obsolete list. It 
can now be found in the In Force list. 

5. Repeat steps 3 and 4 for other activity codes you want to reactivate.

6. When finished, click Close.

Deleting Activity Codes
If an activity code has never been used and is no longer needed, you can delete 
it.See Obsolete an activity code on page 95.

Important: You can only delete activity codes that are In Force.

Warning: Deleting activity codes can have far-reaching effects on the Tracker system and 
your Tracker environment. Please contact Customer Support before deleting 
activity codes following initial system set-up.

Method: Delete an activity code

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click the activity code you want to delete.

3. Click Delete.

4. Click Yes to confirm the deletion. 

The deleted activity code will no longer appear in the list.

5. Repeat steps 2 to 4 for other activity codes you want to delete.

6. When finished, click Close.
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Recurrent Filing Activities (Calendar Filings)
You can create recurrent activities using the Activity Code dialog. For example, 
you can set up an activity to occur automatically every year on the same date, for 
annual filings or reports.

Creating Recurrent Filing Activities
You create a recurrent activity at the Filing level.

Method: Create a recurrent filing activity

1. Select Admin > Custom Tables > Activity Codes.

The Activity Codes list opens, with the In Force activity codes displayed.

2. Click Add.

The Activity - Add dialog opens.
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3. Complete the Code and Description entry boxes.

4. Click the Applies To drop-down menu and select Filing.

5. Select Recur Every.

6. In the entry boxes beside Recur Every, enter the number and the units for 
the applicable timeframe.

7. Click OK to save your changes and return to Activity Codes.

8. Repeat steps 2 to 7 for additional recurrent activities.

9. When finished, click Close.

Custom LOBs
This section describes:

• Mapping Custom LOBs to Standard LOBs on page 99

• Changing LOB Mappings on page 101

• Deleting LOB Mappings on page 102

• Mapping Multiple LOBs to a Custom LOB on page 102

Mapping Custom LOBs to Standard LOBs
If you have entered lines of business that do not match the standard Tracker lines 
of business, then you will have to map them to the standard Tracker lines of 
business.
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Important: After you have finished mapping, you need to log out of Tracker, then log back in. 
This is required for any mapping changes take effect.

Note: Multiple LOBs and SERFF Filings

The SERFF system generally does not allow for multiple LOBs to be combined 
and submitted in a single filing. If you create a custom LOB that is mapped to two 
or more standard LOBs, a warning appears:

SERFF does not support creating the following file(s) for a Customized LOB 
that has been mapped to multiple standard LOBS.

Do you still want to continue?

You can still continue to create the multiple LOB mapping by clicking Yes. 
However, be aware that if you create this filing, its submission might not be 
accepted.

Method: Map a non-standard Line of Business to a standard Line of 
Business

1. Select Admin > Custom Tables > LOB Mappings.

The LOB Mapping dialog displays.

2. Click Add.

LOB Mapping - Add opens.
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3. Enter your company’s Custom LOB Code.

4. Select the corresponding standard Available Line of Business.

5. Enter a brief Description of your company’s custom LOB.

6. Click OK to save the mapping.

7. Repeat steps 2 to 6 for other LOB mappings you want to make.

8. When finished, click Close.

Changing LOB Mappings
You can change LOB mappings.

Method: Change an LOB mapping

1. Select Admin > Custom Tables > LOB Mappings. 

LOB Mapping opens.

2. Click the LOB record you want to change.

3. Click Edit to open the related LOB Mapping dialog box.

4. Make any necessary changes and click OK.

5. Repeat steps 2 to 4 for other LOB mappings you want to change.

6. When finished, click Close.
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Deleting LOB Mappings
You can delete LOB mappings.

Method: Delete an LOB mapping

1. Select Admin > Custom Tables > LOB Mappings. 

The LOB Mapping dialog opens.

2. Click the LOB record you want to delete.

3. Click Delete.

A message appears asking you to confirm whether you really want to delete 
this mapping.

4. Click Yes to confirm the deletion (or No to cancel the deletion) and return to 
the LOB Mapping dialog.

5. Repeat steps 2 to 4 for other LOB mappings you want to delete.

6. When finished, click Close.

Mapping Multiple LOBs to a Custom LOB
This feature allows you to file for more than one line of business (LOB) in a single 
filing. This is useful for products that contain more than one LOB. You can set up 
a custom line of business that maps to multiple standard lines of business. This 
allows a single filing to have access to the regulatory specialist information and 
filing forms for multiple LOBs.

Method: Map multiple LOBs to a custom LOB

1. Select Admin > Custom Tables > LOB Mappings. 

The LOB Mapping dialog opens.

2. Click Add.

The LOB Mapping – Add dialog displays.

3. Enter the code for this LOB in Custom LOB.

4. Enter the Description for this LOB.

5. Select the lines of business to which you want to map the custom LOB. All 
of the available lines of business are listed in Available Lines of Business. 
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6. Click the right arrow button to include these standard LOBs in your custom 
LOB.

The LOBs are moved to To Map.

7. Click OK to save the custom mapping.
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If you are working with Tracker integrated with SERFF, a warning message 
appears.

8. Click Yes to continue and return to LOB Mapping.

9. Repeat steps 2 to 8 to create other multiple.

10. When finished, click Close.
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Reassigning Activities

This feature allows you to reassign pending or current activities to another user.

Method: Reassign an activity

1. Select Admin > Reassign Activities.

Reassign Activities opens.

2. Click the From drop-down menu and select the name of the person from 
whom you want to unassign the activity.

3. Click the To drop down box and select the name of the person to whom you 
want to reassign the activity.

4. Click OK to complete the reassignment (or click Cancel to stop the 
reassignment).

Note: The person you reassign the activity to is not automatically notified. You must do 
this by some other method, for example by leaving voice mail, updating your 
intranet portal, sending an email or fax, and so on.
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Administrative Reports

A number of reports are available to summarize various types of administrative 
information in the system. These administrative reports provide administrative 
level information about the companies and users in your system. For example, you 
can produce a report that lists authority information for every company in your 
system.

These reports are available only through the Administration menu, and are 
accessible only to users that have Administrator as their security level. For more 
information about non-administrative Tracker reports, please see Searching, 
Reporting, and Filing Summary on page 423.

The following administrative reports are available in Tracker:

• General Company Listing Report on page 106

• Companies with Authorities Listing Report on page 107

• User Listing Report on page 107

This section also describes Generating Administrative Reports on page 108.

General Company Listing Report
The General Company Listing Report provides general information about each 
company, related department, and user listed in your Tracker system.

This report displays the following fields:

• Company Name

• Company Code

• Name

• Address

• City

• State

• Zip

• Phone

• Fax

• Toll-Free Phone

• URL

• NAIC Group Code

• NAIC Company Code

• FEIN

• State of Domicile

• Country
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• SERFF ID

• Department Name

• Department Address

• Department State

• Department Zip

• Department Phone

• Department Fax

• Department Toll-Free Phone

• User Name

• User Designation

• User Title

Note: Currently, the SERFF IDs of companies are not captured in this report.

Companies with Authorities Listing Report
The Company with Authorities Listing Report provides a list of all companies 
recorded in your Tracker system, together with the states and lines of business for 
which each is licensed.

This report displays the following fields:

• Company Name

• Company Code

• State

• Line of Business

User Listing Report
The User Listing Report provides detailed information about every Tracker user 
listed in your system.

This report displays the following fields:

• User Name

• Department

• Insurance Type

• User Group

• Prefix

• First Name

• Middle Initial

• Last Name

• Initials



THE ADMINISTRATION MODULE

108 TRACKER P&C VERSION 6.6 USER GUIDE

• Title

• Access Level

• Phone

• Fax

• Toll-Free Phone

• Email Address

• Professional Designation(s)

• Address

• City

• State

• Zip

• Country

• Signing Authority

Generating Administrative Reports
Administrative Reports are produced in the same manner as all standard Tracker 
reports. (See Searching, Reporting, and Filing Summary on page 423 for more 
information.)

Method: Generate an administrative report

1. Select Admin> Reports.

The Reports dialog displays.

2. Select the report you want to produce.

3. To generate the report with default values, click Preview.

or

(if available) To change the selection criteria and sort order, follow these 
steps:

a. Click Parameters.

The report settings dialog displays.

b. Define the Selection Criteria which you want the report to encompass. 
Here a selection of fields appropriate to the report you are creating are 
presented. You can specify a single member for each field, or select All 
to generate a report for all the members of that field group.

c. In Sort Order, enter the number corresponding to the field by which 
you want the report to be sorted.

d. Click OK.
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Tracker generates the report you have specified using your dates, criteria, 
and sort order, and a preview of the generated report appears in a Crystal 
Reports viewer window.

4. Review the generated report.

If you need to make changes, close the preview window and redefine the 
report criteria.

5. To print the report, click Print.

The report prints to your default printer.
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Chapter 3
Logging into Tracker

When your Tracker administrator sets up your company’s Tracker system, every 
Tracker user’s computer will be provided with a single shortcut which you will 
use to access Tracker.

If the Windows Authentication login option is configured by your administrator, 
you will use your Windows ID and password to log into Tracker. With this option, 
you would therefore not need to enter a separate user ID and password to log into 
Tracker.

If you are not configured to use the Windows Authentication option, you must use 
the Tracker Login method.

Note: You Tracker administrator will implement the login method your organization will 
use based on your company’s requirements.

This chapter describes:

• Tracker Login on page 112

• Changing Your Tracker Login Password on page 113
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Tracker Login

Note: This section applies only if your Tracker administrator has not configured the 
Windows Authentication login option for your organization.

Your Tracker administrator will need to give you a Tracker Username and a 
Password to enter the Tracker system.

Your Username is the name or code which you use to identify yourself to the 
system. It is usually a version of your name, such as your first initial plus your last 
name, but it can be any selected code.

Your Password is a secret 6-20 character code which identifies you to the system. 
It is case-sensitive and can be made up of letters or numbers, or a combination of 
both. Initially, your Tracker administrator will give you your username and a 
temporary password to use when you first access Tracker.

Logging In

Method: Log in to Tracker

1. Double-click the Tracker shortcut on your desktop . The Tracker 
splash screen appears briefly, displaying version and identification 
information about Tracker.

If you are configured to use the Windows Authentication login: you will 
be logged into Tracker automatically.

If you are not configured for Windows Authentication login, the LogIn 
box opens. Follow these steps:

a. Enter your Username and your Password. Note that the password 
appears onscreen as a series of asterisks, to protect your privacy. 
Passwords are case-sensitive.

b. Click OK.

In a few seconds, the Tracker Top Level screen appears.

Note: If you enter your Tracker login username or password incorrectly, an error 
message appears indicating that you have made a mistake. You can then try to 
enter your password two more times; if it is still incorrect, Tracker will close and 
you will need to contact your Tracker Administrator, who will enable you to 
create a new Tracker login password.
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Changing Your Tracker Login Password

Note: This section applies only if your Tracker administrator has not configured the 
Windows Authentication login option for your organization.

Your Tracker administrator will give you your username and a temporary 
password to use when you first access Tracker.

After entering the Tracker system for the first time, you should change your 
password to something that is meaningful to you. You may change your password 
at any time, from any point in the system.

Method: Change your Tracker login password

1. Select View > Options > Password.

The Change Password dialog displays.

2. Enter your Old Password (it will display as a series of asterisks).

3. Enter the New Password you have chosen (it will display as a series of 
asterisks).

4. Enter your New Password a second time, so that the system can verify it.

5. Click OK.

Your password has been changed.
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Chapter 4
Programs and Filing Groups

Programs are the top level of Tracker. They contain filing groups, and each filing 
group contains a set of related filings. Each filing is ultimately used to create a 
filing package, which is then submitted to each state Department of Insurance.

You work with programs in the Filing Module of Tracker. See Filing Module on 
page 22 for more information.

This chapter describes:

• Working with Company Programs on page 116

• Working with Filing Groups on page 120
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Working with Company Programs

You must create a company program before you can create any filing groups or 
filings.

This section describes:

• Creating a New Company Program on page 116

• Editing Company Programs on page 117

• Deleting Company Programs on page 118

Creating a New Company Program
Use the following method to add a company program.

Method: Add a new company program

1. Select File > Company Program.

The Company Program list box displays.

2. Click Add.
3. The New Company Program dialog displays.
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4. Enter the 8-character Code (name) of the new program, and a short 
Description.

5. Click OK to return to the Company Program dialog.

The program you just added will now appear in the list of programs.
6. Click Close.

Editing Company Programs
Use the following method to edit a company program.

Method: Edit a company program

1. Select File > Company Program.

The Company Program list box displays.

2. Click the program you want to edit and click Edit.
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3. Edit the Description as required.

Note: You cannot edit the company program code.
4. Click OK to save the company program.
5. Click Close.

Deleting Company Programs
Use the following method to delete a company program.

Method: Delete a company program

1. Select File > Company Program.

The Company Program list box displays.

2. Select the program you want to delete and click Delete.

A confirmation dialog appears.
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3. Click Yes to delete the program. Click No to cancel deleting the program.

The appropriate action occurs.

Note: If the program has filing groups associated with it and you click Yes, the program 
will not be deleted. You will see the following error message:

Unable to delete company program; it is used by existing filing groups.
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Working with Filing Groups

After you have created a company program, you can add filing groups to it to 
organize your filings.

The following tasks deal with filing groups:

• Adding a New Filing Group on page 120

• Viewing the Filing Groups for a Specific Program on page 121

• Accessing a Filing Group Record on page 122

• Viewing Filing Group Tabs on page 122

• Entering a Filing Group Code on page 122

• Overriding the Filing Group Code Number on page 122

• Creating a Filing Group Past 99999 on page 123

• Creating Filing Groups in a Multi-User Environment on page 123

Adding a New Filing Group
You can add a new filing group at any time using the File menu New Filing 
Group command.

The keyboard shortcut Ctrl + N will also access the New Filing Group dialog; it 
can be used from most main screens. It cannot be used when the File menu is 
open.

Method: Add a new filing group

1. Select File > New Filing Group, or click the New Filing Group button. 

The New Filing Group dialog displays.

2. Enter a Program by selecting one from the drop-down list.
3. In Filing Group #, you can:

• let Tracker assign a system-generated filing group code

• select the Override check box and enter a different filing group code
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4. Enter the filing group FG Name, FG Description, FG Mgr (Manager), 
and Date information. The FG Mgr and Date fields will be automatically 
filled in with your name and today’s date (which you may change if 
desired).

Tip: FG Name and FG Description should be the same. Product and FG Name 
should be different.
5. Complete the Custom text box, if required.
6. To create the filing group and exit the dialog, click Create.

The new filing group is added.

OR

To proceed to create filings for this filing group immediately, ensure you 
have selected a program and click New Filing(s).

Note: For more information on how to work with filings after clicking New Filing(s), 
see  Adding New Filings on page 126.

Viewing the Filing Groups for a Specific Program
Follow these steps to view the filing groups for a specific program.

Method: View the filing groups for a specific program

1. Navigate to the Top level.
2. On the Filing Group header, locate the Program field.
3. From the Program field drop-down list select the program whose filing 

groups you want to view. 

The filing groups for this program will appear on the Filing Groups list tab.
4. When you select (highlight) a filing group on the list, the related basic 

information for that filing group will appear in the Filing Group header 
fields.

Changing Filing Group Settings
You can change some of a filing group’s settings (the ones that are not greyed out) 
by selecting or entering new values, and saving.
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Accessing a Filing Group Record
You may access a single filing group record from the Tracker Top level via the 
Filing Groups tab.

On the Filing Groups tab, select the filing group you want to view and double-
click it to view the details of this filing group.

Method: Browse through the filing group files

You can browse through the filing group files, moving from one filing group to 

another, by using the Back  and Forward  toolbar buttons or equivalent 
Edit menu options.

Viewing Filing Group Tabs
In addition to the filing group header, a filing group contains the following tabs:

• The My Filings Tab and Filings Tabs – For details, see Accessing Filing 
Records from the Filing Group Level on page 135.

• The Activities Tab – Filing Group Level on page 231

• The Rates Tab — Filing Group Level on page 164

• The Rules Tab — Filing Group Level on page 181

• The Forms Tab — Filing Group Level on page 147

• The Other Attachments Tab – see Other Attachments on page 195

• The NAIC Filing Description Tab – see NAIC Filing Descriptions on page 
201

Entering a Filing Group Code
The Filing Group Code is a five-character numeric code used to identify a group 
of related filings (such as all the filings in a multi-state filing). You can create as 
many filing groups as required within a given program. Tracker will automatically 
provide the next number in the series when a new filing group is created. This 
automatic assignment of numbers can be overridden at the time of creation (see 
details below).

Overriding the Filing Group Code Number
Tracker will automatically choose the next number in the filing group series each 
time you create a new filing group. You will see this in the Filing Group field 
when you access the New Filing Group dialog box. If you want to change this 
code to a different number, click in the Override box, and then manually enter the 
number you want. Note that you cannot enter a number which already exists in the 
system. If you do, an error message appears and you will need to re-enter the 
Filing Group Code.
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Note: If you override the filing group code with a larger number, Tracker will 
automatically number subsequent filing groups continuing from that new larger 
number.

Creating a Filing Group Past 99999
When you are creating a filing group and your system has reached 99999, the 
system automatically rolls over and begins searching from 00001 to look for the 
next available filing group number (for example, 00010 might be the next 
available unused number). 

Creating Filing Groups in a Multi-User Environment
You can create a filing group while other users are simultaneously creating filing 
groups. If more than one user creates a filing group at the same time, Tracker 
assigns each user a different number (in sequential order). When the filing group 
is successfully entered, a message box opens indicating the filing group number 
that has been assigned to the group you just created. 
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Chapter 5
Working with Filings 

This chapter provides detailed information about working with filings in Tracker, 
whether you are using paper-based filings or working with SERFF. 

This chapter describes:

•  Adding New Filings on page 126

• The My Filings — All Tab on page 133

• Filing Header on page 137

• Filing Tabs on page 139

• The Filing Details Tab on page 140

• Company Group Filings on page 142

• Schedule Items Overview on page 145

• Forms on page 147

• Rates and Rate Exceptions on page 164

• Rules and Rule Exceptions on page 181

• Linking Related Filings on page 193

• Other Attachments on page 195

• NAIC Filing Descriptions on page 201

• Entering Filing Fees on page 203

• Copying Filings on page 206
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 Adding New Filings

Typically, you add a new filing or filings while creating a new filing group, or 
from within an existing filing group. (New filings can also be created after 
completing a recurrent activity or while viewing Publications). Tracker will 
automatically make the new filing a member of whatever filing group you are 
working in. A new filing you add to an existing filing group will automatically 
have all the attachments (schedule items) that are currently in the filing group, as 
well as any added later.

Note: Multi-state and multi-company filings are created in the same manner as single 
filings. The process simply generates more than one related filing under the same 
filing group.

New filings are added using the Create New Filing(s) dialog. There are three tabs 
on this dialog:

• Details: used to select Type and CLS combinations

• Program/Filing Group Setup: used to add common settings for filings 
(Filing Type, Start Date, Filing Description, Filing Manager, Custom, and 
Company Reference #)

• Filing Setup: used to add or modify the settings entered on the Program/
Filing Group Setup tab, and to add the Company Reference # and NAIC 
Filing Description.

Important: The Filing Description field plays a critical role in organizing filings. Since a user 
can create filings with the same Company, LOB and State in the same Filing 
Group, a Filing Group may contain several filing projects. The Filing Description 
field is the unique identifier for each filing project in a Filing Group. It is critical 
that a user does not use the same Filing Description for separate filing projects in 
the same Filing Group.

Method: Add a new filing or filings

1. While creating a new filing group (see Adding a New Filing Group on page 
120), click New Filing(s)

OR

At the Filing Group level, click the New Filing button .

The Create New Filing(s) dialog opens, and the Details tab is displayed.
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2. Select the appropriate Type check boxes.

Note: At least one Type must be selected. 
3. Click Add/Modify.

The Add/Modify CLS dialog displays.

4. Enter a Filing Description by doing one of the following: 
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• For new filings, click the text box (the default text “Create New Filing 
Project” will disappear) and type in a filing description.

OR

• To add filings to an existing filing project, click the down-arrow button 
to display the list of all filing descriptions in the filing group, and select 
one or more filing descriptions from the list. If you make multiple 
selections, then each selection displays in the field separated by a 
comma.

Note: The Filing Description cannot be changed after selecting one or more CLSs. To 
change the Filing Description after selecting one or more CLSs, remove all CLSs 
from the Selected list.
5. From the Available list on the left, choose the desired company/state/line of 

business (CLS) combination(s) for this filing.

• The CLS combinations shown in the list are determined by the 
administrative setup. They are grouped first by company and then by 
state (default) or by LOB, depending on the position of the By LOB 
button above the Available list. You can toggle between the two views 
as often as you require. 

• Companies listed are licensed for a least one LOB in one state.

• The list shows only those LOBs for which the company is licensed.

• Expand branches of the list by clicking any of the + buttons.

• Select the check box beside each desired CLS combination.
6. When you have finished selecting LOB combinations, click the right arrow. 

The selected combination(s) appear in the Selected list.

Tip: If you double-click a CLS combination in the Available list or the Selected list, it 
will immediately move to the other list. You can also use the double arrow button 
to move all LOB combinations from one list to the other. 

Note: At least one CLS combination must be selected.
7. When you are satisfied with all the information displayed, click OK.

Tracker saves the CLS selections and closes the Add/Modify CLS screen. 
The Details tab displays with the new CLS selections in the CLS table.
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8. Click the Product/Filing Group Setup tab.

The Product/Filing Group Setup dialog displays.

In the filing group, you may optionally complete the following fields:

• Filing Type

• Start Date

• Filing Description

• Filing Manager

• Custom

• Company Reference #
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Note: The purpose of these Filing level fields in this dialog are to give you a start on 
populating the Filing level fields on the Filing Setup tab. Each field populated on 
this screen will apply to all filings on the Filings Setup tab. You are not required 
to populate any of these fields on this screen. You can go directly to the Filing 
Setup tab to populate these Filing level fields if desired.
9. When you have finished, click the Filing Setup tab.

The Filing Setup dialog displays.

A drop-down list of system-numbered CLS combinations is created. 
Selecting a CLS combination from the drop-down list displays that CLS 
combination’s information (the Company, LOB, and States). A table of 
filings for that CLS combination is also displayed.

10. Choose a CLS combination from the CLS drop-down list.

The system displays that CLS combination’s information and populates the 
table with values based on entries made in the Filing section of the 
Program/Filing Group Setup tab.

11. Select a filing and click Edit Filing (or double-click on the filing).

The Edit Filing dialog displays.
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12. Complete or revise the fields.

Note: Fields marked with an asterisk are required.
13. When finished, click OK.

The Edit Filing dialog closes, the new or modified entries are saved, and the 
Filing Setup tab displays.

14. Repeat steps 10 to 13 for all CLS combinations and filings until the 
information on all filings is complete.

15. Click Create.

Tracker displays a status box that updates as the filings are created.
16. When the status box indicates that the process is done, click Close. 

The newly created filing(s) will appear on your My Filings tab, My Filings 
— All tab of the Filing Manager, and the Filings tab in the appropriate 
Filing Group.

Each filing is assigned a 12-character Tracker Filing ID based on the 
following:

• 2-character State Code

• 5-digit Filing Group number

• 5-digit sequence number (counter of filings created in that filing group)

Notes:
• For states that do not allow combined filings, Tracker will split the filings 

into separate rates, rules, and forms where applicable.

• The sequence number portion of the Filing ID does not recycle numbers of 
deleted filings.
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• If separate CLS combinations have the follow elements in common, Tracker 
automatically combines them into one row as a CG filing and displays CG - 
Company Group and the Company Codes and Company Names as CG - 
Company Group (10 - CO1, 20 - CO2):

• LOB

• state

• attachments (with matching state association and metadata associated 
with the attachment)

• dates



THE MY FILINGS — ALL TAB

TRACKER P&C VERSION 6.6 USER GUIDE  133

The My Filings — All Tab

The My Filings — All tab displays a list of all of the filings in the system where 
you are assigned as the filing manager. From here, you can directly access the 
filing details for any of your 
filings.

The My Filings — All tab can show all of your filings, or be filtered to show only 
those filings of a particular status (such as Started, Pending, or Closed) or only 
those with a Suspense Date (pending future action) attached.

Accessing the My Filings — All Tab
The My Filings — All tab can be accessed at any time from any point within 
Tracker using the View Menu option: View My Filings — All.

1. Select the View menu.
2. Select the View My Filings — All option. The Top Level with the My 

Filings — All tab will be displayed. 

Sorting the My Filings — All Tab
The Filing Description field is the unique identifier for each filing project in a 
Filing Group. As a result, the default sort order is first sorted by the Filing 
Description field so that each filing project is displayed together.

The default sort order of the My Filings - All tab is as follows:

• Filing Description (ascending)

• State (ascending)
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• LOB (ascending)

• FG # (descending)

• Company Code (ascending)

• Content (ascending)

• Sequence # (descending) 

Note: Sequence # is used in sorting but is not displayed.

You can change the sort order by right-clicking a column header and select a new 
sort order from the context menu.

A sort on any column uses the following sort order where the first sort criterion is 
always the column selected for the sort:

• [column selected] (ascending or descending based on selection)

• State (ascending)

• LOB (ascending)

• FG# (descending)

• Company Code (ascending)

• Content (ascending)

• Filing Description (ascending)

• Sequence # (descending) — not displayed

Example #1: a sort initiated on the State column in ascending order is:

• State (ascending)

• LOB (ascending)

• FG # (descending)

• Company Code (ascending)

• Content (ascending)

• Filing Description (ascending)

• Sequence # (descending) — not displayed

Example #2: a sort initiated on the LOB column in ascending order is:

• LOB (ascending)

• State (ascending)

• FG # (descending)

• Company Code (ascending)

• Content (ascending)

• Filing Description (ascending)

• Sequence # (descending) — not displayed
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Example #3: a sort initiated on the Content column in ascending order is:

• Content (ascending)

• State (ascending)

• LOB (ascending)

• FG# (descending)

• Company Code

• Filing Description

• Sequence # (descending) — not displayed

Filtering the My Filings — All Tab
You can filter your My Filings — All tab to display only the filings of a certain 
status group (or groups) which you define. On the Filing Group Header, there are 
located several status markers which tell you how many filings of each status 
(such as Started, Pending, Approved) are currently contained within a single 
filing group. Beside each of these status markers is a checkbox which can be used 
to define the status-types of filings you want to see.

There is also a Suspended button located to the right of these checkboxes. If 
pressed, only those filings having the status(es) specified and having a Suspense 
Date (future activity) attached will be listed. By using this feature you can list 
only those filings requiring your immediate attention.

Method: Filter the My Filings — All Tab

1. On the Filing Group Header, locate the Filing Status check boxes.
2. Click in the boxes beside each status type you want to appear in the My 

Filings — All tab.
3. If you want to view only filings having a Suspense Date attached, click the 

Suspended button located to the right of the checkboxes.
4. In the My Filings — All list, only filings having a status which you have 

selected will appear.

Method: Access a single filing

• On the My Filings — All tab select the filing you want to view and double-
click it to open the related details of the filing.

Accessing Filing Records from the Filing Group Level
You can access a single specific filing from its related Filing Group level using the 
My Filings tab or the Filings list tab.
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The My Filings tab displays a list of all of the filings in the selected filing group 
where you are assigned as the filing manager. The Filings tab displays a list of all 
of the filings in the selected filing group, including those where others are 
assigned as the filing manager. 

The Filing Description field is the unique identifier for each filing project in a 
Filing Group (see Create Filing Section). As a result, the default sort order is first 
sorted by the Filing Description field so that each filing project is displayed 
together.

See also Sorting the My Filings — All Tab on page 133.

Method: Access a filing from a Filing Group level

1. Navigate to the filing group with the filing you want to access.
2. On the My Filings tab or Filings list tab, double-click the filing you want to 

view.

The Filing level view of the filing displays.

Browsing through the Filing Records
You can browse through the filing records within a filing group, moving from one 

filing record to another, by using the Back  and Forward  toolbar 
buttons or equivalent Edit menu options.
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Filing Header

This area of the Filing screen contains detailed information about the filing, as 
well as information about the filing group to which the filing belongs.

The Filing level is designed to give you quick and easy access to all your filing 
information.

The Title Bar shows the Tracker Version, Tracker level, and the Identification 
Number.

The Filing Group Header shows the associated Filing Group #, FG Name and FG 
Description, theprogram that the filing group is a part of, and start date.

The Filing Header shows the filing's Descrip(tion), (start) Date, Filing Type, 
Filing Manager, (content) Type (Rate, Rule, Form, or a combination), Company, 
State, Line of Business, and File Status.

Below the Filing Header are various tabs that contain additional information. The 
tabs shown at the Filing Level are as follows:

• Filing Details

• Resources

• Comments

• Activities

• Forms (if it is a form filing)

• Rates (if it is a rate filing)

• Rules (if it is arule filing)

• Filing Forms

• Filing Package

Filing 
Group 
Header 

Filing 
Header

Tabs

Title Bar

Toolbar
Menu Bar
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• Other Attachments

• NAIC Filing Description

• Filing Fee

• SERFF (if viewing a SERFF filing)

The Tracker Filing ID
Each filing in the system is assigned a unique identification code to help you keep 
track of your filings.

This Tracker identification code is comprised of three elements:

• a State code (two digits)

• a Filing Group number (five digits)

• a Sequence number (five digits)

Note: The Sequence number is a running count of all filings in a filing group. For 
example, if there are five filings in a filing group and a new filing is created in that 
group, the system assigns the next sequential number.
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Filing Tabs

Below the filing header are various tabs which contain additional information.

The filing tabs are described in the following sections:

• The Filing Details Tab on page 140

• The Resources Tab on page 212

• The Comments Tab on page 213

• The Activities Tab – Filing Level on page 214

• The Forms Tab — Filing Group Level on page 147

• The Rates Tab – Filing Level on page 170

• The Rules Tab — Filing Group Level on page 181

• The Filing Forms Tab on page 215

• The Filing Package Tab – see Activities and the Filing Package Tab on page 
249

• The Other Attachments Tab – see Other Attachments on page 195

• The NAIC Filing Description Tab – see NAIC Filing Descriptions on page 
201

• The Filing Fee Tab – see Entering Filing Fees on page 203
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The Filing Details Tab

The Filing Details tab records additional general, date, and progress tracking 
information about a single filing. It is specific to one filing alone, even if that 
filing is part of a group of related multi-filings. You should add information to this 
tab as it becomes available, throughout the course of the filing process.

Note: The Filing Details tab contains a lot of information, and depending on the size of 
your monitor and your desktop set-up, you may need to use the vertical scroll bar 
located on the right-hand side of the tab to see all of the available fields.

Entering Filing Details Information

Note: Some of the fields (including most date fields) on the Filing Details tab will be 
filled in automatically by the system as different activities are performed and 
posted for the filing, as the filing process progresses. Many fields can be changed 
if necessary.

Method: Enter filing details

1. In the References information section:

• Enter the Insurance Department File #, if any, assigned by the DOI.

• Enter the Company Reference #, if your company will be using another 
number different than, or in addition to, the Tracker filing identification 
number to identify this filing.

• The Filing Statute will be automatically filled in by the system using 
information from the Regulatory Specialist. 

• If necessary, enter text in the Custom field.
2. In the Date Status information section:

• The Start Date will be automatically filled in when you create the 
filing.

• The Approved, Approval Received, Disapproved, Deemer, Filed, 
Req. Renewal Effective, Approved Effective, Withdrawn, 
Resubmitted, Respond By, Appr. Renewal Effective, Req. Effective, 
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Objection, and Custom Date fields will be updated as you perform the 
activities associated with them over the course of the filing process and 
by certain messages received from SERFF.

• In the Days option, enter the number of days after submission that you 
want this filing to take effect.

• The field names for the four Custom Dates are assigned in System 
Defaults: see Performing Custom Table Tasks on page 87.

3. In the Print/Mail/Automation Status information section:

• The Scheduled Mail, Actual Mail, Rate Built, and EDP Rate 
Effective dates will be updated as you perform the activities associated 
with them over the course of the filing process.

• Update the Print Status as necessary.
4. At the bottom of the Filing Details tab:

• The Tracker Reference # refers to the identification number for this 
filing if it was transferred from a version of Tracker before 4.0.
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Company Group Filings

This feature allows you to create filings for multiple companies that are filing the 
same policy forms, rates, and rules in any state.

Adding Company Group Filings

Note: You can add a new filing or filings while creating a new filing group.

Method: Add a Company Group filing

The steps for adding a Company Group filing are the same as the steps for adding 
any new filing. Follow the instructions for  Adding New Filings on page 126. 
When create new filings, if separate CLS combinations have the same LOB and 
state, Tracker automatically combines them into one row as a CG filing and 
displays CG - Company Group and the Company Codes and Company Names as 
CG - Company Group (10 - CO1, 20 - CO2).

Viewing the Companies in a Company Group Filing
The company group filing appears in the display list with CG in the company code 
field.

Method: View the companies in a Company Group filing

1. Navigate to the filing group with the company group filing that you want to 
view the companies for.

2. Highlight the company group filing.

3. Double-click the Company field in the header.

A list box displays showing the companies included in the group.
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4. To close the Company Group Filing Members list box, do one of the 
following:

• Click the X in the top right-hand corner of the list box.

• Press ESC.

• Press Return.
5. Navigate to the Filing level for the company group filing. 

Notice that the second tab from the left has been renamed “Companies/
Resources.” 

6. Click the Companies/Resources tab.

The Company Group Members list shows all the companies that form part 
of the group. 

Searching for a Company Group Filing
The search function is capable of searching for filings associated with specific 
company codes, including company group filings. 

For details on using the search function, see Performing Tracker Searches on page 
424.
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The search results include the company group (CG) filings where company code 
contains BT.

Note: When you search using the Company Code, always use the actual code number. 
CG is not recognized as a valid search criteria.

Generating Filing Forms for a Company Group Filing
For Company Group filings, there are a number of different ways in which the 
states want the filing forms to be completed. Some states require a separate filing 
form for each company in the group, while other states will accept a single copy 
of the form, as long as all the companies in the group are listed on the form. Even 
within a single state, the requirements may vary for each form.

With these varied requirements in mind, each filing form is reviewed before being 
added to Tracker to determine if a separate instance of the form is required for 
each company in the company group, or if only one instance of the form is 
required listing all companies in the company group. The filing form is then 
appropriately coded and added to Tracker to conform to a state’s requirements 
unique to each filing form.
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Schedule Items Overview

When it comes to adding schedule items to your filings, Tracker offers great 
flexibility. Schedule items—that is, forms, rates, rules, and other attachments—
can be added to filings of any type. For convenience, if they are added at the 
Filing Group level, each filing in the filing group with a status of Start will 
automatically contain a linked copy of the schedule item, complete with any 
changes made at the Filing Group level at a later time (though this link can be 
broken by making certain changes at the Filing level).

Adding Schedule Items
Adding a schedule item to a filing is as simple as navigating to the filing and 
clicking the appropriate button on the toolbar.

Note: If you start adding a schedule item to a filing that has a different type (for 
example, adding a rate schedule item to a rule filing), Tracker will check 
Regulatory Specialist to see if combined filings are allowed in that state. If they 
are not, you are prompted to cancel the addition or continue anyway. 

After the schedule item is added:

• Tracker adds the appropriate Form/Rate/Rule tab; if the filing is in Start 
status, also adds the appropriate Filing Group level items to the newly 
created tab

• Tracker checks the appropriate Type check box in the Filing banner 

• Tracker locks the corresponding Related Filing field (regardless of whether 
the filing was sent to SERFF or not)

For SERFF filings:

• (for filings not yet sent to SERFF) Tracker deletes any data in the Related 
Filing field at the time the field is locked. (If the filing was sent to SERFF, 
no data is deleted.)

• SERFF functionality for the new filing type will apply, that is, use of the 
SERFF/Supporting Documentation tab, the View Schedule button, auto-
populate Filing Forms, Public Access functionality, and others.

• Users will need to send newly added Form/Rate/Rule schedule items to 
SERFF via an Initial Submission, Filing Amendment, or an Objection 
Response.

• If additional Supporting Doc schedule requirements are needed as a result of 
the newly added Form/Rate/Rule schedule item, User will need to create 
User Added requirements to be sent as part of the Initial Submission, Filing 
Amendment or Objection Response. Tracker will not refresh the Supporting 
Doc schedule requirements or the list of filing forms on the Filing Forms 
tab.

• For Filing Amendments and Objection Responses, only the Rate Schedule 
item information is sent to SERFF. (Rate data is only sent with the initial 
submission).
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Refer to the following topics for details on adding and editing schedule items at 
the Filing Group and Filing level:

Forms
• Adding a New (or Editing an Existing) Filing Group Level Form on page 

147

• Adding a New (or Editing an Existing) Filing Level Form on page 151

Rates
• Adding a New (or Editing an Existing) Filing Group Level Rate on page 164

• Adding a New (or Editing an Existing) Filing Level Rate on page 173

Rules
• Adding a New (or Editing an Existing) Filing Group Level Rule on page 181

• Adding a New (or Editing an Existing) Filing Level Rule on page 186

Other Attachments
• Adding a New (or Editing an Existing) Filing Group Level Other 

Attachment on page 195

• Adding a New (or Editing an Existing) Filing Level Other Attachment on 
page 198
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Forms

In Tracker, the term forms refers to insurance policies, endorsement forms, riders, 
and so on, used to construct and contain the criteria of the insurance coverage 
being provided. New forms, form alterations, and form exceptions must often be 
filed with individual state insurance departments, with references made to the 
existing forms affected, in order to meet compliance regulations.

The Forms Tab — Filing Group Level
The Filing Group level Forms tab lists all of the forms, endorsements and other 
items attached to this filing group.

From this tab, you can access the details for any of the forms listed.

1. On the Forms tab, select the form record you want to view and double-click 
it to open the related Form Details dialog.

2. Click a tab title to view information on that tab screen.

Adding a New (or Editing an Existing) Filing Group Level 
Form

Tip: When you add a form at the Filing Group level, all filings with a Start status in 
that filing group will automatically contain the form. You can see these Filing 
Group level forms at the Filing level, and any changes made at the Filing Group 
level will appear in filings at the Filing level with a status of Start. If a filing that 
is not in Start status changes back to Start status (as a result of performing or 
deleting an activity), then any new or modified forms that were not previously 
included in that filing are still not included in the filing after the status change. 
Adding forms at the Filing Group level then making required changes at the Filing 
level may save you time compared to adding forms individually at the Filing 
level.

Method: Add a new or edit an existing Filing Group level form

1. Navigate to the Filing Group level for the desire filing group.

2. To create a new form, click the New Form toolbar button  or select 
Insert > New Form.

The New Form dialog opens.

Alternatively:
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To edit an existing form, double-click the desired form on the Forms tab.

The Form Details dialog opens (not shown, but similar to New Form 
dialog box).

3. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing group record. Check these to ensure 
that you are adding the form to the desired record.

4. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date.

• In the Form # field, enter the code/number assigned to this form by 
your company.

• If applicable, in the Advisory Form # field, enter the code/number 
assigned to this form by the relevant Advisory Organization.

• In the Title field, enter a brief title for this form.

• In the Edition Date field, enter the edition date for this form.

• In the Type field, select the form type from the drop-down list.

• In the Action area, select whether this is a New, Replacement or 
Withdrawn form.
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5. On the Attachments tab:

• To add a new attachment to the form, click Add, and using the file 
browser that opens, locate the required document. Double-click the 
required document, or select the document and click Open. If you have 
a DMS, select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

• Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.
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• In the Print Date field, enter the print date for this form.

• In the Typeset Date field, enter the typeset date for this form.
6. On the Memo tab:

• The Form # field displays the form number.

• The Title displays the form title.

• In the Memo field, enter a comment or description of the form. This text 
is included in the long filing letter. (See Understanding Filing Letters on 
page 351.)
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7. On the Misc. tab:

• In the Custom field, you can add more information about the form. 
Information in this field will not appear in the final filing package.

• In the Requirement area, select Mandatory, Optional, Conditional 
Mandatory, or Not Applicable.

• If this form will have an impact on related rates, select the Form 
Impacts Rates check box.
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8. On the Readability tab:

• In the Sentence Count field, enter the number of sentences in the text of 
the form.

• In the Word Count field, enter the number of words in the text of the 
form.

• In the Syllable Count field, enter the number of syllables in the text of 
the form.

• In the Flesch Score field, enter the Flesch Score (readability score) of 
the form.
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9. On the Replacement tab:

• Click Add.

The Replacement Attachment Selection dialog displays. 

The Available Attachments table displays a list of all the forms in the 
system that this new forms may be replacing. 

To move one or more forms from the list of Available Attachments to the 
Selected Attachments table, highlight the applicable forms, then use the >, 
>>, <, << buttons to move your selections.

Enter the applicable replaced information as follows:
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a. Enter the Replaced Form # and Replaced Edition.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced rates.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

10. To add another new form, click Next. 

OR

To finish, click OK. 

The new form(s) will be added (or the existing form updated), and the dialog 
will close.

 The Forms Tab — Filing Level
The Filing level Forms tab lists all of the forms for this filing, both Filing Group 
level forms and Filing level forms.

From this tab, you can access the details for any of the forms listed.

1. On the Forms tab, select the form record you want to view and double-click 
it to open the related Form Details dialog.

2. Click a tab title to view information on that tab screen.

Adding a New (or Editing an Existing) Filing Level Form

When you add a form at the Filing Group level, all filings with a Start status in 
that filing group will automatically contain the form. You can see these Filing 
Group level forms at the Filing level, and any changes made at the Filing Group 
level will appear in filings at the Filing level with a status of Start. If a filing that 
is not in Start status changes back to Start status (as a result of performing or 
deleting an activity), then any new or modified forms that were not previously 
included in that filing are still not included in the filing after the status change. 
However, if you change certain fields at the Filing level, marked in this guide with 

a broken link icon, , the form will become independent of changes at the 
Filing Group level, in effect becoming a Filing level form. 
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Notes:

• Filing level forms can be edited if the filing has not been submitted.

• Forms attached at the Filing level only apply to that filing.

Method: Add a new or edit an existing Filing level form

1. Navigate to the Filing level for the desired filing.

2. Click the New Form toolbar button  or select Insert > New Form.

The New Form dialog box opens.

Alternatively:

To edit an existing form, double-click the desired form on the Forms tab.

The Form Details dialog box opens (not shown, but similar to New Form).

3. The basic information fields at the top of the dialog box will be 
automatically filled with information from the filing record. Check these to 
ensure that you are adding the form to the desired record.

4. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date.
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•  In the Form # field, enter the code/number assigned to this form by 
your company.

•  If applicable, in the Advisory Form # field, enter the code/number 
assigned to this form by the relevant Advisory Organization.

•  In the Title field, enter a brief title for this form.

•  In the Edition Date field, enter the edition date of this form.

•  In the Type field, select the form type from the drop down list.

•  In the Action area, select whether this is a New, Replacement, or 
Withdrawn form attachment. Note that this is a mandatory field for 
SERFF filings.

If this is a Replacement, enter the Previous State Filing #. (This is the 
DOI file number assigned by the state to the previous filing.)

5. On the Attachments tab:

•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.
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• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.

 

• In the Print Date field, enter the print date for this form.

• In the Typeset Date field, enter the typeset date for this form.

6.  On the Memo tab:

You can enter a comment or description of the form. Text entered here is 
included in the long filing letter. (See Understanding Filing Letters on page 
351.)
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7. On the Misc. tab:

•  In the Requirement area, select Mandatory, Optional, 
Conditional Mandatory, or Not Applicable.

•  If this form will have an impact on related rates, select the Form 
Impacts Rates check box.

•  In the Custom field, you can add more information about the form. 
Information in this field will not appear in the final filing package.
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8. On the Readability tab:

•  In the Sentence Count field, enter the number of sentences in the 
text of the form.

•  In the Word Count field, enter the number of words in the text of 
the form.

•  In the Syllable Count field, enter the number of syllables in the 
text of the form.

•  In the Flesch Score field, enter the Flesch Score (readability score) 
of the form.
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9.  On the Replacement tab:

10. Click Add/Lookup.

The Replacement Attachment Selection dialog opens.

The Available Attachments table displays a list of all the forms in the 
system that this new form may be replacing. 

To move one or more forms from the list of Available Attachments to the 
Selected Attachments table, highlight the applicable form, then use the >, 
>>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the form to 
be replaced, enter the replaced information.

a. Enter the Replaced Form #and the Replaced Edition field.



FORMS

TRACKER P&C VERSION 6.6 USER GUIDE  161

b. Click the V button to add your manual entry to the Selected 
Attachments table.

a. Repeat steps (a) and (b) as necessary to add additional replaced forms.

b. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

11. On the Status tab:

• On the Tracker Status drop-down list, you can select a status for this 
form only, independent of the status of the filing, but use with caution.

•  If you want the form to be included in the overall filing, select the 
Enable check box.

•  If this form is specific for this state, select the State Specific check 
box.

• The Replacement Effective Date will be automatically entered by the 
system in the future when this new form is replaced, but only if the form 
was added to the Replacement tab of the new form.

12. To add another new form, click Next.

OR

To finish, click OK. 
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The new form reference(s) will be added (or the existing form reference 
updated), and the dialog will close.

Enabling Forms
Tracker provides the ability to selectively enable forms.

When a form is enabled (Enable set to Yes), it will be sent to SERFF with the 
initial filing or it can be added to a Filing Amendment or Objection Response, or 
it will be included in a paper filing (will print as part of the filing package). When 
a form is not enabled (Enable set to No), it is not available for a SERFF filing nor 
will it be included in a paper filing.

Method: Disable a form

By default, most forms will be enabled—form part of the filing package. To 
disable a form and not include it in the filing package you must perform the 
following steps:

1. On the Forms tab, highlight the form that you would like to disable. 
2. Right-click the form that is selected.

A dialog displays.

 
3. By default, the form will already have a checkmark to the left of the Enable 

option.
4. Click Enable. 

The dialog closes and No appears in the Enable column in the table of 
forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

Method: Enable a form

If you have disabled a form and you want to enable it, follow these steps:

1. On the Forms tab, highlight the form that you would like to enable. 

This form 
will not be 
included 
in the 
filing 
package.
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2. Right-click the form that is selected. 

A dialog displays.

 
3. Click Enable. 

The dialog closes and Yes appears in the Enable column in the table of 
filing forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.
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Rates and Rate Exceptions

Rates are the premium amounts which insurance companies charge their 
customers. Rate exceptions are rates, devised by individual insurance companies, 
which deviate from state-established standards. Rates are generally managed and 
tracked through the use of standard manuals and manual pages; new rates, rate 
alterations, and rate exceptions must often be filed with individual State Insurance 
Departments, with references made to the manual pages affected, in order to meet 
regulations. 

The Rates Tab — Filing Group Level
The Filing Group level Rates tab lists all of the rates and rate exceptions attached 
to this filing group.

From this tab you can access the rate details for any of the rates listed.

1. On the Rates tab for the desired filing group, double-click any rate in the 
Rate List subtab to open the related Rate Details dialog.

2. On the Rate Details dialog, click a tab to display its information.

Setting the Filing Group Level Rate Information
The value in this field flows through to the filings unless this field is changed at 
the Filing level.

Method: Set the Filing Group level rate information

At the Filing Group level for the desired filing group, on the Rates tab:

• Select a Rate Change Type from the drop-down list: Decrease, Increase, 
Rate Neutral. or leave the default value of blank.

Adding a New (or Editing an Existing) Filing Group Level 
Rate

Tip: When you add a rate at the Filing Group level, all filings in that filing group with 
a status of Start will automatically contain the rate. You can see these Filing 
Group level rates at the Filing level, and any changes made at the Filing Group 
level will appear at the Filing level. If a filing that is not in Start status changes 
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back to Start status (as a result of performing or deleting an activity), then any new 
or modified rates and rate exceptions that were not previously included in that 
filing are still not included in the filing after the status change. Adding rates and 
rate exceptions at the Filing Group level then making required changes at the 
Filing level may save you time compared to adding rates and rate exceptions 
individually at the Filing level.

Method: Add a new (or edit an existing) Filing Group level rate

1. Navigate to the Filing Group level for the desire filing group.

2. To create a new Filing Group Level Rate, click the New Rate toolbar 

button  to open the New Rate dialog, or select Insert > New Rate.

The New Rate dialog displays (shown below).

Alternatively:

To edit an existing Filing Group Level Rate, double-click the rate 
attachment on the Rate List on the Rates tab.

The Rate Details dialog displays (not shown, but similar to New Rate).

3. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing group record. Check these to see that 
you are adding the rate to the desired filing group.

Begin entering information on the General tab for the next rate.
4. On the General tab:
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• The Entered By field will automatically be filled in with your name. 
The Date Entered field will have the rate’s creation date. The date can 
be changed by clicking the drop-down button and selecting a date from 
the calendar.

• In the Company Rate # field, enter the code/number assigned to this 
rate by your company.

• In the Advisory Rate # field, enter the number assigned to this rate by 
the advisory organization.

• Enter the Exception Page #.

• Enter the Edition Date.

• In the Title field, enter a brief title for this rate attachment.

• In the Action area, select whether this is a New, Replacement or 
Withdrawn rate attachment. Note that this is a mandatory field for 
SERFF filings.

5. On the Attachments tab:

• To add a new attachment to the rate, click Add, and using the file 
browser that opens, locate the required document. Double-click the 
required document, or select the document and click Open. If you have 
a DMS, select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.
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• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

a. Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.

 

6. On the Memo tab:

• The Rate # and Title are automatically filled in.

• The Memo field provides room for a lengthy comment or background 
description of the attachment. Text entered here is included in the long 
filing letter. (See Understanding Filing Letters on page 351.)
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7. On the Misc. tab:

The Custom field allows you to add more information about the rate. 
Information in this field will not appear in the final filing package.

8. On the Replacement tab:

9. Click Add, and the Replacement Attachment Selection dialog displays.
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The Available Attachments table displays a list of all the rate attachments 
in the system that this new rate attachment may be replacing. 

To move one or more rate attachments from the list of Available 
Attachments to the Selected Attachments table, highlight the applicable 
rate attachment, then use the >, >>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the rate to 
be replaced, enter the replaced information.

a. Enter the Replaced Rate # and the Replaced Edition field.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

a. Repeat steps (a) and (b) as necessary to add additional replaced rates.

b. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

10. Click Next.

The information on all the tabs will be saved, the new rate reference will be 
added to the main Rate tab at Filing Group level, and another New Rate 
dialog will open.

OR

Click OK. 

The information on all the tabs will be saved, the new rate item will be 
added to the main Rate tab at Filing Group level, and the New Rate dialog 
will close.

OR

Click Cancel to close the New Rate dialog without saving.
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The Rates Tab – Filing Level
The Filing level Rates List tab lists all of the rates and rate exceptions for this 
filing; both Filing Group level filings and Filing level filings.

From this tab you can access the rate details for any of the rates listed.

1. On the Rates tab for the desired filing, double-click any rate in the Rate 
List subtab to open the related Rate Details dialog.

2. Click a tab title to view information on that tab screen.

If this is a Company Group filing, a CG Impact tab will also display.

Viewing or Changing Rates and Rate Exceptions at the 
Filing Level 
On the Rates tab for a filing, you can access the details for any of the rates or rate 
exceptions listed, and enter or change the information for this filing.

Note: When changed at the Filing level, a filing’s Rate Change Type will become 
independent of the Rate Change Type setting at the Filing Group level.

Entering Filing Level Rate Information
You can enter or change the rate information that applies to this filing only. This 
can include performing a rate action to request an increase or decrease in a rate.

Method: Enter Filing level rate information

1. Navigate to the Filing level for the desired filing.
2. Click the Rates tab.
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3. If required, select an entry from the Rate Change Type drop-down list 
(blank, Increase, Decrease, or Rate Neutral). 

Note: When changed at the Filing level, a filing’s Rate Change Type will become 
independent of the Rate Change Type setting at the Filing Group level.
4. Select an entry from the Filing Method drop-down list, which by default 

shows Prior Approval, File and Use, Flex Rating, or Use and File. (This 
list can be customized by the Tracker Administrator. See Filing Method 
(Rate) on page 290.)

5. Click the Rate Change Details tab. This tab contains the Public Access 
section (which indicates whether the document affiliated with the 
requirement can be publicly accessed) and a grid with company-specific rate 
change information for the filing.

6. Double-click a row containing data.

The Rate Change By Company dialog opens.

Note: If Rate Change Type is set to Not Applicable, the fields on the Rate Change By 
Company dialog will be locked and empty.

7. Enter (or view) the company-specific rate change information for the filing, 
as follows:

a. The Company Name field is read-only.
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b. In the % Indicated change, enter a positive or negative percentage 
value. 

c. In the Overall % Rate Impact field, enter a positive or negative 
percentage value.

d. In the Written premium change for this program field, enter a 
positive or negative dollar value. The value cannot exceed ten digits and 
must be a whole number; the maximum value that can be entered is 2 
billion.

e. In the # of policyholders affected for this program field, enter a value. 
It cannot exceed ten digits or 2 billion and must be a whole number.

f. In the Written premium for this program field, enter a dollar value.

g. In the Max % change requested for this program field, enter a 
positive percentage value.

h. The Max % approved for this program is the maximum percentage 
increase allowed by the state. The approved values for SERFF filings 
will be shown on the disposition report and will be populated into the 
approved fields by the system for SERFF filings. This field is read-only.

i. In the Min % change requested for this program field, enter a 
positive percentage value.

j. The Min % approved for this program is the minimum percentage 
increase allowed by the state. The approved values for SERFF filings 
will be shown on the disposition report and will be populated into the 
approved fields by the system for SERFF filings. This field is read-only.

8. If this is a company group filing, a CG Impact tab is displayed. Click this 
tab.

9. In the % Indicated Change field, enter a positive or negative percentage 
value.

10. In this tab, enter the Overall percentage rate impact for the filing.

The Effect of Rate Filing section in this tab includes two read-only fields:

• Written premium change for this program

• # of policyholders affected

These fields are read-only because their values are calculated by the system.
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11. Click the Save button on the Tracker toolbar to save your changes.
12. Click OK to save your changes.
13. Click the Last Revision tab.

14. In this tab, enter the following information for the previous rate revision:

• Overall percentage

• Effective Date – click the drop-down arrow to select a date from the 
calendar

• Filing Method – Prior Approval, File and Use, Flex Rating, or Use 
and File. (This list can be customized by the Tracker Administrator. See 
Filing Method (Rate) on page 290.)

15. Click the Save button on the Tracker toolbar to save your changes.

Adding a New (or Editing an Existing) Filing Level Rate

When you add a rate at the Filing Group level, all filings in that filing group with 
a status of Start will automatically contain the rate. You can see these Filing 
Group level rates at the Filing level, and any changes made at the Filing Group 
level will appear at the Filing level. If a filing that is not in Start status changes 
back to Start status (as a result of performing or deleting an activity), then any new 
or modified rates and rate exceptions that were not previously included in that 
filing are still not included in the filing after the status change. However, if you 
change certain fields at the Filing level, marked in this guide with a broken link 

icon, , the rate attachment will become independent of changes at the Filing 
Group level, in effect becoming a Filing level rate attachment. If a filing that is 
not in Start status changes back to Start status (as the result of an activity being 
run), then any new or modified Filing Group level rate attachments that were not 
previously included in that filing are still not included in the filing after the status 
change.

Method:  Add a new (or edit an existing) Filing level rate

1. Navigate to the desired filing.
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2. To create a new Filing Level rate attachment, click New Rate  to 
open the New Rate dialog, or select Insert > New Rate.

The New Rate dialog opens (shown below).

Alternatively:

To edit an existing Filing Level rate attachment, double-click the rate 
attachment on the Rate List on the Rates tab.

The Rate Details dialog displays (not shown, but similar to New Rate).

The basic information fields at the top of the dialog will be automatically 
filled with information from the filing record. Check these to see that you 
are adding the rate attachment to the desired record.

3. On the General information tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date. The date can be changed by clicking 
the drop-down button and selecting a date from the calendar.

•  In the Company Rate # field, enter the code/number assigned to 
this rate by your company.

•  In the Advisory Rate # field, enter the number assigned to this rate 
by the advisory organization.

•  Enter the Exception Page #.

•  Enter the Edition Date.
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•  In the Title field, enter a brief title for this rate attachment.

•  In the Action area, select whether this is a New, Replacement, or 
Withdrawn rate attachment. Note that this is a mandatory field for 
SERFF filings. If this is a replacement, enter the Previous State Filing 
#. (This is the DOI file number assigned by the state to the previous 
filing.) 

4. On the Attachments tab:

•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.
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• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.

 

5.  On the Memo tab:

• The Rate # and Title are automatically filled in.

• The Memo field provides room for a lengthy comment or background 
description of the attachment. Text entered here is included in the long 
filing letter. (See Understanding Filing Letters on page 351.)
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6. On the Misc. tab:

 The Custom field allows you to add more information about the rate. 
Information in this field will not appear in the final filing package.

7.  On the Replacement tab:

8. Click Add/Lookup, and the Replacement Attachment Selection dialog 
box opens.
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The Available Attachments table displays a list of all the rate attachments 
in the system that this new rate attachment may be replacing. 

To move one or more rate attachments from the list of Available 
Attachments to the Selected Attachments table, highlight the applicable 
rate attachment, then use the >, >>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the rate to 
be replaced, enter the replaced information:

a. Enter the Replaced Rate # and the Replaced Edition field.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced rates.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

9. On the Status tab:

Enter the following information:

• The Status field allows you to enter a status for this rate attachment 
only, independent of the status of the filing. However, use this field with 
caution if you chose to manually manipulate the status for a rate 
attachment.
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• The Effective Date is the Approved Effective Date of the filing. It will 
be populated by the system when you perform the activity to approve 
the filing.

•  If you want the rate attachment to be included in the overall filing, 
select the Enable check box.

•  If this rate is specific for this state, select the State Specific 
checkbox.

• The Replacement Effective Date will be automatically entered by the 
system in the future when this new rate is replaced, but only if the rate 
was added to the Replacement tab of the new rate.

10. To add another new rate attachment, click Next. 

The New Rate dialog box will re-appear ready for another new rate 
attachment.

OR 

To finish, click OK. 

The new rate attachment(s) will be added, (or the existing rate attachment 
will be updated) and the dialog will close.

Enabling Rates
Tracker provides the ability to selectively enable filing rates.

When a rate is enabled (Enable set to Yes), it is available for a SERFF filing 
(available to satisfy filing requirements) or will be included in a paper filing (will 
print as part of the filing package). When a rate is not enabled (Enable set to No), 
it is not available for a SERFF filing (it is not available to satisfy filing 
requirements) or it will not be included in a paper filing (it will not print as part of 
the filing package).

This rate 
will not be 
included 
in the 
filing 
package.
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Method: Disable a rate

By default, most rates will be enabled—form part of the filing package. To disable 
a rate and not include it in the filing package you must perform the following 
steps:

1. Navigate to the Filing level of the desired filing.
2. Click the Rates tab.
3. Right-click the rate that you would like to disable. 

A dialog displays.

 
4. By default, the rate will already have a checkmark to the left of the Enable 

option.
5. Click Enable.

The dialog closes and No appears in the Enable column in the table of filing 
forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

Method: Enable a rate

If you have disabled a rate and you want to enable it, follow these steps:

1. Navigate to the Filing level of the desired filing.
2. Click the Rates tab.
3. Right-click the rate that you would like to enable. 

A dialog displays.

 
4. Click Enable. 

The dialog closes and Yes appears in the Enable column in the table of 
rates.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.
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Rules and Rule Exceptions

Rules are underwriting guidelines used in the insurance industry to determine 
what rate category applies to an applicant’s insurance coverage. Rule exceptions 
are rules, devised by individual insurance companies, which deviate from state-
established standards. Rules are generally managed and tracked through the use of 
standard manuals and manual pages; new rules, rule alterations, and rule 
exceptions must often be filed with individual State Insurance Departments, with 
references made to the manual pages affected, in order to meet compliance 
regulations.

The Rules Tab — Filing Group Level
The Filing Group level Rules tab lists all of the rules and rule exceptions attached 
to this filing group.

From this tab, you can access the details for any of the Filing Group level rules.

1. On the Rules tab for the desired filing group, double-click any rule to open 
the related Rules dialog.

2. Click a tab title to view information on that tab.

Adding a New (or Editing an Existing) Filing Group Level 
Rule
The Rules tab at the Filing Group level lists all of the rules added to the selected 
filing group. 

When you add a rule at the Filing Group level, all filings in that filing group with 
a status of Start will automatically contain the rule. You can see these Filing 
Group level rules at the Filing level, and any changes made at the Filing Group 
level will appear at the Filing level. If a filing that is not in Start status changes 
back to Start status (as a result of performing or deleting an activity), then any new 
or modified rules that were not previously included in that filing are still not 
included in the filing after the status change. 

Tip: Adding rules at the Filing Group level then making required changes at the Filing 
level may save you time compared to adding rules individually at the Filing level. 

Method: Add a new (or edit and existing) Filing Group level rule

1. Navigate to the desired filing group.
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2. To add a new Rule to a filing group, click the New Rule toolbar button 

 or select Insert > New Rule.

The New Rule dialog opens (shown below).

Alternatively: 

To edit an existing Rule, double-click the desired rule.

The Rule Details dialog opens (not shown, but similar to New Rule).

3. The basic information fields at the top of the dialog will be automatically 
filled with information from the filing group record. Check these to ensure 
that you are adding the rule to the desired record.

4. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date. The date can be changed by clicking 
the drop-down button and selecting a date from the calendar.

• In the Company Rule # field, enter the code/number assigned to this 
rule by your company.

• If applicable, in the Advisory Rule # field, enter the code/number 
assigned to this rule by the relevant advisory organization.

• In the Title field, enter a brief title for this rule.

• In the Exception Page # field, enter the manual page number for this 
rule.

• In the Edition Date field, enter the edition of this rule.
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• In the Action area, select whether this is a New, Replacement, or 
Withdrawn rule.

5. On the Attachments tab:

• To add a new attachment to the rule, click Add, and using the file 
browser that opens, locate the required document. Double-click the 
required document, or select the document and click Open. If you have 
a DMS, select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

• Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.
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6. On the Memo tab:

• The Rule # field displays the rule number entered on the General tab.

• The Title field displays the rule title entered on the General tab.

• In the Memo field, enter a comment or background description of the 
rule. This text is included in the long filing letter. (See Understanding 
Filing Letters on page 351.)

7. On the Misc. tab:
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The Custom field allows you to add more information about the rule. 
Information in this field will not appear in the final filing package.

8. On the Replacement tab:

9. Click Add, and the Replacement Attachment Selection dialog displays. 

The Available Attachments table displays a list of all the rules in the 
system that this new rule may be replacing. 

To move one or more rules from the list of Available Attachments to the 
Selected Attachments table, highlight the applicable rule, then use the >, 
>>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the rule to 
be replaced, enter the replaced information.

a. Enter the Replaced Rule# and Replaced Edition.
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b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced rules.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

e. Click OK when done.
10. To add another new rule reference, click Next. 

The New Rule dialog opens

OR

To finish, click OK. 

The new rule will be added (or the existing rule updated), and the dialog will 
close.

The Rule Tab – Filing Level
The Filing level Rules tab lists all of the rules for this filing at both the Filing 
Group and Filing levels.

From this tab, you can access the details for any of the rules listed.

1. On the Rules tab, double-click the Rule record to open it.
2. Click a tab title to view or change information.

Adding a New (or Editing an Existing) Filing Level Rule 

When you add a rule at the Filing Group level, all filings in that filing group with 
a status of Start will automatically contain the rule. You can see these Filing 
Group level rules at the Filing level, and any changes made at the Filing Group 
level will appear at the Filing level. If a filing that is not in Start status changes 
back to Start status (as a result of performing or deleting an activity), then any new 
or modified rules that were not previously included in that filing are still not 
included in the filing after the status change. However, if you change certain fields 

at the Filing level, marked in this guide with a broken link icon, , the rule will 
become independent of changes at the Filing Group level, in effect becoming a 
Filing level rule.
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Method: Add a new (or edit an existing) Filing level rule

1. To add a new Rule, at the Filing level, click the New Rule toolbar button 

 or select Insert > New Rule.

The New Rule dialog displays (shown below).

OR

To edit an existing Rule, double-click the desired rule.

The Rule Details dialog displays (not shown, but similar to New Rule).

2. The basic information fields at the top of the dialog box will be 
automatically filled with information from the filing record. Check these to 
ensure that you are adding the rule to the desired record.

3. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date.

•  In the Company Rule # field, enter the code/number assigned to 
this rule by your company.

•  If applicable, in the Advisory Rule # field, enter the code/number 
assigned to this rule by the relevant advisory organization.

•  In the Title field, enter a brief title for this rule.
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•  In the Exception Page # field, enter the manual page number for 
this rule.

•  In the Edition Date field, enter the edition of this rule.

•  In the Action area, select whether this is a New, Replacement, or 
Withdrawn rule. Note that this is a mandatory field for SERFF filings. 
If this is a Replacement, enter the Previous State Filing #. (This is the 
DOI file number assigned by the state to the previous filing.)

4. On the Attachments tab:

•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.
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•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.

 

5. On the Memo tab:

• The Rule # field displays the Rule number.

• The Title displays the rule’s title.

•  In the Memo field, enter a comment or background description of 
the rule. This text is included in the long filing letter. (See 
Understanding Filing Letters on page 351.)
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6. On the Misc. tab:

 In the Custom field, you can add more information about the rule. 
Information in this field will not appear in the final filing package.

7. On the Replacement tab:
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• Click Add/Lookup, and the Replacement Attachment Selection dialog 
appears. The Available Attachments table displays a list of all the rules in 
the system that this new rule may be replacing. 

To move one or more rules from the list of Available Attachments to the 
Selected Attachments table, highlight the applicable rule, then use the >, 
>>, <, << buttons to move your selections.

If the list of Available Attachments is blank or does not contain the rule to 
be replaced, enter the replaced information.

a.  Enter the Replaced Rule # and Replaced Edition.

b. Click the V button to add your manual entry to the Selected 
Attachments table.

c. Repeat steps (a) and (b) as necessary to add additional replaced rules.

d. Use the up and down arrows above the Selected Attachments table to 
move the entries within this table so that the list of attachments are in 
the correct order.

 

e. Click OK when changes to this window are complete, or click Cancel 
to close this window without making any changes.
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8. On the Status tab:

• On the Tracker Status drop-down list, you can select a status for this 
rule only, independent of the status of the filing, but use with caution.

•  If you want the rule to be included in the overall filing, select the 
Enable check box.

•  If this rule is specific for this state, select the State Specific check 
box.

• The Replacement Effective Date will be automatically entered by the 
system in the future when this new rule is replaced, but only if the rule 
was added to the Replacement tab of the new rule.

9. To add another new rule, click Next.

OR

To finish, click OK. 

The new rule reference(s) will be added (or the existing rule reference(s) 
updated), and the dialog box will close.
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Linking Related Filings

Sometimes, you may need to file related filings (of different types) separately. 
You may be doing this because certain states do not allow you to, for example, file 
forms and rates together, or because your company may not allow combined 
filings as a general business practice. In cases where you submit related filings 
separately, states may require a cross-reference (or “link”) in each filing to any 
related filings.

You add these cross-references to the Related Filings section in one of two ways:

• by selecting a filing from a list of filings that Tracker has determined may be 
related, or 

• by searching the system and selecting from the search results. Once the ID 
has been entered, the filings are effectively linked to each other.

Note: The ID that is used is the related filing’s Company Reference # if one exists at 
the time the filing is sent to SERFF. If no Company Reference # is present in the 
related filing, then the field will be populated with the Tracker Filing ID of the 
related filing. If the related filing’s Company Tracking # changes prior to 
submitting the filing to SERFF (because the user added, changed, or deleted the 
Company Reference #), then the number shown in the Related Filings area will 
be updated. After the filing is submitted to SERFF, the value in the field will be 
updated in Tracker, but not passed to SERFF.

Method: Link related filings

1. In the Related Filings section of the filing header at the Filing level, click 

the  button next to the filing type you want to search.

The Related Filings dialog displays. Any potentially related filings are 
listed.
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2. If the related filing you are searching for is listed, double-click it to add it to 
the respective Related Filings type.

If the related filing you are searching for is not listed, you can search for the 
filing manually.

a. Click Search.

b. Enter your search criteria, then click Search again. (For more 
information about searching Tracker, see Performing Tracker Searches 
on page 424.)

Any filings matching your search criteria are displayed in the Search 
Results tab.

c. If the related filing you are searching for is listed, double-click it to add 
its filing ID to the respective Related Filings type.

After the filing ID has been entered, the related filing is now linked to the filing 
you are working on. You can double-click the filing ID of the related filing to 
quickly open the related filing.

Note: If the related filing is a combined filing, two of the Related Filings fields will be 
populated with the related filing values. For example, if the related filing is a 
combined Rate and Form filing, then both the Form and Rate fields in the 
Related Filings section will be populated with filing numbers.
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Other Attachments

In addition to rates, rules, and forms, filings usually require other supporting 
documentation (for example, actuarial memorandums, exhibits, certifications, and 
so on). 

The Other Attachment Tab — Filing Group Level
The Other Attachments tab is the area within Tracker in which any supporting 
documentation you want to include in the filing should be attached. You can add 
these other attachments at either the Filing Group or Filing level. The Other 
Attachments tab at the Filing Group level lists all of the Other Attachments 
added to the selected filing group. 

Adding a New (or Editing an Existing) Filing Group Level 
Other Attachment
If you add Other Attachments at the Filing level, you can choose whether they 
print with the filing.

If you add an Other Attachment at the Filing Group level, then for each filing in 
the filing group, the new attachment will be automatically set to print with the 
filing.

Tip: When you add an Other Attachment at the Filing Group level, all filings in that 
filing group with a status of Start will automatically contain the Other Attachment. 
You can see these Filing Group level other attachments at the Filing level, and any 
changes made at the Filing Group level will appear at the Filing level in filings 
with a status of Start. If a filing that is not in Start status changes back to Start 
status (as a result of performing or deleting an activity), then any new or modified 
Filing Group level items that were not previously included in that filing are still 
not included in the filing after the status change.Adding Other Attachments at the 
Filing Group level then making required changes at the Filing level may save you 
time compared to adding Other Attachments individually at the Filing level.

Method: Add a new or edit an existing Filing Group level Other 
Attachment

1. Navigate to the Filing Group level of the desired filing group.
2. To create a new Other Attachment, click the New Other Attachment 

toolbar button  or select Insert > New Other Attachment.
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The New Attachment dialog opens (shown below).

OR

To edit an existing Other Attachment, double-click the attachment on the 
Other Attachments tab.

The Attachment Details dialog opens (not shown, but similar to New 
Attachment).

3. On the General tab:

• The Entered By and Date Entered fields will automatically be filled in 
with your name and today’s date. The date can be changed by clicking 
the drop-down button and selecting a date from the calendar.

• Enter the Title of the new attachment, or edit the existing Title.

• Select an attachment Type from the drop-down menu.

• If required, enter (or edit) text in the Memo box to describe this 
attachment. Text entered here will not appear in the final filing.
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4. On the Attachments tab:

• To add a new Other Attachment, click Add, and using the file browser 
that opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

• To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS. 

• In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

• Use the up and down arrows above the Attachments table to move the 
entries within this table so that the list of attachments are in the correct 
order.

 

5. To add another Other Attachment, click Next. 

OR

• To finish, click OK.
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The new Other Attachment(s) will be added (or the existing Other 
Attachment updated), and the dialog will close.

Note: For SERFF filings: If you attempt to delete or modify an Other Attachment that 
has been affiliated with a SERFF requirement in a filing that has been submitted, 
you will get a warning message.

The Other Attachments Tab — Filing Level
The Other Attachments tab is the area within Tracker in which any supporting 
documentation you want to include in the filing should be attached. You can add 
these other attachments at either the Filing Group or Filing level.

Adding a New (or Editing an Existing) Filing Level Other 
Attachment

If you add other attachments at the Filing level, you can choose whether they print 
with the filing.

Important: When you add an Other Attachment at the Filing Group level, all filings in that 
filing group with a status of Start will automatically contain the Other Attachment. 
You can see these Filing Group level other attachments at the Filing level, and any 
changes made at the Filing Group level will appear at the Filing level in filings 
with a status of Start. If a filing that is not in Start status changes back to Start 
status (as a result of performing or deleting an activity), then any new or modified 
Filing Group level items that were not previously included in that filing are still 
not included in the filing after the status change. However, if you change certain 

fields at the Filing level, marked in this guide with a broken link icon, , the 
other attachment will become independent of changes at the Filing Group level, in 
effect becoming a Filing level other attachment. 

Method: Add a new or edit an existing Filing level Other Attachment

At the Filing level:

1. To create a new Other Attachment, click the New Other Attachment 

toolbar button  or select Insert > New Other Attachment.

The New Attachment dialog displays.

OR

To edit an existing Other Attachment, double-click the attachment on the 
Other Attachments tab.
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The Attachment Details dialog displays.

2. On the General information tab:

• Enter the Title of the new attachment, or edit the existing Title.

• Select an attachment Type from the drop-down menu.

• If required, enter (or edit) text in the Memo box to describe this 
attachment. Text entered here will not appear in the final filing.

• If required, select Enable.
3. On the Attachments tab:
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•  To add a new attachment, click Add, and using the file browser that 
opens, locate the required document. Double-click the required 
document, or select the document and click Open. If you have a DMS, 
select Browse DMS if the attachment is located in aDMS.

Tip: Select a file on a shared network drive or a DMS, not a local drive. This will help 
prevent problems if other users work with this filing.

• To view an existing attachment, select the document and click View 
Attachment, or double-click the attachment.

•  To replace an existing attachment, select the attachment in the 
Attachments table and click Modify, and using the browser that opens, 
locate the required document. Double-click the required document, or 
select the document and click Open. If you have a DMS, select Browse 
DMS if the attachment is located in a DMS.

•  In the No. of Pages field, enter the number of pages in the attached 
document.

• Repeat above steps for additional attachments.

•  Use the up and down arrows above the Attachments table to move 
the entries within this table so that the list of attachments are in the 
correct order.

 

4. To add another Other Attachment, click Next. 

OR

To finish, click OK. The new Other Attachment(s) will be added, and the 
dialog box will close.
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NAIC Filing Descriptions

You can enter the NAIC filing description at the Filing Group level or Filing level. 
This description is copied into the corresponding filing forms. For SERFF filings, 
the information is also sent with the filing electronically to the state.

When you add a NAIC filing description at the Filing Group level, all filings in 
that filing group with a status of Start will automatically contain the NAIC filing 
description. You can see the Filing Group level NAIC filing description at the 
Filing level, and any changes made at the Filing Group level will appear at the 
Filing level in filings with a status of Start. If a filing that is not in Start status 
changes back to Start status (as a result of performing or deleting an activity), then 
any new or modified Filing Group level items that were not previously included in 
that filing are still not included in the Filing after the status change.

Method: Enter (or edit) the NAIC filing description at the Filing Group 
level

1. Navigate to the Filing Group level of the desired filing group.
2. Click the NAIC Filing Description tab.

3. Enter (or edit) the NAIC Filing Description, then click the Save button on 
the Tracker toolbar.

The filing description is saved and is copied into the filings in this filing 
group. If you change this description later, the change will automatically 
appear in the filings in this filing group, unless you have edited the 
description at the Filing level.

Method: Enter (or edit) the NAIC filing description at the Filing level

If you add or modify the NAIC filing description at the Filing level, the filing 
description will become independent of changes at the Filing Group level, in 
effect becoming a Filing level NAIC filing description, as indicated below by the 

broken link icon.  

If a filing that is not in Start status changes back to Start status (as a result of 
performing or deleting an activity), then the NAIC Filing Description that was not 
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previously included in that filing will still not be included in the filing after the 
status change. 

1. Navigate to the Filing level of the desired filing.
2. Click the NAIC Filing Description tab.

3.  Enter (or modify) the NAIC Filing Description, then click the Save 
button on the Tracker toolbar.

The filing description is saved.
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Entering Filing Fees

Use the Filing Fee tab to enter fee payment information for a filing. If you are 
using SERFF, you can pay by check or EFT: see Paying Filing Fees via EFT on 
page 291.

Entering Filing Fees Paid by Check
If you are paying filing fees by check, complete the following procedure to enter 
the filing fee payment information.

Method: Enter filing fees paid by check

1. Navigate to the desired filing
2. Click the Filing Fee tab.

3. Under Payment Method, select Check.
4. If any portion of the fee is being paid on a retaliatory basis, click Yes in the 

Is Fee Retaliatory? section.
5. Click Add Payment.

The Check Details dialog displays.
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6. Enter the Check Date, Check # and Check Amount.
7. Enter any descriptive notes in the Comments field.
8. To enter another payment, click Next, otherwise click OK.

The check payments you entered are displayed in the Payment History 
Details table at the bottom of the Filing Fee tab.

9. Enter any descriptive information in the Fee Explanation field.
10. Click the Save button on the Tracker toolbar to save your changes.

Editing Filing Fee Check Payments

Note: You can edit all the fields in the Check Details dialog box before submitting the 
filing. Once submitted, only the Comments field and Fee Explanation field can 
be edited.

Method: Edit check filing fee payments

1. Navigate to the desired filing.
2. Click the Filing Fee tab.
3. Scroll down to the Payment History Details table.
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4. Double-click any of the payments listed in the Payment History Details 
table. 

5. Make any required changes.
6. Click OK.
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Copying Filings

Tracker supports the ability to create new filings based on existing filings.

This section includes the following topics:

• Copying Attributes on page 206

• Copying Multiple Filings on page 207

• Copying Schedule Items and Filing Forms on page 207

• Copying Filings on page 208

Copying Attributes
The new filings you create by copying will have the following attributes copied 
from the original (not revised) version of the selected filing(s):

• Filing Group-level NAIC filing description

• Program field

• State field

• LOB field

• Group # field

• Company field

• Project Start Date field

• Filing Type field

• Custom field

• Description field

• Filing Statute field

• All comments in the Comments tab

• All users in the Resources tab

• All company group member in the Company/Resources table of a CG filing

The new filings you create by copying will not have the following attributes 
copied from the original (not revised) version of the selected filing(s):

• Filing Status is set to Start

• A unique Filing ID is assigned (the sequence number component of the 
Filing ID is incriminated)

• Filing Manager is set to current user

• Retaliatory is set to blank

• PaymentMethod is set to blank
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For SERFF filings:

• Copy Filing functionality does not copy public access information or does it 
copy TOI, SubTOI or Filing Type information.

• The SERFF status of copied items (including the SERFF status) is empty or 
blank.

Copying Multiple Filings
To create multiple filings when you copy, select multiple filing types in the dialog 
and Tracker will create a copy of the original filing with each of your selected 
filing types. These copies are usually separate filings, but Tracker will combine 
filings based on type of filing and the rules for combined filings in the states 
selected.

When copying combined filings, if you select the filing types for your copy that 
are the same as the original, Tracker will create a combined filing like the original; 
it will not split the combined filing into multiple, seperate filings.

Copying Schedule Items and Filing Forms
When copying filings, you have the following mutually exclusive options 
regarding the schedule items:

1. Include Group level items
2. Include Group and Filing level items (but not filing forms)
3. Include Group and Filing level items and filing forms

With options 1 and 2, Tracker adds a new set of filing forms based on information 
in Regulatory Specialist for each filing’s state, LOB, Type of Filing and Filing 
content.

With option 3, the filing forms are copied exactly as they are saved in the original 
filing(s), complete with user-entered data. This is a useful feature if you have a 
problem submitting the original filing want to resubmit a brand new filing exactly 
like the old one.

Note: Any filing forms that display a Filing ID will have the Filing ID from the original 
filing, which will be incorrect since the copied filing has a different ID. You 
should correct the Filing ID. Before entering data in the filing form, open the 
filing form in Word, use the Unprotect Document command, change the Filing ID, 
and then use the Protect Document command. 

With options 2 and 3, the new filings will contain all Filing-level forms, rates, 
rules, and other attachments associated with the filing(s) being copied, including 
all metadata for each attachment, attachment paths, sub-tabs and data on sub-tabs, 
and so on—everything for each attachment. The following also results:

• The Filing level attachments in the new filing(s) have the same relationship 
with the filing group as the original filing, that is, if the link with the Filing 
Group attachment is broken, the link in the copy is also broken. 
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• The Filing level-NAIC Filing Description from the filing(s) is copied and 
its relationship with the filing group is maintained, that is, if the link with 
the filing group is broken, the link in the copy is also broken.

• The Enable setting is copied.

• On the Status sub-tab, the State Specific indicator and the Enabled 
indicator are copied, all other fields will be empty or blank.

• All Related Filings information is copied.

Copying Filings
When creating copies of existing filings, you can choose to use new or existing 
Filing Group-level attachment types and filing forms.

Method: Copy a filing

1. Navigate to the Filing Group level and highlight a filing.
2. Click Insert > Copy Filing.

The Copy Filing dialog displays.

3. Complete one of the following steps:

To create copies with the same filing type and Group-level items:
a. Select Include Group Level Items

The default No Change is selected.

b. Click OK.

The Copy Filing dialog closes. The result of the copy is displayed. 

c. Click OK.

The list of filings is updated with the new filing(s).

OR
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To create copies with different filing types:
a. Select Change Type.

The filing type selectors become active.

b. Select the filing type(s) for the new filing(s).

c. Click OK.

The Copy Filing dialog closes. The result of the copy is displayed. 

d. Click OK.

The list of filings is updated with the new filing(s).

OR

To create copies with the same filing type using Group-level and 
Filing-level items:

a. Select Include Group & Filing Level Items.

The Include Filing Forms check box is activated and selected.

b. If required, clear the Include Filing Forms check box. (If the Include 
Filing Forms check box is cleared, then Tracker does not copy any of 
the existing filing forms but instead adds a new set of filing forms based 
on information in Regulatory Specialist for each filing’s state, LOB, 
Type of Filing and Filing content.)

c. Click OK.

The Copy Filing dialog closes. The result of the copy is displayed. 

d. Click OK.

The list of filings is updated with the new filing(s).
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Chapter 6 
Working with Common Filing 

Tasks

This chapter deals with tasks you will perform whether you are using filing 
profiles when you create your filings, or whether you are creating filings 
completely within Tracker.

This chapter describes:

• Filing Resources on page 212

• Filing Letter Comments on page 213

• Activities on page 214

• The Filing Forms Tab on page 215

• Filing Statutes on page 226

• Related Publications on page 227
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Filing Resources

This chapter describes resources and how they relate to filings. Resources refer to 
employees at your company who are involved in the filing process. 

The Resources Tab
The Resources tab displays a list of company personnel responsible for various 
facets of the filing and the program to which it belongs. This data is used to 
automatically enter specific information into filing forms where required.

Resources are entered into the system via the administrative User and Company 
functions. See User Profiles on page 75 and Adding New Companies on page 54 
for more information on how to add users and companies to Tracker.

Entering Filing Resources
When you create a filing, the Resources tab will be automatically populated with 
the resources listed for the company to which the filing pertains. You may, 
however, choose to change the resources listed for a particular filing.

Method: Enter filing resources

1. Navigate to the filing where you want to enter resources.
2. Select the Resources tab.
3. For each applicable personnel type field select a name from the related drop 

down list.
4. Click Save to save your resources information.

Resources may be edited at any time. Always click Save  when you have 
finished editing to ensure that your changes are preserved.
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Filing Letter Comments

This chapter describes filing letter comments and how they relate to filings.

The Comments Tab
The Comments tab provides a number of large text fields in which you can enter 
comments to add extra information to your filing letters. Any information entered 
here will automatically be added in the appropriate places to any relevant filing 
letters created for that filing.

Adding Filing Letter Comments
At the Filing level:

1. Select the Comments tab.
2. Locate the text field for the type of comment you want to add.
3. In the text field type the comment as you want it to appear on the letter.
4. Repeat steps 2 and 3 for all comments required.
5. Click Save to save your comment information.

Note: Comments may be edited at any time. Always click Save  when you have 
finished editing to ensure that your changes are preserved.



WORKING WITH COMMON FILING TASKS

214 TRACKER P&C VERSION 6.6 USER GUIDE

Activities

This chapter describes activities at the Filing level:

• Specific Filing Level Activities on page 214

• The Activities Tab – Filing Level on page 214

Specific Filing Level Activities
A number of specialized functions are accessed and performed via the Filing level 
Perform Activity function.

Filing letters can be accessed within certain types of activities. The activity dialog 
box then allows you to select the type of letter required. Information to populate 
the letter is automatically taken from the administrative, regulatory, and filing 
specific information (such as letter comments) already entered into the system.

Any additional documents required for a filing, such as actuarial proofs, or 
marketing brochures, can also be accessed and attached via the Activities 
function. You simply choose an Attachment activity, and then browse for, and 
attach, your file. You can even make notes regarding the attachment in the 
activity’s memo field. Document attachments can also be edited via the Activities 
function, as long as the software used to create those attachments is available on 
the system running Tracker.

The generation of completed filings is also done via the Perform Activity 
function. The generate filing activity gathers together all of the documents 
specified for the filing (required filing forms, filing letters, attachments, and so 
on), populating each document with information taken from the filing data you’ve 
entered and the regulatory and administrative portions of the system. The 
generated documents are then made available to you for viewing and printing 
within Microsoft Word.

The Activities Tab – Filing Level
The Filing level Activities tab lists all activities that have been performed upon 
(or are pending performance upon) this filing. From this tab you can access the 
activity details for any of the activities listed.
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The Filing Forms Tab

The Filing Forms tab displays a list of all filing forms attached to the filing. 
State-required filing forms are automatically listed here by the Tracker system, 
which pulls this information from the Regulatory Specialist tables, based on the 
filing type selected upon filing creation. From the Filing Forms tab you can 
access, complete, and view any of the filing forms listed.

Tracker uses fillable forms to quickly create forms that are in the proper layout 
and format. Fillable forms will generate in Microsoft Word with specific fields 
defaulted to pre-populate. Any shaded fields require user input and are formatted 
as such. The form itself is protected to facilitate tabbing to the required input 
fields.

Once you are ready to perform the Generate Complete Filing activity, note that 
the filing form does not generate again. Filing forms configured to print will print 
out with the filing package and will be listed in the document list in the Generate 
Complete Filing activity.

This section describes the following topics:

• Entering Filing Form Information on page 215

• Filing Forms and Company Group Filings on page 3

• Enabling Filing Forms on page 216

• Print Filing Forms Before or After Filing Letter on page 218

• The Order of Filing Forms on page 219

• Changing the Filing Forms on page 220

Entering Filing Form Information
You enter filing form information by opening the filing form and editing it.

Method: Enter filing form information

1. Navigate to the filing with the desired filing form and double click the filing 
form.

The form generates through the Document Generation Window.

Once generated, Microsoft Word opens and the form appears on screen.
2. Enter information into the shaded areas. Use the Tab key to move through 

these areas.
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3. After entering the information, click Save, or select File > Save.

The filing form is saved to the Tracker database.

Note: Ensure you save your changes as instructed above. If you select File > Close and 
OK when prompted to save, your changes will be lost. 

Tip: If information in the generated filing form is missing because it was not entered in 
the filing, you can minimize the filing form, click Cancel on the message box that 
appears, enter the missing information in the filing, and regenerate. 

Method: View or Edit Filing Forms

1. Navigate to the filing with the filing form you have previously worked on 
that you want to view or edit and double click the filing form. 

The form automatically appears in Word.

Note: The document does not go through the generation process again.
2. Make changes as required to the filing form and resave.

Note: Ensure you save your changes as instructed above. If you select File > Close and 
OK when prompted to save, your changes will be lost. 

Filing Forms and Company Group Filings
For more information on filing forms and company group filings, see Generating 
Filing Forms for a Company Group Filing on page 144.

Enabling Filing Forms
Tracker provides the ability to selectively enable filing forms.
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When a filing form is enabled (Enable set to Yes), it is available for a SERFF 
filing (available to satisfy filing requirements) or will be included in a paper filing 
(will print as part of the filing package). When a filing form is not enabled 
(Enable set to No), it is not available for a SERFF filing (it is not available to 
satisfy filing requirements) or it will not be included in a paper filing (it will not 
print as part of the filing package).

Method: Disable a filing form

By default, most filing forms will be enabled; they will be included in the filing 
package. To disable a filing form(s) and not include it in the filing package you 
must perform the following steps:

1. Navigate to the filing with the filing form you want to disable.
2. On the Filing Forms tab, highlight the filing form that you want to disable. 
3. Right-click the filing form that is selected.

A dialog displays with four choices.

 
4. By default, the filing form will already have a checkmark to the left of the 

Enable option.
5. Click Enable. 

The dialog closes and No appears in the Enable column in the table of filing 
forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

Method: Enable a filing form

If you have disabled a filing form and you want to enable it, follow these steps:

1. Navigate to the filing with the filing form you want to enable.

These 
filing 
forms will 
not be 
included 
in the 
filing 
package.
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2. On the Filing Forms tab, highlight the filing form that you would like to 
enable. 

3. Right-click the filing form that is selected. 

A dialog displays with four choices.

 
4. Click Enable. 

The dialog closes and Yes appears in the Enable column in the table of 
filing forms.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

Print Filing Forms Before or After Filing Letter
The Prt After Letter column on the Filing Forms tab indicates whether the 
default behavior is for the filing form to print before or after the filing letter. If 
there is a No in the column, the filing form will print before the filing letter. If 
there is a Yes in the column, the filing form will print after the filing letter.

For those states which require a given filing form to print before the letter, the 
default is No—these filing forms will print before the letter.

If a filing form’s Print After Letter setting on the Filing Forms tab indicates Yes 
and you want the filing form to print before the letter, follow these steps:

Method: Print a filing form before the filing letter

1. Navigate to the filing with the filing form you want to print before the letter.
2. Select the form that you would like to print before the filing letter.
3. Right-click the selected form. 

A list of options displays.

This form 
will print 
before the 
filing 
letter.
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4. To make the filing form print before the filing letter, clear Print After 

Letter. 

The list of options closes, and No is displayed in the filing form’s Prt After 
Letter column. If you display the list of options again, there will not be a 
checkmark beside Print After Letter. If you click Print After Letter again, 
the setting will change back to Yes.

5. Repeat for other filing forms you want to print before the letter. If multiple 
filings forms are set to print before the letter, they will print in the same 
order as shown in the list.

Note: You must repeat the Generate Complete Filing Activity for this change to take 
effect in the print process.

The Order of Filing Forms
You can also use the pop-up options list to change the order in which filing forms 
appear in the filing forms list by moving them up or down through the list. The 
order in the list controls the order that they print: all the filing forms with Prt 
After Letter set to No are printed in the listed order before the letter, and all the 
filing forms with Prt After Letter set to Yes are printed in the listed order after 
the letter.

Method: Change the order of filing forms

1. Navigate to the filing where you want to change the order of filing forms.
2. On the Filing Forms tab, highlight the filing form that you would like to 

change the order of.
3. Right-click the form that is selected.

A list of options displays.

 

Note: The Move Up option will not appear when the first filing form is selected. The 
Move Down option will not appear when the last filing form is selected.
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4. If you click the Move Up option, the selected filing form moves up one 
position in the list of filing forms. To move it up another position, repeat the 
process.

5. If you click the Move Down option, the selected form moves down one 
position in the list of filing forms. To move it down another position, repeat 
the process. 

Note: Filing Forms can only be moved within the filing you are currently working with. 
If you create a new filing, even if the exact same filing forms apply, the filing 
forms will appear in the default order that is assigned by Tracker. You will have to 
modify their order again (as described above) if you want to maintain the custom 
order of forms in the Filing Forms tab.

Changing the Filing Forms
When creating the filings on the New Filing Group/Filing(s) dialog, and Filing 
Type is selected, the system generates the applicable filing forms under the Filing 
Forms tab. Tracker allows the user to change the Filing Type on the Filing Level 
(Filing Header), however, the system does not recognize the change nor does the 
system generate revised filing forms. 

When the incorrect Filing Type is selected and the required filing forms are not 
generated, the user has the following options:

• Delete and recreate the filing. Ensure that the correct Filing Type is 
selected. 

• Make a copy of the filing using Insert > Copy Filing and select the correct 
Filing Type. (See Copying Filings on page 206.)

• Use Other Attachment and attach the applicable form(s).(See The Other 
Attachment Tab — Filing Group Level on page 195 and The Other 
Attachments Tab — Filing Level on page 158.)

Editing and Replacing a Generated Filing Form or 
Letter
You can make and save changes to a document that has been generated as part of 
an activity. We recommend that the only type of documents generated by Tracker 
that you use this functionality with is the letter. Replacing a generated document is 
a two step process that requires saving the edited document under a new name 
before you can replace it.

To enable editing and then saving a letter generated through an activity, you use 
the View and Replace functions in the Edit Activity dialog box. The View 
function lets you view an existing document in Microsoft Word so that you can 
then edit and save it to your hard drive under a new name. (When you open a 
generated document through the Edit Activity dialog box, it is a read-only 
temporary document, which is why you must save it under a new name.) For 
instructions, see Printing an Edited Document on page 224.

Once you edit and save the document, you must use the Replace function to 
replace the existing document (residing in the database) with the new one that you 
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edited and saved under a new name. Until you replace the existing document, the 
newly saved one is only accessible from your computer, not the database. 

Method: Edit a generated letter

1. Navigate to the filing with the letter you want to edit and click the Activities 
tab. 

2. Double-click the activity with the letter you want to edit.

The Edit Activity dialog box displays:

3. From the Documents area, select the letter you want to edit or view.

Note: You can select multiple documents to view; however, you can only replace one 
document at a time. 
4. Click View. 

The document opens as a read-only temporary file in Microsoft Word.
5. Make the changes you want to the document.
6. When you finish, click File > Save As.

Note: If you choose Save rather than Save As, an error message is displayed. If this 
happens, click OK and the Save As dialog opens.
7. In the Save As dialog, type a new name for the document and select the 

location on your hard drive where you want to save it.
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8. Click Save.
9. After you save the edited document to your hard drive, you can replace the 

existing document (in the Tracker database) with this newly edited one. You 
must do this to update your changes to the database. To do so, return to 
Tracker and follow the instructions in the next section.

Replacing A Generated Document
When you have edited a document and saved the document with another name, 
you can replace the filing’s existing document with the newly edited one.

Method: Replace a generated document

1. Navigate to the filing with the document you want to replace and click the 
Activities tab. 

2. Double-click the activity with the document you want to replace.

The Edit Activity dialog displays.

3. In the Documents area of the Edit Activity dialog, select the document you 
want to replace.
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4. Click Replace.

Note: The Replace button is only available when a document in the list box is selected. 
Otherwise, it is dimmed.

The Replace With dialog displays.

5. Locate and select a document (the one you edited and saved to a new name) 
to replace the existing document.

6. Click Open.

The dialog closes, saving your edited document to the database.

Note: To save a document to the database, its size must not exceed 0.99MB.
7. In the Edit Activity dialog, click OK.

Printing One Copy of a Generated Document
The Perform Activity dialog provides the option to print only one copy of a 
generated filing even if the requires multiple copies (according to Regulatory 
Specialist). You must check the Print check box to activate the Print 1 Copy 
check box.
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Printing an Edited Document
If you just want to make minor changes to one document and print it without 
saving the changes to the database, you can do so from within Microsoft Word.

Method: Print an edited document 

1. Navigate to the filing where you want to edit and print a document and click 
the Activities tab. 

2. Double-click the activity you want to edit and print.

The Edit Activity dialog displays
3. Click View.

The document opens in Microsoft Word
4. Edit the document as required.
5. When you finish making your changes, click File > Print.
6. After the document is printed, click File > Close.
7. In the next dialog box that displays, click the No button to close the 

document.

The document closes without saving the changes you made.
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Reprinting All Generated Documents
Tracker lets you reprint a complete package that is associated with an activity. The 
Reprint Package feature lets you reprint all the generated documents, activity 
attachments, and rate, rule, and form attachments. 

Method: Reprint all generated documents

1. Navigate to the filing where you want to reprint all the documents in an 
activity and click the Activities tab.

2. Double-click the activity for which you want to reprint the package.

The activity’s dialog displays.
3. Click Print Package.

A dialog displays an option to print only one copy.
4. To print one copy, click Yes or click No to print the number of copies 

required by the state, as defined in the Regulatory Specialist. 

Note: The Print Package button is used only for printing generated documents.

The entire package, including all of the attachments, prints.
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Filing Statutes

Sometimes a filing is created where the statute on the filing details tab is left 
blank. This happens when there is more than one statute option for the type of 
filing that has been created. Tracker will not assume which statute is the correct 
one.

When multiple statute options are available, you must select the appropriate one 
for your filing. You can go to the Regulatory Specialist to look for the statute 
information for that particular filing and make a choice based on the information 
provided. When a filing is created and the statute is left blank, Tracker will now 
populate the field with the text No Statute and will prompt you to fill in the 
statute before performing any activities.

The statute needs to be completed because many areas of Tracker depend on the 
statute having data entered. (For example reports, complete filing generation, and 
so on.)
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Related Publications

This section describes publications at the Filing level. These topics include:

• The Publication Tab on page 227

• Adding a Publication Reference on page 227

The Publication Tab
Filings are often created in response to the receipt of publications from an 
advisory organization or legislative body. The Filing level Publication tab 
displays information about a publication in the system related to or pertaining to 
this particular filing. The information contained on this tab is identical to the 
information presented on the related publication’s details screen; see The 
Publication Details Tab on page 365 for more information.

Note that the Publication tab appears at the Filing level only if that filing was 
created or referenced in relation to a particular publication in your system.

Adding a Publication Reference
A publication reference can be added to a filing only from the originating 
publication details screen. This occurs automatically when a filing is created 
directly from a publication record. A reference can also be created manually from 
a publication detail record by using the Insert > New Filing Reference option. 
See Linking Publications to Filings on page 371.
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Chapter 7
Working with Activities

This chapter provides detailed information about performing, posting, and 
working with activities in the Tracker system. Instructions for performing 
activities for filing groups, filings, multi-filings, and publications are also 
contained here, including instructions for attaching filing letters, filing forms, and 
actuarial exhibits to a filing, and procedures for generating and printing filings.

This chapter describes:

• Tracker Activities on page 230

• Standard Tracker Activities on page 232

• Standard SERFF Activities on page 234

• Performing Basic Activity Procedures on page 235

• Performing Filing Activity Procedures on page 246

• Working with Attachments on page 253

• Performing Activity Searches on page 257

• Multi-Filing Activities on page 259
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Tracker Activities

In the Tracker system, an Activity is any action related to or performed upon a 
filing group, filing, or Publication record. These actions can be anything: 

• creating a memo or a note-to-self

• recording a phone call to/from a state insurance department

• generating a filing, and so on.

All of these actions can be recorded and kept as a history within the activity 
function. The Filing Level Activity function encompasses a wide range of 
passive and active activities, including generating, editing, and printing filing 
documents. 

Passive Activities
Passive activities are usually related to recording information (for example, the 
recording of a memo or phone call in relation to a record). They do not change any 
documents related to a filing.

Active Activities
Active activities are usually related to generating documents (for example, 
creating a filing letter, or generating and printing a complete filing). They 
generally update or create documents related to a filing.

Status Changes and Active Activities
Some activities update status fields or dates in the system, so that your record is 
automatically updated when you perform that activity. For example, when you 
perform an activity to record the receipt of DOI approval for a filing, the activity 
automatically updates the status of the filing record to Approved and updates the 
Approval Date of the filing record to the date specified in the activity). 

Activities and Post Activities
Activities can be Performed (performed and recorded under today’s date or given 
a past date) or Posted (recorded with a future date or suspense date to act as a 
reminder); each function has a separate menu option and toolbar button accessible 
on any of the Filing Group level, Filing level, or Publication Activity tab screens. 
The Post Activity function is especially useful for setting Suspense Dates to 
remind yourself (or your co-workers) about due dates and tasks which need to be 
completed on or by a certain date.

Any record having a future or suspense dated activity attached to it is flagged with 
the date and activity description where it is listed in the main tab screens (such as 
the Filing Groups tab, the My Filings – All tab, the Filings tab, the My Filings 
tab, and the Publications tab). Also, the Suspended button located above each of 
these tab screens can be pushed to show only those records having a future or 
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suspense activity attached, so that you can view only those records that need to be 
worked with, and can see what tasks you have upcoming.

The Activities Tab – Filing Group Level
The Filing Group level Activities tab lists all activities that have been performed 
upon (or are pending performance upon) this filing group. From this tab, you can 
access the activity details for any of the activities listed.
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Standard Tracker Activities

Tracker comes with a set of over thirty standard activities covering most of the 
activities you will want to perform in relation to your filing group, filing, and 
publication records. If there are other activities you want to be able to perform 
through this function, or if you want to tailor some of the activities to your own 
needs, this can be done through the Tracker administrative Custom Tables 
function, or by an Tracker Support Representative. Contact your Tracker 
administrator, or see Activity Codes on page 90.

The following table lists of all the standard activities in the Tracker system, and a 
brief description of their function.

Activity Description

Approve Filing in System Use this activity to record the receipt of a DOI’s approval of a 
filing. 
It updates the status of the filing to Approved.

Attach Exhibit/ 
Backup Material

This activity allows you to attach a document, exhibit, or other 
backup material to a filing.

Background Information This allows you to enter background or extra information 
about a record.

Build Rate for EDP System Use this activity to enter/update your Build Rate for EDP date 
for a filing.

Correspondence for Filing Use this activity to generate a correspondence letter to a DOI 
(Department of Insurance) for a filing. It updates the status of 
the filing to Pending.

Form Development Record information regarding form development using this 
activity.

Form Revision Use this activity to enter and track form revision information.

Generate Complete Filing This activity lets you generate a complete filing, view it, and 
then print it out. 
It updates the status of the filing to Pending.

Generate Letter This activity lets you generate, view, and print a filing letter; 
you may choose from several types of letter.

Instructions for Filing Use this activity to record instructions for tasks to be 
performed upon this filing at a later date. 
This activity can be post-dated. It will appear on the Filing 
Approval Notification Report.

Instructions for Publication Use this activity to record instructions for tasks to be 
performed upon this filing at a later date. 
This activity can be post-dated. It will appear on the Filing 
Approval Notification Report.
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Note: Not all activities are available at every level of the system. Filing Group level and 
Publication activities are generally limited to information-recording activities 
(such as memos and notes, background information, and suspense dates), while a 
much wider of activities may be performed upon at the Filing level (such as 
generating letters and filings).

Inter-Department Request Use this activity to record a request for action or information 
to another department. 
This activity can be post-dated.

Mail Filing to DOI Use this activity to record the date that a filing was sent to a 
state DOI (Department of Insurance).

Memo/Notes The Memo/Notes activity allows you to enter notes and 
information about a record as you work with it.

Respond to DOI –  
Objection

Use this to create a response letter following a DOI 
(Department of Insurance) Objection. 
Updates the status of the filing to Pending.

Respond to DOI –  
Resubmit Filing

Use this to create a re-filing letter following a response from a 
DOI (Department of Insurance). 
Updates the status of the filing to Pending.

Response from DOI –  
Disapproved Filing

Records the date of the receipt of a Disapproval from a DOI 
(Department of Insurance). 
Updates the status of the filing to Disapproved.

Response from DOI –  
General

Records the receipt of a Response from a DOI (Department of 
Insurance).

Response from DOI –  
Objection

Records the date of the receipt of an Objection from a DOI 
(Department of Insurance). 
Updates the status of the filing to Objection.

Schedule Mailing Date 
to DOI

Use this activity to set a scheduled mailing date. 
This activity can be post-dated.

Set Suspense Action Date This activity allows you to post a future suspense (reminder) 
date.

Update Objection Respond by 
Date

Use this activity to document a change to the Respond by Date

Withdraw Filing Use this to create a withdrawal letter and record the date when 
you withdraw a filing from a DOI. 
Updates the status of the filing to Withdrawn.

Activity Description
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Standard SERFF Activities

If you are using Tracker with SERFF, the following standard activities are 
included to help you manage and submit your SERFF filings. 

Activity Description

SERFF: Generate SERFF 
Filing

Use this activity to generate and submit a filing to SERFF after 
you have finished developing it.

SERFF: Get Filing 
Requirements

Use this activity to retrieve the requirements for a SERFF filing 
from the given state for your selected combination of TOI, sub 
TOI and filing type for that state.

SERFF: Submit Note to 
Reviewer

Use this activity to submit a note to the state reviewer for an open 
or closed filing (if allowed by the state).

SERFF: Submit Additional 
Fee activity

Use this activity to allocate and submit EFT fee payments.

SERFF: Submit Filing 
Amendment

Use this activity to submit an amendment to a filing. This can 
include revised or additional schedule items.

SERFF: Submit Objection 
Response to SERFF

Use this activity to submit a objection response to an objection 
letter. 
An objection response may include revised and/or additional 
schedule items.
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Performing Basic Activity Procedures

This section describes basic procedures used with activities:

• Performing an Activity on page 235

• Performing Activities with an On Approval Option on page 237

• Posting an Activity on page 238

• Accessing a Single Activity Detail Record on page 240

• Editing an Activity Detail Record on page 241

• Completing an Activity on page 242

• Completing a Recurrent Activity on page 244

• Deleting an Active Activity Detail Record on page 244

• Deleting a Passive Activity Detail Record on page 244

Performing an Activity
From a Filing Group or Filing level, or Publication screen Activities tab screen.

1. Click Perform Activity on the toolbar. 

The Perform Activity dialog displays.

2. In the Perform Activity dialog, select the activity you want to perform.

3. Click Perform. 

The Perform Activity dialog for the selected activity displays.
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Note: The following describes the steps in the Generate Letter activity. Each activity 
dialog will look slightly different.

4. Enter information in the applicable fields:

• Usually, the default Description should be used.

• The Date field will automatically be filled in with today’s date.

• The Performed By field will automatically be filled in with your name.

• Indicate the Priority of the activity by clicking in one of the Low, 
Medium, or High selection buttons (the default priority is Medium).

• If you are generating a filing letter, select a Letter Type from the drop-
down list to the right of the field.

• Clear the View, Print, Draft, and Print One Copy check boxes as 
required.

If you select the View check box, the generated letter will open in a 
Microsoft Word window for viewing. You may then use Word’s print 
command to print the letter, if desired.

If the Print check box is selected, the letter will automatically be 
printed following generation.

If you select the Draft check box, the letter will be generated, but will 
not be saved for future viewing in the activity record.

If you select the Print One Copy check box, only one copy of each 
document in the filing package will be printed. You might do this if you 
wanted to review the entire filing package and did not want to print out 
the multiple copies of each document that are usually required with a 
complete filing package.
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• Use the View/Draft check combination to generate and preview draft 
filing letters. If you want to generate and save a letter, and have it 
generate and print as part of the final Complete Filing generation, make 
sure that you clear the Draft check box.

Generated (non-draft) letters will be saved, and will be accessible later 
from the activity detail record.

• Use the Attach File field to enter the location (path) of a document file 
you want to attach to the filing (such as an extra form or exhibit). You 
can type in the path (to a maximum of 255 characters) or click the 

browse button  located to the right of the field to locate and select 
the correct path. The attached document will then be accessible from the 
activity detail record.

All attachments that you want to have generated and printed as part of 
the final filing must be performed with both View and Print selected, 
and Draft cleared.

• Use the large Memo field to record the main text or information such as 
a note, memo, or phone message. This field can also be used to add 
extra text to any filing letter.

5. Click Perform. 

The activity will be performed and will appear on the related Filing Group, 
Filing, or Publication Activity list tab.

6. To finish, click OK. 

The new activity will be performed or recorded, and the dialog will close.

Performing Activities with an On Approval Option
The Requested Renewal Effective Date and Requested Effective Date may be 
affiliated with an activity by the Tracker Administrator. (See Adding Active 
Activity Codes on page 91.) In some cases, you will have an On Approval option 
in addition to the default calendar setting.
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If the Administrator has not configured the activity for the On Approval option, 
when you perform the activity, you will see a date selection button, but not the On 
Approval checkbox.

If the Administrator has configured the activity for the On Approval option, the 
default option is with the calendar unlocked and the On Approval check box not 
selected. If you select the On Approval check box, the system will clear the 
calendar and lock it. If you want to revert back to an actual date, you need to clear 
the On Approval check box. The system will then unlock the calendar and allow 
you to pick a specific date.

Posting an Activity
Posting an activity allows you to specify a future target date on which that activity 
should be performed. This is very useful when posting suspense dates, or giving 
instructions which need to be performed at a future date.

Method: Post an activity

1. From a Filing Group or Filing Level, or Publication Activities tab screen, 

click the Post Activity toolbar button  to open the Post Activity list 
box.
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2. In the Post Activity list box, select the activity you want to post.

3. Click Post.

The Post Activity dialog displays. (The example below is for the Set 
Suspense Action Date activity. Each activity window will look slightly 
different):
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4. Enter information in the applicable fields.

Use the Description field to enter a brief description of the activity you are 
posting. Usually, the default Description can be used. 

In the Suspense Date field, enter the date on which you want this activity to 
be performed (such as the suspense dates, reminder dates, due dates, and so 
on).

The Due Date field is the actual date on which this activity must be 
completed. This field allows you to bring up activities by suspense date 
before the due date.

The Performed By field will automatically be filled in with your name; you 
may select a different name if someone else is to perform the posted activity.

Indicate the Priority of the activity by clicking in one of the Low, Medium, 
or High selection buttons (the default priority is Medium).

Use the Memo field to record the main text or information of a suspense 
note, memo, or instruction.

5. Click Post.

The activity will be posted and will appear on the related Filing Group, 
Filing, or Publication Activity list tab.

Accessing a Single Activity Detail Record
You can display the details of any activity record.
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Method: Access an activity detail record

1. Navigate to the required filing group, filing or Publication.

2. Click the Activities tab.

3. Select the activity record you want to complete, and double-click it to open 
the related Edit Activity dialog.

4. Click OK or Cancel when finished viewing the record.

Editing an Activity Detail Record
You may edit, change, or add to the information on an activity detail record at any 
time (provided that you have a system security level which permits editing).

Method: Edit an activity record

1. Navigate to the required filing group, filing or Publication.

2. Click the Activities tab.

3. Select the activity record you want to complete, and double-click it to open 
the related Edit Activity dialog.

It will look like the original Perform Activity or Post Activity dialog, but 
will have additional fields. (The example below is for the Generate 
Complete Filing activity. Each Edit Activity box will look slightly 
different.)
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4. Make any necessary changes or additions to the information displayed on 
the screen.

Note that:

• The Post Activity Memo field allows you to store information pertinent 
to the completion or results of an activity.

• The Documents field will list any documents generated in the original 
posting.

To view one of these documents, select it from the list and click View 
Document. The document opens in its native application.

5. Click OK to save your changes and exit the dialog.

Completing an Activity
When you post an activity for a future date, you leave it open until that activity 
has been performed, for example, until you’ve forwarded the necessary 
documents, made the required phone call, finished the task, and so on. When you 
have finished a posted activity, you should open the related activity record and 
note that it has been completed, and then close the record. It will then appear as 
Completed in the related Activities list tab.
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Method: Complete an activity

1. Navigate to the required filing group, filing or Publication.

2. Click the Activities tab.

3. Select the activity record you want to complete, and double-click it to open 
the related Edit Activity dialog.

It will look like the original Post Activity dialog, but will have additional 
fields. (The example below is for the Set Suspense Date activity. Each Edit 
Activity box will look slightly different):

4. In the Post Activity Memo field, enter any information relating to the 
performance or completion of the original posted activity.

5. When you have added any necessary notes, click OK.

If today’s date is equal to or later than the original suspense date, a message 
appears asking if you want to complete the activity.

6. Click Yes to complete the activity, or click No to leave the activity open if 
you haven’t yet completed all required tasks.

Your changes will be saved and Edit Activity will close.
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Completing a Recurrent Activity
Follow this method to complete a recurrent activity. After you complete a 
recurrent activity you can optionally create a new filing.

Method: Complete a recurrent activity

1. Navigate to the desired filing, open the activity, on the due date, that you 
want to complete.

2. Click OK.

A dialog displays asking you if you want to complete the activity.

3. Click Yes.

A dialog displays.

4. Click No to complete the recurrent activity but not create a new filing.

OR

Click Yes to complete the recurrent activity and to create a new filing.

5. If you click Yes, you are prompted to choose the filing group in which the 
new filing is created.

Once the new filing is created, the recurrent activity is created for this filing. 
The suspense date and due date of the recurrent filing are incremented by the 
period specified by the activity type.

Deleting an Active Activity Detail Record
Activities should only be deleted when absolutely necessary. Only the most 
recently performed (or posted) activity attached to a record may be deleted. 
Therefore, to delete the third last active activity performed, you need to delete 
every activity which followed it as well. Deleting an activity reverses any actions 
performed in the system (such as status or date updates) as a result of that activity.

Method: Delete an activity detail record

1. Navigate to the required filing group, filing or Publication.

2. Click the Activities tab.

3. Select the activity you want to delete.

4. Click Delete on the toolbar.

5. Click Yes to delete the activity, or No to cancel.

Deleting a Passive Activity Detail Record
Passive activities can be deleted in any order.
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Method: Delete a passive activity detail record

1. Navigate to the required filing group, filing or Publication.

2. Click the Activities tab.

3. Select the activity you want to delete.

4. Click Delete.

5. Click Yes to delete the activity, or No to cancel.

Note: Because the activity feature helps you to track, as a history, all actions performed 
during the filing process, it is recommended that you perform a new activity each 
time you perform an action, or that you edit an existing activity only by 
responding to and adding to the information already recorded, rather than deleting 
existing activity information.
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Performing Filing Activity Procedures

This section describes activities specific to filings:

• A Sample Filing Letter on page 246

• Information In the Filing Letter on page 248

• Filing Letter Comments on page 249

• Activities and the Filing Package Tab on page 249

A Sample Filing Letter
On the following page is a sample of a Long Filing Letter, containing all possible 
elements. In this example, filing letter Comments information appears on a gray 
background (this information is entered via the Filing level Comments tab; see 
The Comments Tab on page 213 for details). Other portions of the letter are 
generated automatically by the system from information previously entered for 
the filing, and from regulatory specialist records for that state and line of business.
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Information In the Filing Letter
The following information is included in a typical filing letter. This information is 
drawn from various data already entered in connection to the filing, and from the 
regulatory specialist records for that state, line of business, and filing type.

Note: Each letter format contains slightly different information, depending on its scope 
and purpose.

• Date 
Tracker checks for any filing date first. If there is no filing date, then Tracker 
looks for the activity date. Either of these dates could be the current date. 
This date can be edited in Microsoft Word if required.

Note: When generating a letter using the Generate Complete Filing activity, the letter 
uses the filing date that is entered in the activity, not today’s date.

• Name and Address 
The name and address of the State Insurance Department are generated 
automatically. If you are creating multiple filing letters, each one will have a 
different Insurance Department name and address.

• Attention Line 
The attention line is generated automatically.

• Reference 
Reference information includes the NAIC Number, FEIN Number, Tracker 
Filing Identification Number, and the State ID. It is automatically generated.

• Salutation Line 
The title of the recipient is automatically generated.

• Introductory Paragraph 
The first paragraph is automatically generated.

• Activity Memo 
Any information from the activity memo field is included in the letter.

• Form Information 
If the filing includes Forms, this section is included in the letter. For each 
entry identified as a form, the system automatically includes the form 
number, revision date, and description. If this is a replacement form, the 
replaced form number is identified if it has been entered in Tracker. If it is a 
new form, it is identified as an introductory filing.

If you want to include descriptive information for each form, such as its 
purpose or deviations from industry standard form provisions, you can add 
an explanatory comment from the form detail memo field. 

• Rate Information 
If the filing includes Rates, this section is included in the letter. For each 
entry identified as a manual rate page, the system automatically includes the 
rate page number, edition, and description. If this is a replacement page, the 
replaced page is identified. If it is a new page, it is identified as an 
introductory filing.
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If you want to include supporting arguments to explain or justify a rate 
filing, you can add an explanatory comment. If you want to include 
comments about the specific rate effect for the proposed rate change, you 
can add such comments in the memo field of each rate.

• Rule Information

If the filing includes rules, this section is included in the letter. For each 
entry identified as a rule, the system automatically includes the rule manual 
exception page, edition, and description. If this is a replacement page, the 
replaced page is identified. If it is a new page, it is identified as an 
introductory filing.

If you want to include comments about the rules, you can add such 
comments for each rule page from the rule details memo field.

Filing Letter Comments
Depending on what has been specified in your filing, you may need to enter some 
comment information as part of the filing letter creation process. Filing letter 
comments are added in at the Filing level. See Filing Letter Comments on page 
354.

Activities and the Filing Package Tab
Activities can be added to the Filing Package tab, as well as any supporting 
documentation for those activities. Any files attached to them will be converted to 
Portable Document Format (PDF). All files converted in this fashion will also be 
printed when you generate the complete filing package.

Note: Once you have moved activities to the filing package, you cannot modify or delete 
the activities or their supporting documents. However, you can edit text in the 
Post Activity Memo field.

Method: Add an activity to the Filing Package

1. Click the Perform Activity button. 

2. Select the activity you want to perform and click Perform.

The activity dialog displays.
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3. On the Perform Activity dialog, attach the file you want to associate with 
this activity and print in the filing package by clicking the Browse button.

The Activity File Attachment file browser displays.

4. In the Activity File Attachment file browser, choose the file you want to 
attach and click Open.

5. Click Move to Filing Package.

6. Click Perform.
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7. On the message box that opens (text below), click Yes.

Option “Move To Filing Package” has been chosen. Once the activity 
has been moved to the Filing Package tab, you will not be able to edit or 
delete the activity not will you be able to edit, replace or delete any of 
the documents(s) contained within the activity. Do you want to proceed?

The PDF printer creates a PDF copy of the attachment and saves the copy in 
the directory where the attachment is located.

8. After the Status window that opens has finished updating, click Close.
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The PDF file you created will be printed out on all subsequent printings of 
the complete filing package and appears in the Filing Package tab.
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Working with Attachments

The following section deals with using attachments with filings:

• Attaching Documents to a Filing on page 253

• Generating and Printing Filings on page 253

• Performing the Filing Approval Activity on page 254

Attaching Documents to a Filing
You may add extra documents to a filing using an attachment activity.

Method: Attach a document to a filing

1. Navigate to the filing you want to attach a document to.

2. Click the Perform Activity button  to open the Activity List box.

3. Click the desired attachment activity.

4. Click Perform to open the related Activity dialog.

5. Enter any required information in the fields provided.

6. Click the  button beside Attach File field to open a file browser.

7. Select the file path for the document you want to attach. (The path name 
cannot exceed 255 characters.)

8. Click Open to confirm the file path and return to the activity dialog.

The selected file path will now appear in the Attach File field.

9. Click Perform to save the activity and exit the dialog.

Note: This attached document will be printed as part of the entire filing, but only when 
the Generate Complete Filing activity is performed.

Generating and Printing Filings
Once you have added and completed all the components of a filing, the entire 
filing can be generated and printed using a single activity command. When you 
generate and print a filing, all documents related to or attached to the filing will be 
generated and printed, including:

• any filing letters created for the filing

• all filing forms required for the filing

• any attached rate, rule, or form pages (as specified)

• any additional documents or exhibits which you have attached in either the 
Other Attachments tab or within the activity of Generate Complete Filing.
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Method: Generate and print a filing

1. Navigate to the filing you want to generate and print.

2. Click the Perform Activity toolbar button  to open the Activity List 
box.

3. Select the Generate Complete Filing activity.

4. Click Perform to open the related New Activity box.

5. Enter information in the applicable fields:

• Use the large Memo field to record any notes regarding the filing. This 
text will appear in the generated letter.

• Attach documents such as actuarial memorandum (if desired), using the 

Browse button  in conjunction with the Attach File field.

6. Click Perform.

The filing generates. During the generation process, a Document Generation 
window appears, tracking the generation in progress (this may take a while, 
depending on the size of the filing). The document then opens in Microsoft 
Word. Here you can view and print the filing letter, as required.

7. Close Microsoft Word.

8. Click OK to finish.

The activity will be saved and listed on the filing’s Activity tab. The filing 
documents will remain available via the corresponding activity detail 
record.

Performing the Filing Approval Activity
Use this method to approve a filing’s Rule/Rate/Form.

Method: Perform the Filing Approval activity

1. Navigate to the filing where you want to perform the Approve Filing in 
System activity.

2. Click the Perform Activity button. 

The Perform Activity window opens.
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3. Select Approve Filing in System and click the Perform button.

The Perform Activity – Approve Filing in System window opens.

4. Using the calendar popup boxes, select the Approval Eff. Date and 
Approval Date.

5. Click Perform. 
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A Status Message window opens indicating whether the activity was 
performed successfully. 

6. Click Close.

You can see that the status for the filing is changed to Approved. As well, 
the status for the Rule/Rate/Form is changed to Approved.
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Performing Activity Searches

You can search for activities using the Search function. When you find the 
appropriate activity, you can open the filing, filing group, or publication with the 
Activities tab visible when you select this activity from the search window.

The following tasks deal with activity searches:

• Activity Search Options on page 257

• Searching for Activities on page 257

Activity Search Options
The following options are available to you when a search is performed on 
activities. Each description of the option also contains the details provided in the 
search results:

Activities: When this option is selected from the Search For drop-down box, all 
activities that meet the defined criteria are displayed in the search results. The 
results provide you with the activity description, who initiated the activity, the 
status, the activity code, and the source type (filing group, filing, or publication).

Activities – Filing Groups: When this option is selected from the Search For 
drop-down box, all of the activities in filing groups that meet the defined criteria 
are displayed in the search results. The results provide you with the filing group 
number, the activity description, who initiated the activity, the status, and the 
activity code.

Activities – Filings: When this option is selected from the Search For drop-down 
box, all of the activities in filings that meet the defined criteria are displayed in the 
search results. The results provide you with the filing number, the activity 
description, who initiated the activity, the status, and the activity code.

Activities – Publications: When this option is selected from the Search For 
drop-down box, all of the activities in filings that meet the defined criteria are 
displayed in the search results. The results provide you with the publication 
number, the activity description, who initiated the activity, the status, and the 
activity code.

Note: Because all of the headings cannot fit into the Search Result tab, you must use the 
scroll bar if you want to view the complete result details.

Searching for Activities
To search for an activity, complete the steps described in Performing Tracker 
Searches on page 424. The activity search options in the Search For drop-down 
box are described in Activity Search Options on page 257.

After performing the search, the Search Results dialog displays, from which you 
can select an activity.When selecting an activity from the Search Results tab of 
the Tracker Search window, you can view the associated filing, filing group, or 
publication for that activity immediately, allowing you to determine if this is the 
appropriate activity. Because the Tracker Search window remains open, you 
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have the option to continue selecting activities from the search results until you 
find the right activity.

Method: Select and open a filing, filing group, or publication from an 
activity search

1. Perform a search for an activity as described above.

2. Select an activity from the Search Results tab and click OK.

The associated filing, filing group, or publication is displayed behind the 
Tracker Search window with the Activities tab visible.

3. If the selected activity is not the activity you are looking for, repeat the 
above step until you have found the appropriate activity. 

4. Once you find the activity you are looking for, click the Close button on the 
Tracker Search window.
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Multi-Filing Activities

The following sections describe multi-filing activities:

• Performing Activities for a Multi-Filing on page 259

• Posting Activities for a Multi-Filing on page 259

• Generating and Printing Activities on Multiple Filings on page 260

Performing Activities for a Multi-Filing
The Perform Activities function works the same for multi-filings as it does for 
single filings; the activity is simply applied across more than one filing.

Method: Perform an activity for a multi-filing

1. Navigate to the filing group where you want to perform an activity on a 
multi-filing.

2. On either the My Filings or the Filings tab, select all of the filings to which 
you want this activity to apply. You can select multiple filings by holding 
down the Shift (to select a series) or Control (to select random multiples) 
key while you click them.

3. Click the Perform Activity button .

The Activities List dialog displays.

4. Select the activity you want to perform and click Perform.

The related New Activity dialog displays.

5. Enter information in the applicable fields.

Note that:

• The Performed By field will automatically be filled in with your name.

• The Date field will automatically be filled in with today’s date.

• Use the large Memo field to record the main text or information about a 
note, letter, or phone message.

6. To finish, click OK.

The new activity will be performed or recorded, and the dialog box will 
close. The activity record will be added to the activity tabs of all the selected 
filings. These activity details records can now be treated and updated 
individually.

Posting Activities for a Multi-Filing
The Post Activities function works the same for multi-filings as it does for single 
filings; the activity is simply applied across more than one filing.
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Method: Post an activity to a multi-filing

1. Navigate to the filing group where you want to post an activity on a multi-
filing.

2. On either the My Filings or the Filings tab, select all of the filings to which 
you want this activity to apply. You can select multiple filings by holding 
down the Shift (to select a series) or Control (to select random multiples) 
key while you click them.

3. Click the Post Activity button  to open the Activities List box.

4. Click the activity you want to post.

5. Click Post to open the related New Activity dialog.

6. Enter information in the applicable fields.

Note that:

• The Performed By field will automatically be filled in with your name.

• Use the Suspense Date field to enter Suspense Dates, reminder dates, 
due dates, and so forth. You can sort your My Filings and My Filings 
— All tabs by these activity dates.

• Use the large Memo field to record the main text or information about a 
note, letter, or phone message.

7. To finish, click Post. The new activity will be posted, and the dialog will 
close.

The activity record will be added to the activity tabs of all the selected 
filings. These activity details records can now be treated and updated 
individually.

Generating and Printing Activities on Multiple Filings
Generating and printing activities can be performed on multiple filings in the 
same manner as single filings, using the method described for Performing 
Activities for a Multi-Filing on page 259.

Follow the directions above, selecting a generation activity (such as Generate 
Filing – Complete, Generate Filing – Cover Letter Only, and so on) from the 
activity list. The generation will be performed for all of the filings, and the 
documents will be opened in Microsoft Word so that you can view, print, and then 
close the generated documents as required.

Note: Each document generated will contain information specific to that filing, as drawn 
from that filing’s record information, and the Regulatory Specialist databases. The 
generation activities will then be added to each of the filings’ activity tabs, where 
the related activity detail records, and the generated documents, can later be 
accessed and modified individually.
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Note: To print a complete filing package, you would not use Microsoft Word. You would 
click the Print Package button on the Edit Activity window.
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Chapter 8 
Working with SERFF Filings 

This chapter describes:

• SERFF on page 264

• The SERFF Tab (Filing Level) on page 265

• Working with SERFF Filings En Masse on page 267

• Working with SERFF Filings at the Filing Level on page 276

•  Reviewing SERFF Filings on page 302

• Submitting Filings to SERFF on page 310

• Monitoring SERFF Filings and Working with Messages on page 311

• Working with Submitted Filings on page 319

• Working with Closed Filings on page 343

• Filing Summary for SERFF Filings on page 345

Note: Before performing the procedures described in this chapter, you would need to 
have completed the procedures described in the previous chapter, Working with 
Filings on page 125.
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SERFF

SERFF is the system designed and maintained by the NAIC that allows insurance 
companies to send filings electronically to states that participate in SERFF. In 
contrast to traditional paper-based filings, submitting a filing through SERFF 
allows you to send all required filing documentation electronically. 

Tracker integrates with SERFF to allow you to access the most current state 
requirements for filings as stored in the SERFF filing rules database. 

The previous chapter (Working with Filings on page 125) described the following 
steps performed in Tracker to create a traditional paper-based or SERFF filing:

• Create your filing groups

• Create your filings 

• Add the filing content of rates/rules/forms to your filing

• Add other attachments to your filing under the Other Attachments tab

This chapter describes how to use Tracker to submit filings electronically to 
SERFF and to manage the filing process for electronic filings. You need to 
perform the following procedures, but note that their order depends somewhat on 
your own business process.

1. Selecting the TOI, the sub TOI, and the filing type.

2. Retrieving and reviewing the SERFF supporting documentation filing 
requirements

3. Reviewing the General Instructions.

4. Satisfying or bypassing filing requirements.

5. Creating any user added requirements.

6. Entering State-Specific values.

7. Setting Public Access values.

8. Selecting the filing fee payment method (check or EFT) and entering the 
payment details.

9. Reviewing the SERFF filing details.

10. Generating a draft of the SERFF filing.

11. Reviewing the generated filing.

12. Submitting your filing to SERFF.

13. If necessary, revising or amending submitted filings.
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The SERFF Tab (Filing Level)

Initially, no SERFF tab appears in filings. On the Filing Details tab, a SERFF area 
includes fields (initially blank) for TOI, Sub TOI, and Filing Type. After selecting 
values for these fields, and performing the activity to get the filing requirements, a 
SERFF tab is added to the filing.

SERFF Tab Banner
The SERFF tab contains a banner with the following read-only fields:

• Type of Insurance, Sub TOI, Filing Type – These fields are populated 
with your previous selections for these values.

• SERFF Filing ID – A value does not appear here until the filing is 
successfully submitted to SERFF.

• SERFF Status – A value does not appear here until the filing is successfully 
submitted to SERFF. The status will change as the filing progresses through 
the review process at the state.

• State Status – A value does not initially appear here but will be populated 
by the system with the value sent from SERFF as the filing moves through 
the review process at the state.

• Submitted – This read-only check box is selected after the filing has been 
successfully submitted to SERFF.

• Public Access – This read-only check box is initially not selected, 
indicating that the filing is not Public Access. The system will select the 
check box when the state sets the public access status of the filing to Yes.

• Primary Reviewer and Other Reviewers – names and phone numbers, if 
available, provided by SERFF

SERFF Tab Subtabs
The SERFF tab contains the following subtabs:

• Supporting Documentation – Contains the supporting documentation 
schedule item requirements for this filing. From this tab, you can view the 
SERFF filing details, SERFF-specific requirements, form schedules, rate/
rule schedules.

• State Specific – From this tab, you can enter any required state values for an 
individual filing.
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• Correspondence – This tab displays a table of all correspondence 
associated with this filing, such as Notes to Filers, Objection Letters and 
Disposition Reports. Double-click an item to open it. From this tab, you can 
also create a Filing Amendments, Notes to Reviewers and Objection 
Responses.

By default, the entries in the table are sorted by Date Received/Sent, newest 
first (ascending). Right-clicking on the date of an entry displays a context 
menu where you can select to sort the table by that date in ascending or 
descending order. 

• Public Access – From this tab, you can mark certain parts of the filing or the 
filing itself as confidential to request that the state keep these items 
confidential and not make them available via Public Access.

• Log Entries – From this tab, you can view the various SERFF messages 
associated with this filing.

From the SERFF tab and its sub-tabs, you will perform a variety of tasks to 
prepare the filing for submission to SERFF, as well as to manage the filing 
through the review process. 
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Working with SERFF Filings En Masse

You can work with SERFF filings in two ways:

• en masse (working with multiple filings within a filing group at the same 
time)

• at the Filing level

Initially, you will work with filings en masse because it allows you to enter 
information much more quickly and efficiently. Later in the process, you will 
work with filings at the filling level. Changes you make at the Filing level will 
appear when working with that filing group en masse.

The procedures that you can perform for filings en masse are:

• Selecting TOI, Sub TOI and Filing Type for Filings En Masse on page 267

• Retrieving Requirements for Filings En Masse on page 269

• Satisfying Requirements for Filings En Masse on page 271

•  Bypassing Requirements for Filings En Masse on page 273

Selecting TOI, Sub TOI and Filing Type for Filings En 
Masse
The initial step in preparing a filing for submission to SERFF involves selecting a 
filing’s Type of Insurance (TOI), a sub TOI, and a Filing Type for filings within a 
particular Tracker Line of Business (LOB). The Product Coding Matrix (also 
called simply “the matrix”) is maintained by the NAIC and contains the uniform 
classifications for TOIs, sub TOIs, and Filing Types. The matrix represents a more 
exact and detailed classification than the Tracker LOB.

SERFF is premised on the assumption that all states are using the matrix. By using 
the en masse procedure below, you can make TOI, sub TOI and filing type 
selections for all states using the matrix by making a single selection.

States where no values are returned are, by definition, non-matrix states. For these 
states, you will have to select the TOI, sub TOI and filing type on a state-by-state 
basis. You can do this within the en masse screen (as described below) or at the 
Filing level, as described in Selecting the TOI, Sub TOI and Filing Type at the 
Filing Level on page 276.

Method: Select a TOI, sub TOI and filing type for filings en masse

1. Navigate to the desired filing group.

2. Click the Select TOI, Sub TOI and Filing Type button on the toolbar  or 
select Insert > TOI Selection.

The TOI, Sub TOI and Filing Type Selection dialog displays. 



WORKING WITH SERFF FILINGS

268 TRACKER P&C VERSION 6.6 USER GUIDE

The LOB for this filing group is automatically selected in the Available 
LOBs drop-down list. If there is more than one LOB in this filing group, 
then the LOBs are displayed in the Available LOBs drop-down list in 
alphabetical order, and the first LOB in this list is automatically selected.

3. If there is more than one LOB in this filing group, from the Available LOBs 
drop-down list, select an LOB.

Filings belonging to the LOB you selected are displayed.

4. Ensure that all the filing(s) for which you want to make the TOI, Sub TOI 
and Filing Type selection are selected in the Check Applicable Filing(s) 
column. If this is the first time you are accessing the en masse selection 
screen, by default, all the filings are marked as selected. You can clear or 
select the individual check boxes as necessary. To quickly clear all the 
selected filings, click Uncheck.

5. In the Product Coding Matrix section, first select the TOI, then Sub TOI 
and finally the Filing Type which corresponds to the LOB of your filings.

6. Click Match.

The system compares the selections for TOI, Sub TOI and Filing Type 
with each state’s list of active TOIs, sub TOIs and filing types. Matches for 
each state using the matrix are displayed.
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If no match is found, no value is displayed for the selected state. (If no 
matches are found for any selected filings, a message box appears.) You can 
then manually select a value from a drop-down list in each cell.

Note that the system may find a match for the TOI, but not for the Sub TOI 
or Filing Type. If so, you would then have to make a selection in those cells.

7. When you are done making your selections, click Save.

8. Click Close to exit.
 

Retrieving Requirements for Filings En Masse
 After you have selected a TOI, sub TOI, and filing type, you need to retrieve the 
supporting documentation filing requirements from SERFF.

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

Complete the following procedure to simultaneously retrieve the requirements for 
more than one filing in the same filing group. This is known as working with 
retrieving filing requirements en masse. (See also:  Retrieving Requirements at the 
Filing Level on page 280.)

Method: Retrieve the requirements for filings en masse

1. Navigate to the filing group that contains the filings for which you want to 
retrieve the filing requirements.

2. Click the Retrieve Filing Requirements button in the SERFF tool bar. 
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The Retrieve Filing Requirements screen opens.

The Available Filings list includes filings from this filing group

• that have a TOI, sub TOI, and Filing Type populated; and

• for which no filing requirements have been retrieved, whether at the en 
masse level or Filing level

3. In the Available Filings area, select (using click, Ctrl-click or Shift-click) 
the filings for which you want to get the filing requirements.

4. Click the right arrow button. 

The selected filings are moved to the Selected Filings table. The Retrieve 
and Retrieve and Satisfy/Bypass buttons then become active.

5. Click Retrieve.

Tracker displays progress messages as it attempts to download the filing 
requirements for each of the selected filings.

(To retrieve and satisfy or bypass the requirements in one step, you can click 
Retrieve and Satisfy/Bypass. For additional information, see Satisfying 
Requirements for Filings En Masse on page 271 and  Bypassing 
Requirements for Filings En Masse on page 273.)

6. Click Close on the message box.

If Tracker finds a direct match between a filing’s TOI, sub TOI, and filing type 
and the state’s current active list, it performs the following actions for that filing:

• retrieves the Filing Requirements

• performs the Filing Level activity assigned to get the SERFF Filing 
Requirements (this may be a custom activity)

• retrieves the SERFF Tracking ID
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• displays the activity on the Activities tab at the Filing level

• locks the TOI, sub TOI and Filing Type values at the Filing level

Tracker will normally find a match, but if it does not, possibly because during the 
time interval between 

a. retrieving the TOI, and

b. retrieving the filing requirements

the state had changed its TOIs, Tracker deletes that filing’s TOI, sub TOI, and 
filing type choices.

When complete, Tracker displays the SERFF Activity Status Message window 
listing success or failed for each filing involved. 

The failed filings will need to have new TOI, sub TOI, and filing type values 
selected before you can repeat this procedure. (See Selecting TOI, Sub TOI and 
Filing Type for Filings En Masse on page 267, or Selecting the TOI, Sub TOI and 
Filing Type at the Filing Level on page 276.)

Note: A SERFF tab will now appear on the filings for which you successfully retrieved 
their requirements.

Satisfying Requirements for Filings En Masse
 

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

After retrieving the requirements, you can then satisfy the requirements for the 
unsubmitted filings en masse using the Filing Requirements screen.

Using the en masse method, you can only satisfy requirements for which the 
document which applies is an Other Attachment that has been added at the Filing 
Group level. (See Other Attachments on page 195.) To satisfy a requirement with 
just a comment but no Other Attachment, you must use the Filing level method. 
(See  Satisfying Requirements at the Filing Level on page 285.)

Method: Satisfy the requirements for filings en masse

1. Navigate to the desired filing or filing group, and click the Satisfy/Bypass 

Requirements button on the Tracker toolbar. 

The Filing Requirements screen opens. It contains a table with the 
following columns:

• Filings from that filing group that have had their requirements retrieved 
are listed in alphanumeric order by an ID that includes a two-digit state 
code, a two-digit LOB code, a two-digit company (or CG, if a company 
group) code, a two-digit filing content code, and a two-digit sequence 
number

• filing Requirements and their corresponding Status
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• Satisfy/ByPass Details

Tip: This screen provides a summary of where you are in the process of working with 
requirements. It shows previous work done to filings in this filing group using this 
en masse process, and any work done at the Filing level. However, filings that 
have been submitted to SERFF are not shown.

2. From this screen, you can quickly access additional information:

• To view the details of a requirement, mouse over or double-click the 
Requirement name.

• To view the general instructions of a filing, click General Instructions 
under the corresponding filing ID.

Note: You can quickly open a filing by double-clicking the filing ID. This closes the 
Filing Requirements dialog box, however you can quickly open it again by 
clicking the Satisfy/Bypass Requirements button on the Tracker toolbar. In this 
way, you can quickly toggle between the en masse view and an individual filing.

3. To satisfy requirements by affiliating them with Other Attachments you 
have previously added to this filing group, click Satisfy.

The Satisfy Requirements dialog opens.

Note: Requirements in bold must be satisfied and cannot be bypassed.

4. Select a document from the Available Supporting Documents drop-down 
list.

The check boxes in the Check column and the Comments box become 
available.
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5. Select the check boxes beside the requirements that you want to satisfy with 
the Available Supporting Document you selected.

Note: If a check box is greyed out, you will not be able to affiliate the selected Other 
Attachment with that requirement. This is because the Other Attachment has been 
modified at the Filing level.

6. Enter any optional notes or description in the Comments box.

7. Click Satisfy.

The requirements’ corresponding Status is updated to Satisfied.

8. Repeat steps 4 through 7 to satisfy any other requirements with another 
Available Supporting Document.

9. If you want, you can bypass requirements at this point by clicking Bypass 
and following the steps beginning with step 3 in  Bypassing Requirements 
for Filings En Masse on page 273.

10. When you are done, click Close.

 Bypassing Requirements for Filings En Masse 
 

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

After retrieving the requirements, you can then bypass the requirements for the 
unsubmitted filings en masse using the Filing Requirements screen.

Note: Certain requirements may be designated by the state as “non-bypassable.” You 
cannot bypass these requirements; you can only satisfy them. These requirements 
will be displayed in bold.

Method: Bypass the requirements for filings en masse

1. Navigate to the desired filing or filing group, and click the Satisfy/Bypass 

Requirements button on the Tracker toolbar. 

The Filing Requirements screen opens. It contains a table with the 
following columns:

• Filings from that filing group that have had their requirements retrieved 
are listed in alphanumeric order by an ID that includes a two-digit state 
code, a two-digit LOB code, a two-digit company (or CG, if a company 
group) code, a two-digit filing content code, and a two-digit sequence 
number

• filing Requirements and their corresponding Status

• Satisfy/ByPass Details
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Tip: This screen provides a summary of where you are in the process of working with 
requirements. It shows previous work done to filings in this filing group using this 
en masse process, and any work done at the Filing level. However, filings that 
have been submitted to SERFF are not shown.

2. From this screen, you can quickly access additional information:

• To view the details of a requirement, mouse over or double-click the 
Requirement name.

• To view the general instructions of a filing, click General Instructions 
under the corresponding filing ID.

Note: You can quickly open a filing by double-clicking the filing ID. This closes the 
Filing Requirements dialog box, however you can quickly open it again by 
clicking the Satisfy/Bypass Requirements button on the Tracker toolbar. In this 
way, you can quickly toggle between the en masse view and an individual filing.

3. To bypass requirements and provide a reason, click Bypass.

The Bypass Requirements dialog box opens. All the checkboxes and the 
Bypass Reason box become available.
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4. Enter a reason in the Bypass Reason box.

5. Select all the requirements that you want to bypass using this reason.

6. Click Bypass.

The requirements’ corresponding Status is updated to Bypass, and the 
reason is displayed in the Satisfy/Bypass Details column.

7. Repeat steps 4 through 6 to bypass any other requirements.

8. If you want, you can satisfy requirements at this point by clicking Satisfy 
and following the steps beginning with step 3 in Satisfying Requirements for 
Filings En Masse on page 271.

9. When you are done, click Close.
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Working with SERFF Filings at the Filing Level

You can work with SERFF filings in two ways:

• en masse (working with multiple filings within a filing group at the same 
time)

• at the Filing level

Initially, you will work with filings en masse because it allows you to enter 
information much more quickly and efficiently. Later in the process, you will 
work with filings at the filling level. Changes you make at the Filing level will 
appear when working with that filing group en masse.

This section describes the procedures that you can perform for individual SERFF 
filings:

• Selecting the TOI, Sub TOI and Filing Type at the Filing Level on page 276

•  Clearing the TOI, Sub TOI, and Filing Type At the Filing Level on page 280

• Working with Supporting Documentation Filing Requirements at the Filing 
Level on page 280

• Creating a User Added Requirement at the Filing Level on page 288

• Entering State-Specific Values at the Filing Level on page 289

• Setting Public Access Values on page 290

•  Paying Filing Fees on page 291

Note: See also: Working with SERFF Filings En Masse on page 267.

Selecting the TOI, Sub TOI and Filing Type at the Filing 
Level 
You initiate the process of working with a SERFF filing by selecting the TOI, sub 
TOI, and filing type at the Filing level.

Note: You can also select the TOI, sub TOI, and filing type for multiple filings within a 
filing group at one time: see Selecting TOI, Sub TOI and Filing Type for Filings 
En Masse on page 267.

Method: Select the TOI, Sub TOI and Filing Type at the Filing level

1. Navigate to the filing you want to work on as a SERFF filing.

2. In the SERFF area of the Filing Details tab, click Select.
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Tracker connects directly to SERFF and returns the list of Active TOIs, sub 
TOIs, and Filing Types for that state.

The SERFF Filing Information dialog box opens.

3. Expand the TOI entries by double-clicking on the desired TOI, or clicking 
on the  to the left of the desired TOI.
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4. Expand the sub TOI entries by double-clicking on the desired sub TOI or 
clicking on the  to the left of the desired Sub TOI.

5. Click the desired filing type under the Sub TOI.

The OK button becomes active.
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6. Click OK.

The filing is now using the selected SERFF filing type for this TOI and sub 
TOI.
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 Clearing the TOI, Sub TOI, and Filing Type At the 
Filing Level
If you have entered an incorrect TOI, sub TOI or filing type, you can clear these 
values at the Filing level before you retrieve the requirements for this filing.

Important: If you have already obtained the filing requirements for this filing, then you 
cannot clear the TOI, sub TOI, and filing type for this filing. If you want to clear 
the TOI, sub TOI, and filing type for a filing where you have already obtained the 
filing requirements, you must delete the SERFF: Get Filing Requirements 
activity: see Deleting an Active Activity Detail Record on page 244.

Method: Clear the TOI, sub TOI, and filing type at the Filing level

In the SERFF area of the Filing Details tab, click Clear. The TOI, Sub TOI, and 
Filing Type are cleared. 

Alternatively, you can click Select and select a new TOI, sub TOI, and filing type.

Working with Supporting Documentation Filing 
Requirements at the Filing Level
The Supporting Documentation tab within the SERFF tab of a filing contains 
the current list of filing requirements for the TOI, sub TOI, and filing type that 
you have selected for this SERFF filing. You must either bypass or satisfy each 
requirement in order to submit the filing to SERFF.

This section describes:

•  Retrieving Requirements at the Filing Level on page 280

• Viewing Requirements at the Filing Level on page 283

•  Working with General Instructions at the Filing Level on page 284

•  Satisfying Requirements at the Filing Level on page 285

• Removing Requirements Attachments at the Filing Level on page 287

• Bypassing Requirements at the Filing Level on page 287

 Retrieving Requirements at the Filing Level
Supporting documentation filing requirements are referred to as requirements in 
this documentation. You can retrieve the SERFF filing requirements at the Filing 
level by performing the SERFF:Get Filing Requirements activity.

Note: You can also retrieve the SERFF filing requirements for multiple filings within a 
filing group at one time: see Retrieving Requirements for Filings En Masse on 
page 269.
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Method: Retrieve the filing requirements at the Filing level

1. Open the SERFF filing for which you have already selected a TOI, sub TOI, 
and filing type.

2. Click the Perform Activity button on the toolbar. 

3. From the list of activities, click SERFF:Get Filing Requirements, then 
click Perform.

The Perform Activity – SERFF:Get Filing Requirements dialog box 
opens.
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4. Change the Priority if necessary, and enter a Memo if required.

5. When you are done, click Perform.

Tracker displays progress messages as it attempts to download the filing 
requirements.

If Tracker finds a direct match between the filing’s TOI, sub TOI, and filing 
type and the state’s current active list, it performs the following actions for 
the filing:

• retrieves the Filing Requirements

• performs the activity assigned to get the SERFF Filing Requirements 
(this may be a custom activity)

• retrieves the SERFF Tracking ID

• displays the activity on the Activities tab at the Filing level

• locks the TOI, sub TOI and Filing Type values at the Filing level

Note: Tracker will normally find a match, but if it does not—possibly because the state 
had changed its TOIs during the time interval between retrieving the TOI and 
retrieving the filing requirements—Tracker deletes that filing’s TOI, sub TOI, and 
filing type choices. You need to choose new TOI, sub TOI, and filing type values 
for the filing before you can repeat this procedure. (See Selecting the TOI, Sub 
TOI and Filing Type at the Filing Level on page 276.)
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When complete, Tracker displays the SERFF Activity Status Message 
window listing success or failed.

6. Click Close.

The filing requirements have been downloaded for this filing, and are ready 
to be either satisfied or bypassed.

Note: A SERFF tab will now appear on this filing.

Viewing Requirements at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

Before associating any documents you have entered into Tracker with a 
requirement, you should first view the requirement to see its details.

Method: View a requirement at the Filing level

1. Navigate to the filing where you want to view the SERFF filing 
requirements, and click the SERFF tab.

2. Click the Supporting Documentation sub-tab.

The Supporting Documentation sub-tab lists the supporting 
documentation filing requirements in a table that contains the following 
columns:

• Requirement – the name of the supporting documentation filing 
requirement; you can mouse over the Requirement name to view its 
description as a pop-up

• Status – the status of the supporting documentation filing requirement 
(Bypassed or Satisfied)

• Rev – identifies revisions to supporting documentation schedule items 
with an R.

• Document Name(s)/Comments/Bypass Reason – the name of the 
associated document (attachment), any relevant comments, or the 
reason a bypassed requirement was bypassed

• State Status – a value can appear here after the state processes the 
filing, however, not all states update this field, in which case this value 
will remain blank
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• Public Access – indicates whether the document affiliated with the 
requirement can be publicly accessed; the value for this field will 
remain blank until it updated by the state when they process the filing

3. In the Supporting Documentation subtab, click the Requirement you 
want to view from the requirements table to highlight it.

4. Click View Requirement.

The View Requirement dialog displays.

5. To open the file, click a file name in the Select a file to view area and click 
View.

6. When you have finished viewing this supporting documentation filing 
requirement, click Close.

 Working with General Instructions at the Filing Level
You can view, print or save the general instructions from the state for a SERFF 
filing. You can also view, print or save any documents that the state has attached 
to the general instructions.

Note: You can view the General Instructions of multiple filings within a filing group at 
one time when satisfying or bypassing requirements en masse: see Satisfying 
Requirements for Filings En Masse on page 271 and  Bypassing Requirements for 
Filings En Masse on page 273.

Method: View, print or save general instructions at the Filing level

1. Within a filing, on the Filing Details or SERFF tab, click View General 
Instructions.
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Tracker connects to SERFF and returns the general instructions for that 
state. View SERFF General Instructions opens.

Description contains the overall set of general instructions from the state.

2. To print the general instructions, click the printer button in the upper-right 
corner of the dialog box.

3. To save the general instructions to a file, click the Save button in the upper-
right corner of the dialog box.

4. Under Select a file to view: click a file name and click View to open the file. 

The file opens in the corresponding application. You can then print or save 
the file.

5. Click Close when you have finished viewing the general instructions from 
the state for this filing. 

 Satisfying Requirements at the Filing Level
Supporting documentation filing requirements are referred to as requirements in 
this documentation.

You satisfy a given state’s supporting documentation filing requirements by 
affiliating one or more Tracker attachments with that requirement. You can also 
satisfy a requirement with a comment about why no attachment is necessary.

Tip: You can also use this procedure to edit a requirement’s comments, or edit the list 
of affiliated attachments, provided the filing has not been submitted to SERFF. 
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Note: You can also satisfy multiple requirements for multiple filings within a filing 
group at one time: see Satisfying Requirements for Filings En Masse on page 271.

Method: Satisfy requirements at the Filing level

1. In the filing, click the SERFF tab.

2. In the Supporting Documentation tab, double-click the Requirement you 
want to satisfy. 

The Supporting Documentation Details dialog displays.

3. From the Status drop-down list, select Satisfied.

4. In the Comments box, enter any additional information about the 
requirement or the attachment.

5. Click the attachment type in Available Attachments. If necessary, expand 
the list of attachments by clicking on the  to the left of the source of 
attachments.

6. Click the attachment and click the right arrow  to move the attachment to 
the Selected Attachments list.

7. Click OK to save your changes and close the dialog.
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Removing Requirements Attachments at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

You can remove any or all attachments you have associated with a supporting 
documentation filing requirement before submitting to SERFF.

Method: Remove requirement attachments

1. Double-click the requirement from which you want to remove an associated 
attachment.

2. In the Selected Attachments list, click the attachment you want to remove 

from this requirement, then click the left arrow button. 

3. To remove all attachments from this requirement, click the double left arrow 

button. 

4. Click OK to save changes and close the dialog.

Bypassing Requirements at the Filing Level

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

You can bypass a requirement, however, you must provide a reason. If you do not 
provide a reason, you will get an error message when you attempt to submit the 
filing to SERFF.

Method: Bypass a requirement at the Filing level

1. In the filing, click the SERFF tab.

2. In the Supporting Documentation tab, double-click the Requirement you 
want to bypass.

Note: You cannot bypass requirements which are displayed in bold; you can only satisfy 
them: see  Satisfying Requirements at the Filing Level on page 285.

The Supporting Documentation Details dialog displays.
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3. From the Status drop-down list, select Bypassed.

The Bypass Reason box is displayed.

4. In Bypass Reason, enter the reason why you are bypassing this requirement.

5. Click OK when you are done. 

Note: You can also bypass multiple requirements on multiple filings within a filing 
group at one time: see  Bypassing Requirements for Filings En Masse on page 273.

Creating a User Added Requirement at the Filing Level
If you have a filing that needs a requirement that is not listed in the Supporting 
Documentation tab, you can add it. This type of supporting document 
requirement is called a User Added Requirement. An example of this is a 
document that was requested in the General Instructions but not included in the 
list of Filing Requirements.

Method: Create a user added requirement

1. In the filing, click the SERFF tab.

2. Click the User Added button  on the SERFF toolbar.
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The User Added Requirement dialog displays.

3. In the Comments box, enter any notes or information about this 
requirement or attachment.

4. Click the attachment type in Available Attachments. If necessary, expand 
the list of attachments by clicking on the  to the left of the source of 
attachments.

5. Click the attachment and click the right arrow  to move the attachment to 
the Selected Attachments list.

6. When you are done, click OK.

Entering State-Specific Values at the Filing Level
State-specific values represent other information required by the state for a 
SERFF filing. There are three ways you can add this information to Tracker:

• You can select matching data for these values from pre-existing data in 
Tracker.

• You can enter free-form data for values without defaults.

• You can edit or overwrite the default values provided.

Note: You must complete the state-specific fields.

Method: Enter state-specific values at the Filing level

1. Navigate to the filing where you want to enter state-specific values

2. Click the SERFF tab, then click the State Specific sub-tab.
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3. In State Specific Fields Selection, click the Description for the state-
specified field you need to enter.

4. Select the source of the field value from the drop-down list.

The value of the source you have selected is displayed to the right of the 
source name.

5. To use a different value, edit the value in the text box. No Save or Enter is 
required.

Setting Public Access Values
The Public Access subtab enables you to request via SERFF that certain parts of a 
filing or the filing itself be kept confidential and not made available via Public 
Access.

Note: If the state does not allow confidentiality requests, this subtab will not appear.

The Public Access subtab displays the contents of a filing being submitted via 
SERFF in a list. Any items removed or added to a filing are automatically 
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reflected in this list. The items in the list (if they are present in the filing) are 
displayed in this order, from top to bottom: 

• an entry called Entire Filing

• all forms

• all rates, followed by a rate schedule

• all rules

• all SERFF filing requirements (including User Added attachments) that 
have been satisfied or bypassed, the comments, the bypass reasons, and the 
attachments

For each item in the list, there is a corresponding Request Conf check box. Prior 
to submitting the filing via SERFF, when you select a check box, the word 
Accepted displays in the corresponding cell in the Status column. When you clear 
a check box, the Status for that item is cleared. If the check box for Entire Filing is 
selected, all the items in the list become selected and their status becomes 
Accepted. Clearing the Request Conf check box for Entire Filing clears all the 
check boxes and status values. 

After the filing is submitted:

• Any subsequent new filing package items added to the filing will not appear 
on this list, however, any subsequent revised filing package items added to 
the filing will appear on this list.

• If the state accepts the request for an item’s confidentiality, the item’s Status 
will remain at Accepted. If rejected, the value of the Public Access setting 
on the Public Access subtab and other areas of Tracker will be set to 
Rejected.

• If any of the items on this list are revised, the revised items will appear on 
this list directly beneath the “parent” item. Until the revised item is 
submitted via SERFF, the corresponding values in the Request Conf and 
Status columns for the revised items will reflect the same current settings as 
the “parent.” After a revised item is submitted via SERFF, the public access 
indicators all throughout Tracker (including the Public Access tab) for this 
revised item are no longer tied to the parent item, and its public access status 
is completely separate from its parent’s.

 Paying Filing Fees

You can pay filing fees by check or EFT. For payment by check, see Entering 
Filing Fees Paid by Check on page 203. For EFT payments, see Paying Filing 
Fees via EFT.

Paying Filing Fees via EFT
For SERFF filings, you can pay filing fees via EFT for states that allow EFT. The 
EFT payment option is available exclusively for SERFF filings. 

Note: Once an EFT payment is made, subsequent payments must be made using EFT.
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In order for fees to be paid via EFT, there are several items that must first be 
configured in the Administration section of Tracker. These include the Payer 
UNID and the EFT authorization levels. See Company Information on page 54 
and SERFF Settings on page 66.

When you make your selection of the TOI, sub TOI and filing type, whether the 
state accepts EFT payments or not is passed to Tracker and displayed on a filing’s 
Filing Fee tab as follows:

• If the state accepts EFT payments, EFT is enabled in the Payment Method 
section and the State Accepts EFT field is displayed.

• If the state does not accept EFT payments, then the EFT payment method is 
grayed out.

• If the State Charges Fee Per Company field is displayed, it indicates that 
state charges the filing fee on a per company basis.

On the SERFF toolbar, the color of the EFT icon indicates the EFT payment 
status. 

As well, when EFT payment information is added to a filing’s Payment History 
Details table, the corresponding entry in the EFT column on the Filing Group 
level – My Filings, Filing Group level – Filings, or Top Level – My filings - All 
tabs display Yes, otherwise they display No.

Method: Pay the filing fee via EFT

1. Navigate to the filing where you want to pay the filing fee via EFT.

2. Click the Filing Fee tab.

Payment Status Icon Color

EFT payment information is added to the Payment 
History Details table

Green

EFT payment information is removed from the 
Payment History Details table, also the default status

Red

No filing or multiple filings are highlighted at the 
Filing Group level or Top level 

Grey
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3. In the Payment Method section, select EFT.

The Payment History Details table will display.

Note: An error message will be displayed if the Tracker Administrator has not 
configured a valid Payer UNID for the company. To configure a company’s 
UNID, see Entering or Editing General Information for Companies on page 56.

4. If any portion of the fee is being paid on a retaliatory basis, click Yes in the 
Is Fee Retaliatory? section.

5. Enter any descriptive information (such as how the fee is calculated) in the 
Fee Explanation field.

6. Click Add Payment.

The EFT Fee Allocation dialog displays.

7. Enter the Fee Amount.
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8. Enter any descriptive notes in the Comments field.

9. Click Allocate.

The fee is added to the Fee Allocation table at the bottom of the dialog.

Note: If the fee amount you enter exceeds the maximum allowed for your EFT 
authorization level, a message will be displayed. In this case, you will not be able 
to proceed with the EFT payment for this filing. You will need to contact your 
Tracker Administrator to continue, or you will need to have another user with the 
appropriate EFT authority level complete the EFT information.

10. Click OK to save you work.

The filing fee you entered is displayed in the Payment History Details table 
at the bottom of the Filing Fee tab. (For more information about this table, 
see Viewing EFT Transaction Information at the Filing Level on page 294.)

The color of the EFT icon on the SERFF toolbar becomes green. On all 
screens where filings are listed, the corresponding entries in the EFT column 
display Yes.

Viewing EFT Transaction Information at the Filing Level
The Payment History Details table (displayed on a filing’s Filing Fee tab after a 
payment type has been selected) displays each payment for a filing. The 
information displayed includes:

• Transaction Date

• EFT Status – Pending, Successful or Failed

• EFT Transaction ID – provided by SERFF after a successful EFT payment

• Company Name – the name of the company that the transaction applies to

• Amount – the amount of the EFT transaction

• Type - the EFT transaction type: Initial or Additional: Initial means the 
EFT request was sent with the initial filing; Additional means additional 
fees were sent on the filing

• Authorized By

• Comments

See also: Paying Filing Fees via EFT on page 291.

Allocating EFT Company Group Filing Fees
The way fees are allocated when paying company group filing fees via EFT 
depends on the administrative settings for the companies in the group and the way 
the state charges for filings.

When the state does not charge fees on a per company basis, the fee can only be 
allocated to one company. By default, the system will allocate the payment as 
follows: 
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• If the filling contains the company that has been designated as Primary EFT 
in the Admin setup, the fee will be allocated entirely to the company 
designated as Primary EFT.

• If the filing does not contain the company designated as Primary EFT, the 
system will allocate the payment entirely to the first company in the filing 
with a valid payer UNID, but you can override the default allocation for a 
particular payment if you want.

Method: Allocate an EFT fee #1

In this example, (a) the state does not charge a fee per company, and (b) one 
company in the group is designated as Primary EFT.

1. Open the filing and display the Filing Fee tab.

2. In the Payment Method area, select EFT.

3. Click Add Payment.

The EFT Fee Allocation dialog box opens. The Fee Allocation table shows 
all companies with payer UNIDs.

4. Enter the Fee Amount.

5. Click Allocate.

For the Primary EFT company, the Action is set to Allocated, and the Fee is 
set to the total Fee Amount. For the other companies, the Action is set to 
Bypassed, and the Fee is set to $0.00.

Companies 
with UNIDs

Primary EFT 
Company
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6. Click OK.

The payment is listed in the Payment History Details window.

Method: Allocate an EFT fee #2

In this example, (a) the state does not charge a fee per company, and (b) one or 
more companies in the group have a payor UNID but none is designated as 
Primary EFT

1. Open the filing and display the Filing Fee tab.

2. In the Payment Method area, select EFT.

3. Click Add Payment.

The EFT Fee Allocation dialog box opens. The Fee Allocation table shows 
all companies in the filing with a payor UNID.



WORKING WITH SERFF FILINGS AT THE FILING LEVEL

TRACKER P&C VERSION 6.6 USER GUIDE  297

4. Enter the Fee Amount.

5. Click Allocate.

The first company will have Action set to Allocated, and the Fee set to the 
total Fee Amount. The other companies will have Action set to Bypassed, 
and the Fee set to $0.00.

6. If you want to override the default allocation, follow these steps:

a. On the EFT Fee Allocation dialog box, click Allocated in the Action 
column and select Bypassed from the drop-down list.

b. The fee amount will be changed to $0.00.

c. Click in the Action column beside the company you wish to affiliate the 
payment to and select Allocated from the drop-down list.

d. Enter the amount of the payment and press Enter.

Note: If you attempt to allocate the fee to another company without first bypassing the 
company to which the fee was originally allocated, the following error message is 
displayed: “Fee can only be allocated to one company. In order to change the 
default allocation, you must set the Action to bypass on the original allocation.”

7. Click OK.

Companies 
with UNIDs
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The Payment History Details window is updated. (The default allocation is 
shown below.)

Method: Allocate an EFT fee #3

This is an example of how to allocate an EFT Fee when the state charges a fee per 
company

1. Display the Filing Fee tab.

2. In the Payment Method area, select EFT.

3. Click Add Payment.

The EFT Fee Allocation dialog box opens. The Fee Allocation table 
displays all the companies in the filing.

4. Enter the Fee Amount.

5. Click Allocate.

The fee is allocated in one of the following ways:

• If there is no company in the filing designated as Primary EFT, the fee will 
be allocated evenly across all companies in the filing with a payor UNID.

• If one of the companies in the filing is designated as Primary EFT, the full 
fee amount is allocated to that company.

Companies 
with UNID

No Primary EFT 
company
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6. Click OK.

The Payment History Details window is updated.

Method:  Make the EFT payment

Perform the SERFF: Generate SERFF Filing activity and click the Move to 
Filing Package and Submit to SERFF option.

The EFT information you entered in the EFT Fee Allocation dialog will 
automatically be transmitted with the filing to SERFF

Adjusting EFT Filing Fee Details Before Submitting
If, at any point before submitting a filing to SERFF, you need to adjust the EFT 
filing fee details, you can edit them.

Note: All fields in the EFT Fee Allocation dialog box can be edited before submitting 
the filing. Once submitted, only the Comments field and Fee Explanation field 
can be edited.
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Method: Edit EFT filing fee payments

1. In the Filing Fee tab of a filing, double-click any of the payments listed in 
the Payment History Details table.

2. Make your required changes.

3. When you are done, click OK.

The dialog box closes, and the payment details will be updated.

EFT Transaction Status
When you have made your EFT selections, the EFT information (including the 
EFT status) will appear in the Payment History Details table on the Filing Fee 
tab. After the filing has been sent to SERFF, the EFT statuses will be as follows:

• Pending – The EFT status will be remain as Pending if the filing fails to go 
to SERFF. In this case, you will receive a log entry indicating that the filing 
failed, which also means the EFT submission failed. In this case, you will 
need to make the necessary corrections to the filing and submit it to SERFF 
again. You do not need to reenter the EFT information. Your original 
selections will be retained and sent to SERFF when you perform the activity 
to submit to SERFF. 

• Failed – If the filing itself is successfully sent to SERFF, but there is a 
problem with the EFT information, you will receive a log entry stating that 
the EFT transaction failed, and the EFT status will appear as Failed. In this 
situation, you will need to make the necessary corrections to the EFT 
information and then perform the activity of SERFF: Submit Additional 
Fee.

• Successful - The EFT status will appear as Successful when the EFT 
transaction is successfully transmitted to the DOI. 

Additional Payments
Once an initial payment has successfully been submitted to SERFF, you cannot 
allocate a payment to a company that was bypassed in the initial payment.

Example 1:

There are two companies in the filing and the user successfully sends SERFF an 
initial EFT payment of the following:

• Company A: Action=Allocated, Fee=$1000

• Company B: Action=Bypassed, Fee=$0

If a 2nd EFT payment is required, the user cannot affiliate any portion of it with 
Company B. Subsequent payments can only be affiliated with Company A.

Example 2:
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There are three companies in the filing and the user successfully sends SERFF an 
initial payment of the following:

• Company E: Action=Allocated, Fee=$250

• Company F: Action=Allocated, Fee=$250

• Company G; Action=Allocated, Fee=$250

If a 2nd payment is required, the user can affiliate it with all three companies, only 
two companies, or even with only one company.
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 Reviewing SERFF Filings

Before submitting filings to SERFF, you should review the details of the filing. 
This involves:

• Viewing SERFF Filing Details on page 302

•  Viewing Form Schedules on page 306

• Viewing Rate/Rule Schedules on page 307

• Generating a Draft SERFF Filing on page 308

Viewing SERFF Filing Details
 Once you have satisfied or successfully bypassed each filing requirement, you are 
ready to review and verify the SERFF filing details. Some of this data is entered 
automatically by Tracker, and all you need to do is verify that it is correct. Some 
of this data is configurable in the Tracker system defaults: see System Defaults on 
page 35 for more information.

Method: View SERFF filing details

1. Navigate to the filing where you want to view SERFF filing details. 

2. Click the SERFF tab.

3. Click View SERFF Filing Details.

The SERFF Filing Details dialog displays.
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4. You can accept the default values, or, for the fields that are editable, you can 
enter different values. The fields are described in the next section: SERFF 
Filing Details Fields on page 303.

5. When you are done, click OK to save your changes, or click Cancel to exit 
without making changes.

SERFF Filing Details Fields
The following table describes the section and fields of the SERFF Filing Details 
screen and contains three columns:

• The Field or Section Name column lists the name of the fields and sections.

• The Description column describes each the fields.

• The Data Source / Data Entry Instructions column describes where the 
defaults values are obtained from and how to select or enter values for fields 
that are editable. Note that you edit only certain fields, while others are read-
only and cannot be edited.
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Field or Section 
Name Description

Data Source / Data Entry 
Instructions

SERFF Filing ID The tracking ID for 
this filing (from 
SERFF).

Populated by the system 
when the filing is successfully 
submitted to SERFF.

TOI The TOI for this 
filing.

The TOI as entered in 
Tracker.

Sub TOI The sub TOI for this 
filing.

The sub TOI as entered in 
Tracker.

Filing Type The filing type. The Filing Type as entered in 
Tracker.

Project Name The name of the 
project containing this 
filing.

This field obtains data 
automatically from one of the 
following fields, based on 
what has been entered in 
SERFF System Defaults:
• Program Name
• Filing Group Name
• Filing Group Description
• Filing Description
• Custom Field, Filing Group 

Level
• Custom Field, Filing Level
• Company Reference 

Number

Project # The project number 
containing this filing.

This field obtains data 
automatically from one of the 
following fields, based on 
what has been entered in 
SERFF System Defaults:
• Tracker Filing ID
• Filing Group Name
• Filing Group Description
• Filing Description
• Custom Field, Filing Group 

Level
• Custom Field, Filing Level
• Company Reference 

Number
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Product Name The name of the 
product associated 
with this filing.

This field obtains data 
automatically from one of the 
following fields, based on 
what has been entered in 
SERFF System Defaults:
• Program Description
• Filing Group Name
• Filing Group Description
• Filing Description
• Custom Field, Filing Group 

Level
• Custom Field, Filing Level

Company Tracking # The Tracker filing 
identification number.

• Company Reference # 
field (if a value for 
Company Reference # is 
present at the point the 
filing is sent to SERFF)

• Tracker Filing ID (if a 
value for Company 
Reference # is not present 
at the point the filing is sent 
to SERFF)

Companies in Filing The companies 
associated with this 
filing.

System generated

Effective Dates 
(Section)

Requested The requested new 
business effective 
date for this filing.

Populated by a Tracker 
activity: see Working with 
Activities on page 229.

Requested Renewal The requested 
renewal date for this 
filing.

Populated by a Tracker 
activity: see Working with 
Activities on page 229.

Fee Details (Section)

Amount The amount of the fee 
being sent with the 
filing. 

Obtained automatically from 
the filing fee information 
entered.

Explanation A description or 
additional information 
about the filing fee.

Obtained automatically from 
the filing fee information 
entered.

Reference Filing 
(Section)

Field or Section 
Name Description

Data Source / Data Entry 
Instructions
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 Viewing Form Schedules
 Each enabled form in Tracker is, by default, a form schedule item for a SERFF 
filing. Tracker will pass information from the following fields to SERFF for each 
enabled form in Tracker:

• Form Name

• Form Number

• Edition Date

• Form Type: see Form Types on page 85

• Flesch Score

• Form Action

Reference 
Organization

The name of the 
reference 
organization for this 
filing.

Automatically populated with 
the Advisory Org name if a 
publication is linked to the 
filing.

Reference # The advisory 
organization filing ID 
or reference number.

Tracker leaves this field 
blank, even if a publication is 
linked to the filing. This is 
because there can be up to 
five filing reference numbers 
within a publication in 
Tracker, and Tracker cannot 
determine which of these 
numbers should apply to the 
filing. Therefore, you will 
need to manually enter the 
reference numbers. You can 
manually enter a value if no 
publication is linked.

Domiciliary 
Information 
(Section)

Status The status of the filing 
in the domiciliary 
state

Select a value from the drop-
down list.

Comments Information about the 
status of the filing in 
the domiciliary state.

Enter any details that you 
want the state to know about 
the filing in your domiciliary 
state.

Field or Section 
Name Description

Data Source / Data Entry 
Instructions



 REVIEWING SERFF FILINGS

TRACKER P&C VERSION 6.6 USER GUIDE  307

• Replaced Form # (if applicable)

• Previous State Filing # (if applicable.

If an attachment is added in Tracker, it will also be passed to SERFF.

Method: View a form schedule

1. Navigate to the filing where you want to view a form schedule.

2. Click the SERFF tab. Click the Supporting Documentation sub-tab

3. Within the Supporting Documentation sub-tab, click View Form 
Schedule.

The Form Schedule is generated and displayed in Microsoft Word. See 
Form Types on page 85 for information about how to map the Form Type 
Description to SERFF. 

Viewing Rate/Rule Schedules
Each enabled rate and rule in Tracker is, by default, a rate/rule schedule item for a 
SERFF filing. Tracker will pass information from the following fields to SERFF 
for each enabled rate or rule in Tracker:

• Document Name

• Previous State Filing Number

• Rate Change Type

• Related Form Filing Number

• Rate Increase / Decrease / Neutral

• Filing Method

• Rate Change Details

• Company name

• % Indicated change

• Written premium change for this program

• # of policyholders affected for this program

• Written premium for this program

• Maximum % Change (proposed)

• Maximum % Change (approved)

• Minimum % Change (proposed)

• Minimum % Change (approved)

• Overall Rate Information (for Company Group filings):

• New / Replacement / Withdrawn
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• Effect of Rate Filing - Written Premium Change for this Program

• Effect of Rate Filing - Number of Policyholders Affected

• Last Rate Revision

• Overall Percentage of Last Rate Revision

• Effective Date of Last Rate Revision

• Filing Method of Last Filing

Method: View a rate/rule schedule

1. In the filing, click the SERFF tab.

2. Within the Supporting Documentation tab, click the View Rate/Rule 
Schedule button.

The rate/rule schedule is generated and displayed in Microsoft Word.

Generating a Draft SERFF Filing
Before submitting the filing to SERFF, you need to generate a draft of the filing 
and review the generated filing.

Method: Generate a draft SERFF filing

After building the SERFF filing with Tracker, you will perform an Tracker 
activity to verify whether the requirements you initially downloaded from SERFF 
are still current and complete.

1. Click the Perform Activity button. 

The Perform Activity screen opens.

2. Select SERFF: Generate SERFF Filing, and click Perform.

3. The Perform Activity - SERFF: Generate SERFF Filing dialog box 
opens.
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4. Enter any relevant information into the Memo area.

5. Because this only a draft copy, do not select the Move to Filing Package 
and Submit to SERFF check box. Leave it cleared in order to generate the 
filing without sending it to SERFF.

6. Click Perform.

The Activity is processed, and if successfully completed, will be visible 
from the Activities tab. 
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Submitting Filings to SERFF

After you have generated a draft of the SERFF filing and are satisfied with it, you 
can submit it to SERFF.

Note: You can only submit individual filings to SERFF; you cannot submit filings en 
masse.

Method: Submit your filing to SERFF

1. Navigate to the filing you want to submit to SERFF, or navigate to the filing 
group and select multiple filings on the Filings or My Filings tab.

2. Click the Activities tab.

3. Double click the SERFF: Generate SERFF Filing activity you have just 
performed.

The Edit Activity-SERFF: Generate SERFF Filing dialog box opens.

4. At the bottom of the dialog box, select Move to Filing Package and 
Submit to SERFF.

5. Click OK.

Your filing is submitted to SERFF. The Filing Status is now Pending.

Note: Prior to submitting the filing to SERFF, Tracker completes PDF conversion for 
each attachment and checks the size of each. If one of the PDF attachments is 
larger than 3MB in size, Tracker displays a warning message that the filings that 
contain oversized attachments will not be submitted. If the message appears after 
attempting to submit mulitple filings, it should be noted that filings where the 
PDF attachments did not exceed the 3MB limit will be submitted. 
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Monitoring SERFF Filings and Working with 
Messages

As you work with SERFF filings and submit them to SERFF, Tracker creates and 
receives messages from the states about these filings. These messages are 
available in:

• the Top Level of Tracker

• the Log Entries subtab within a filing’s SERFF tab 

Message Types and Content
The messages that are displayed within the messages tabs at the Top Level and 
within the Log Entries tab within the SERFF tab of a filing are categorized by 
type within Tracker for easy identification. The message types are:

• Log Entries on page 311

• SERFF Status Filing Updates on page 313

• Schedule Item State Status Updates on page 314

• Note to Filer on page 315

• Objection Letters on page 315

• Reports on page 315

Log Entries
For each interaction between Tracker and SERFF, including the status updates and 
reports, a log entry is created. Log entries are maintained for each filing on the 
Log Entries tab within the SERFF tab. They represent the history of this SERFF 
filing, starting with the initial submission of the filing to SERFF. No events are 
recorded on this tab while you are working with the filing before submitting it to 
SERFF.

Log entries for all filings are available at the Top Level of Tracker, but entries on 
this tab may be removed from view.

The log entries indicate if:

• the initial filing and any subsequent correspondence was successfully 
submitted

OR
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• the initial filing and any subsequent correspondence was not successfully 
submitted, and must be resubmitted

Note: If you fail to receive a log entry when you have sent the filing or filing amendment 
or objection response, your filing may be in limbo. See SERFF — Filing in Limbo 
on page 469.

Log entries will be automatically generated when any of the following activities 
are performed:

• Submit Filing to SERFF

• Submit Note to Reviewer

• Submit Additional Fee (EFT)

• Submit Filing Amendment

• Submit Objection Response Letter
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SERFF Status Filing Updates
A SERFF status update occurs either automatically (system-generated) or from 
some action taken by the state.

Note: SERFF status updates apply to the entire filing and not at the schedule item level. 

The following table describes the types of SERFF status updates and how they are 
triggered.

SERFF Status Triggered By Description

Submitted System-generated When you perform the 
activity which submits the 
filing to SERFF, you will 
receive a status update 
message of Submitted when 
the filing is received by the 
state.

Assigned A reviewer being assigned 
by the state to work with 
this filing

When the state assigns a 
reviewer to review the filing, 
the SERFF status update of 
Assigned is triggered and sent 
to Tracker.

Pending Industry 
Response

The state sending an 
Objection Letter.

When the state sends an 
Objection Letter because of a 
problem they have found in 
your filing, a SERFF status 
update will be triggered and 
sent to Tracker, changing the 
SERFF status of the filing to 
Pending Industry Response.

Pending State 
Review

A user sending an 
Objection Response.

When a user sends an 
Objection Response in 
response to an Objection 
Letter, a SERFF status update 
will be triggered and sent to 
Tracker, changing the SERFF 
status of the filing to Pending 
State Review.
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Note: When Tracker receives a SERFF status update, it will compare the current SERFF 
status and the state status to determine if a status has changed as a result of the 
update. If there is a change, then Tracker will save the modified date for the 
change (separate date fields for SERFF status and state status since they may be 
updated independent of each other). 

Schedule Item State Status Updates
A state status update message in Tracker is triggered when the state updates the 
state status of the filing, or updates the state status of one or more schedule items. 

Unlike SERFF status update messages, which are automatically generated, when a 
state performs specific functions or creates reports, a state status update message 
is only triggered when the state manually updates the state status in SERFF. State 
status update messages inform you about the progress of the filing and/or schedule 
items as the state conducts its review.

Closed-State 
Specific Action

The state taking final action 
on the filing: approval, 
disapproval, filed, 
acknowledged, and so on.

When the state takes final 
action on a filing, they will 
create a Disposition Report 
which gives the action they 
have taken on the filing. The 
final dispositions include 
approval, disapproval, 
acknowledgment the filing as 
filed, and so on. The 
terminology can vary 
significantly from state to 
state.
When the state sends the 
disposition report, this 
automatically triggers a 
corresponding SERFF status 
update to be sent to Tracker. 
The SERFF status update 
message that is sent to 
Tracker in this instance will 
be Closed - State specific 
status.

Re-opened The state re-opening the 
filing

If the state re-opens a closed 
filing, you will receive a 
SERFF status update message 
for the filing.

Closed-Rejected The state rejecting the 
filing.

If the state rejects the filing 
you will receive a SERFF 
status update of Closed - 
Rejected. 

SERFF Status Triggered By Description
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There are no standard state status update messages. Each state has its own set of 
these messages.

Note to Filer
Note to Filer messages are created by the state and are used to communicate with 
you about some aspect of your SERFF filing. Essentially, they act as an email 
where the state can ask for:

• clarification on something in the filing

• additional information

• additional documents

Objection Letters
If the state that you submitted your SERFF filing to finds a problem with your 
filing that requires further explanation or revisions, the state may send an 
Objection Letter (previously called a Problem Report) detailing the problems they 
have found. For more information, see Viewing Objection Letters on page 255.

Reports
As of this release, there is only one type of SERFF report available: a disposition 
report. A disposition report advises the filer of the disposition of the filing, and is 
generated when the state closes a filing and changes the filing’s status to Closed 
[–State Specific] (i.e. Closed - Approved).

If the state rejects your filing, you will no longer receive a rejection report. 
Instead, you will receive a disposition report with the disposition of Closed-
Rejected.

For more information, see Viewing Disposition Reports on page 340.

Managing Messages in the Message Center
There are various ways to control and manage the various messages coming in 
from SERFF on your filings. Most of these functions apply to the My SERFF 
Messages and All SERFF Messages tabs, collectively referred to as the Message 
Center. The functionality includes: 

• Viewing messages and reports on the My SERFF Messages and All SERFF 
Messages Tabs (Top Level) on page 316

• Identifying New Messages on page 316

• Viewing Messages on page 317

• Deleting Messages (from the Message Center) on page 318
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My SERFF Messages and All SERFF Messages Tabs 
(Top Level)
As you work with SERFF filings and submit them to SERFF, Tracker both creates 
messages and receives messages from the states about these filings. These 
messages are available in:

• the Top Level of Tracker

• the Log Entries tab within the SERFF tab of a filing

Messages at the Top Level of Tracker are in the My SERFF Messages and All 
SERFF Messages tabs.

My SERFF Messages
This tab contains all SERFF messages for the filings where you are the filing 
manager.

All SERFF Messages

This tab contains all SERFF messages for filings for all users.

On the My SERFF Messages and the All SERFF Messages tabs—collectively 
called the Message Center—messages are displayed only for the number of days 
that have been configured in the SERFF Defaults. For more information, see 
Understanding the SERFF System Defaults on page 66 and Hide All Messages 
After [ ] Days on page 67.

You can also delete messages from these tabs without waiting for the specified 
display period to expire (with the appropriate permission) as described in Deleting 
Messages (from the Message Center) on page 318. 

Identifying New Messages
You can easily identify any new messages that have arrived from SERFF since the 
last time you were in the Message Center. All new messages appear in bold, and 
remain in bold until they are opened. Once you open a message, it changes to non-



MONITORING SERFF FILINGS AND WORKING WITH MESSAGES

TRACKER P&C VERSION 6.6 USER GUIDE  317

bold when you close the message or choose to go directly to the filing. Bold, 
therefore, indicates an unread message, while non-bold indicates a read message.

If a message is opened under the ALL SERFF Messages tab, it will also appear 
as unbold (read) under the My SERFF Messages tab. Similarly, if a message is 
opened under the My SERFF Messages tab, it will also appear as unbold under 
the ALL SERFF Messages. That is, the read or unread status of a message is not 
controlled on a per-user basis, but by whoever opens the message first.

Important: We strongly recommend that you only open messages that apply to your filings. If 
you mistakenly open a message for another user’s filing, you should restore the 
message to its unread status by right-clicking the message and selecting the Mark 
as Unread.

Viewing Messages
To view a message, simply double-click it. The message opens.

From this dialog box, you can perform the following procedures:

• To save the text of the message to a file, click the Save icon. You are 
prompted to enter the path name of the file to save the text.

• To print the message, click the Print icon. The message prints.

• To view the filing associated with this message, click the View Filing 
button. The associated filing opens.

• To view any attachments associated with this message, double-click the file 
name in the Attachments section.
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Deleting Messages (from the Message Center) 

You can delete messages from the Message Center. However, your ability to 
delete messages from the My SERFF Messages tab or the ALL SERFF 
Messages tab is controlled by the permission settings for the user security access 
level to which you belong.

There are two permissions: Delete My SERFF Messages and Delete All SERFF 
Messages:

• If the security access level you belong to has the permission to Delete My 
SERFF Messages, then you will be able to delete messages for filings 
where you are the filing manager.

• If the security access level to which you belong has the permission to Delete 
ALL SERFF Messages, then you will be able to delete messages for all 
filings, not just those where you are the filing manager.

• If the security access level to which you belong has neither permission, then 
you cannot delete messages for any filings. 

Important: The ability to delete SERFF messages pertains solely to deletion within the 
Message Center. A message deleted from the Message Center will still appear 
within the Log Entries tab within the filing the message pertains to and under the 
Correspondence tab in the filing.

Method: Delete a message from the Message Center

1. In the My SERFF Messages tab or the All SERFF Messages tab, select the 
message(s) you want to delete. 

To select a continuous range of messages, press and hold the Shift key, click 
the first message and then click the last message in the range of messages 
that you want to delete.

To select a non-continuous number of messages, press and hold the Ctrl 
key, then click each message which you want to delete.

2. Click the  in the toolbar.

A message appears asking if you are sure you want to delete the highlighted 
message(s).

3. Click OK to delete the message(s) or click Cancel to cancel the deletion.

Tip: If you try to delete a message and the  in the toolbar is grayed out, then your 
security level does not have the permission setting to allow deletions. Contract 
your Tracker Administrator if you think you need the ability to delete messages. 
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Working with Submitted Filings

After submitting a SERFF filing, you may need to make certain changes or 
corrections.

The procedures for working with submitted filings are as follows:

• Working with Notes to Reviewers on page 319

• Creating Revised Form, Rate, and Rule Schedule Items on page 323

•  Creating Revised Supporting Doc Schedule Items (Other Attachments) on 
page 324

• Satisfying Previously Bypassed Requirements on page 325

• Working with Filing Amendments on page 326

• Viewing Objection Letters on page 332

• Working with Objection Responses on page 334

• Viewing Disposition Reports on page 340

• Submitting an Additional EFT Payment on page 341

Working with Notes to Reviewers
A Note to Reviewer includes additional information about a previously submitted 
filing.

This section includes the following topics:

• Creating Notes to Reviewers on page 319

• Deleting Notes to Reviewers on page 321

• Submitting Notes to Reviewers on page 321

Creating Notes to Reviewers
After you have submitted a filing to SERFF, you can send a Note to Reviewer 
which includes any additional comments or information about the filing.

Method: Create a Note to Reviewer

1. Navigate to the filing where you want to create a Note to Reviewer.

2. Click the SERFF tab.

3. Click the Correspondence sub-tab.
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4. Cli
ck Note to Reviewer.

The Note to Reviewer dialog displays.

The Created On field is automatically populated.

Note: The Created On date for migrated filings will be blank.

5. Complete the Subject field.

6. Complete the Comments field with the information that you want to send to 
the state.

7. Click OK to save your changes.

The Note to Reviewer is added to the list of Correspondence with a Status 
of Draft. It is also listed on the Filing Package tab.

Important: While the system will allow attachments to be included on the NTR, you should 
not include any attachments on the NTR that belong on the schedules. 

You can now submit the Note to Reviewer.
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Editing Notes to Reviewer
You can edit a Note to Reviewer that is in Draft status

Method: Edit a Note to Reviewer

1. Within the filing containing the Note to Reviewer you want to edit, either

• click the SERFF tab and then the Correspondence subtab.

OR

• click the Filing Package tab.

2. Double-click the Note to Reviewer that you want to edit.

3. Make any necessary changes. (For field descriptions, see Creating Notes to 
Reviewers on page 319.)

Deleting Notes to Reviewers
You can delete a Note to Reviewer that is in Draft status

Method: Delete a Note to Reviewer

1. Navigate to the filing containing the Note to Reviewer that you want to 
delete, click the SERFF tab.

2. Click the Correspondence subtab.

3. Select the Note to Reviewer that you want to delete.

4. Press the Delete key or click the delete button on the Tracker toolbar.

You are asked to confirm the deletion.

5. Click Yes to delete the Note to Reviewer or click No to cancel.

Submitting Notes to Reviewers
After you have created a Note to Reviewer, you can submit it to the state.

Method: Submit a Note to Reviewer

1. Click the Perform Activity button on the toolbar. 

The Perform Activity dialog displays.

2. Select the SERFF: Submit Note to Reviewer activity.

The Perform Activity - SERFF: Submit Note to Reviewer dialog 
displays.
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3. If necessary, change the Priority for this activity.

4. Enter any relevant information in the Memo field. This is for internal use 
only.

5. Select the Move to Filing Package and Submit to SERFF check box, then 
click Perform.

If you perform the activity but do not select Move to the Filing Package and 
Submit to SERFF, the status on the Correspondence tab remains as Draft but the 
item is not editable. In order to enable editing, you will have to first delete the 
related activity, which unlocks the related item on the Correspondence tab, and 
then go in and make changes.

The Note to Reviewer is submitted. In the Correspondence tab:

• the Status of the Note to Reviewer changes to Submitted

• the date the Note to Reviewer was sent is displayed in Date Rec’d/Sent 
column 

Please note:

• The SERFF status of the filing does not change after submitting a Note to 
Reviewer.

• If the Tracker Monitor is busy processing other activities, the status of the 
Note to Reviewer will remain Queued until the Note to Reviewer has been 
succesfully submitted.
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Creating Revised Form, Rate, and Rule Schedule 
Items
Schedule items include forms, rates, and rules. If after submitting a filing, you 
discover an error in a schedule item, or if this state objects to a particular schedule 
item, you need to create and submit a revised schedule item. (You cannot change 
the original schedule item.)

To create revised Other Attachments schedule items, see  Creating Revised 
Supporting Doc Schedule Items (Other Attachments) on page 324.

Method: Create a revised form, rate, and rule schedule item

1. Navigate to the filing where you want to create the revised forms, rates, and 
rules.

2. Click the Forms, Rates or Rules tab.

3. Double-click the form, rate, or rule that you need to revise.

The form, rate, or rule opens.

4. Click the Revise button.

A copy of the form, rate, or rule is added directly below the original in the 
list.

An incremented revision number is assigned to the new form, rate, or rule 
and appears in the Rev # column.

In the original form, rate, or rule, the Enable check box on the Status tab is 
cleared. The form, rate, or rule becomes independent of the Filing Group 
level attachment, if it was not already. 

5. Make any necessary corrections to the copy of the form, rate, or rule 
attachment, including the Attachment path, then save it.

• The Status tab of a revised form, rate, or rule attachment contains a 
SERFF Details section that indicates the State Status and Public 
Access of that form, rate or rule. These fields are populated by the state 
when the state takes action.
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6. After you have created the revised schedule item, you need to submit it 
using an objection response or a filing amendment. See: Working with Filing 
Amendments on page 251 and Working with Objection Responses on page 
334. 

 Creating Revised Supporting Doc Schedule Items 
(Other Attachments)
A supporting documentation schedule item is a schedule item other than a form, 
rate, or rule schedule item. Supporting Documentation schedule items are 
maintained in a filing’s Other Attachments tab. They are also listed in the 
Supporting Documentation subtab within the SERFF tab of a filing.

If after submitting a filing, if you discover an error in a supporting documentation 
schedule item, or if the state objects to a supporting documentation schedule item, 
you will need to revise a supporting documentation schedule item.

Method: Create a revised supporting documentation schedule item 
(Other Attachment)

1. Navigate to the filing where you want to create a revised supporting 
documentation schedule item and click the Other Attachments tab.

2. Double click the Other Attachment that you need to revise.

3. Click the Revise button.

A copy of the Other Attachment is added directly below the original in the 
list.

An incremented revision number is assigned to the Other Attachment and 
appears in the Rev # column.

The Other Attachment, if it was not already, becomes independent of the 
Filing Group level attachment.

4. Make any necessary corrections to the Other Attachment, including the 
Attachment path.

The Create Revised Supporting Documentation Schedule Item check 
box is selected.

5. Click OK to save.
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6. Click the SERFF tab.

7. In the Supporting Documentation subtab, the revised supporting 
documentation schedule item is displayed immediately below the original 
entry, with a Status of Satisfied. 

The name of the revised schedule item is displayed in the Document Name/
Comments/ByPass Reason column.

All revised supporting documentation schedule items are denoted with an R 
in the Rev column on the Supporting Documentation tab.

8. To add comments to the revised schedule item, double-click it to open it, 
then enter any comments in the Comments field.

9. After you have created the revised schedule item, you need to submit it 
using an objection response or a filing amendment. See Working with Filing 
Amendments on page 251 and Working with Objection Responses on page 
334.

Related Topic

• Creating Revised Form, Rate, and Rule Schedule Items on page 323

Satisfying Previously Bypassed Requirements

Note: Supporting documentation filing requirements are referred to as requirements in 
this documentation.

If you had submitted a filing containing a requirement that was bypassed, you can 
revise the supporting doc item and satisfy the requirement.

Note: You cannot bypass a requirement that was previously satisfied.

Method: Satisfy a previously bypassed requirement

1. Navigate to the filing where you want to satisfy a previously bypassed 
requirement, and click the SERFF tab.

2. In the Supporting Documentation sub-tab, double-click the Requirement 
you want to satisfy. 

The Supporting Documentation Details dialog displays.
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3. Click the Revise button.

4. From the Status drop-down list, select Satisfied.

5. In the Comments box, enter any information about the requirement or the 
attachment.

6. Click the attachment type in Available Attachments. If necessary, expand 
the list of attachments by clicking on the  to the left of the source of 
attachments.

7. Click the attachment and click the right arrow  to move the attachment to 
the Selected Attachments list.

8. Click OK to save your changes.

The revised supporting doc item is added to the table, immediately below 
the original, identified by an R. 

Working with Filing Amendments
You can use a filing amendment to correct mistakes or omissions that you have 
discovered.

This section includes the following topics:

• Creating Filing Amendments on page 327

• Editing Filing Amendments on page 330

• Deleting Filing Amendments on page 331

• Submitting Filing Amendments on page 332
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Creating Filing Amendments
After a filing has been submitted to SERFF, you may discover that it contains 
errors or omissions, for example:

• the wrong attachment was included with a schedule item

• a schedule item was left out

• a key piece of data was missing from the filing

In these cases, you need to send the state a Filing Amendment with the revised or 
additional schedule items.

Important: Use a Filing Amendment only to correct mistakes or omissions that you have 
discovered. If the state discovers an error or omission and sends an Objection 
Letter, you need to send the revisions or additions using an Objection Response, 
not a Filing Amendment: see Working with Objection Responses on page 334.

Note: You must finish submitting one Filing Amendment before you can create another.

Method: Create a Filing Amendment

Before you can create a Filing Amendment, you first need to create any missing 
schedule items, or modify any schedule items that had errors under the Forms, 
Rates, Rules or Other Attachments tabs of a filing.

As the following procedure indicates, you need to complete extra steps if you are 
adding a new or revised Other Attachment to a Filing Amendment.

Complete the following steps to create or modify a schedule item:

1. If you are adding a revised Other Attachment to a Filing Amendment, 
complete the following steps, otherwise skip to step 2.

a. Navigate to the filing where you want to create a Filing Amendment 
with a revised Other Attachment, and click the Other Attachments tab.

b. Double-click the Other Attachment you want to revise to open it.

c. Click Revise.

d. Add attachments if required.

e. To automatically include this revision as a Supporting Doc, ensure the 
Create SERFF Supporting Doc Schedule Item check box is selected. 
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Note: If this check box is clear, the revision can be added as a Supporting Doc via the 
Supporting Documentation Details dialog (which is accessed by double-clicking 
the requirement on the Supporting Documentation subtab in the filing’s SERFF 
tab). Multiple revisions as well as original versions can be added using this 
method.

f. Click OK. 

2. Within the filing for which you want to create a Filing Amendment, click the 
SERFF tab.

3. Click the Supporting Documentation tab.

The Supporting Documentation tab displays.

4. For new Other Attachments only, complete the following steps. For all other 
attachment types, skip to step 5.

a. Click the User Added Requirement button  on the SERFF toolbar.
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b. On the User Added Requirement dialog, enter text in the Comments 
field.

c. Click the Other Attachment in the Available Attachments list. If 
necessary, expand the list by clicking on the  to the left of the source 
of attachments.

d. Click the attachment, then click the right arrow  to move the 
attachment to the Selected Attachment list.

e. Click OK.

The requirement you selected is now listed in the Supporting 
Documentation table.

You can now create the filing amendment. Continue to the next step.

5. Click the Correspondence subtab.

6. Click the Filing Amendment button.
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The Created date is automatically populated. 

Note: The Created date for migrated filings will be blank.

In the Comments field of the Filing Amendment dialog, enter any 
information you want to tell the state about the reason for the Filing 
Amendment and revised or additional schedule items.

7. Click the schedule item type in Available Schedule Items list. If necessary, 
expand the list by clicking on the  to the left of the source of attachments.

8. Click the schedule item, then click the right arrow  to move the schedule 
item to the Selected Schedule Items list.

9. Click OK to save the Filing Amendment.

The filing amendment is added to the list of Correspondence with a Status 
of Draft.

You can now submit the Filing Amendment.

Editing Filing Amendments
You can edit a Filing Amendment that is in Draft status.

Method: Edit a Filing Amendment

1. Navigate to the filing containing the Filing Amendment you want to edit, 
and click the SERFF tab.

2. Click the Correspondence subtab.

3. Double-click the Filing Amendment that you want to edit.



WORKING WITH SUBMITTED FILINGS

TRACKER P&C VERSION 6.6 USER GUIDE  331

4. Make any necessary changes. (For field descriptions, see Creating Filing 
Amendments on page 327.)

Deleting Filing Amendments
You can delete a Filing Amendment that is in Draft status.

Method: Delete a Filing Amendment

1. Navigate to the filing containing the Filing Amendment that you want to 
delete, click the SERFF tab.

2. Click the Correspondence subtab.

3. Select the Filing Amendment that you want to delete.

4. Press the Delete key or click the delete button on the Tracker toolbar.

You are asked to confirm the deletion.

5. Click Yes to delete the Filing Amendment or click No to cancel.
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Submitting Filing Amendments
After you have completed a filing amendment, you can submit it to the state.

Method: Submit a filing amendment

1. Click the Perform Activity button on the Tracker toolbar. 

2. From the list of available activities, double-click SERFF: Submit Filing 
Amendment.

3. If desired, clear the Move to the Filing Package and Submit to SERFF 
check box.

If you perform the activity but do not select Move to the Filing Package and 
Submit to SERFF, the status on the Correspondence tab remains as Draft but the 
item is not editable. In order to enable editing, you will have to first delete the 
related activity, which unlocks the related item on the Correspondence tab, and 
then go in and make changes.

4. Add an Activity Memo if required, and click Perform.

5. Read the confirmation message that displays, and click Confirm.

The filing amendment is submitted. 

In the Correspondence tab:

• the Status of the filing amendment changes to Submitted. (If the 
Tracker Monitor is busy processing other activities, the status of the 
filing amendment will remain Queued until the filing amendment has 
been succesfully submitted.)

• the date the filing amendment was sent is displayed in Date Rec’d/Sent 
column.

Note: The SERFF status of the filing does not change after submitting a filing 
amendment.

Viewing Objection Letters
If the state that you submitted your SERFF filing to finds a problem with your 
filing that requires further explanation or revisions, the state may send an 
Objection Letter (previously called a Problem Report) detailing the problems they 
have found. 

Method: View an Objection Letter

1. To open the Objection Letter, perform one of the following:

• At the Top level, click the My SERFF Messages tab.



WORKING WITH SUBMITTED FILINGS

TRACKER P&C VERSION 6.6 USER GUIDE  333

• Navigate to the filing to which the Objection Letter applies, click the 
SERFF tab and then the Correspondence tab.

• Navigate to the filing to which the Objection Letter applies, and click 
the Filing Package tab.

2. Double-click the Objection Letter.

The Objection Letter screen opens.

The Objection Letter screen contains the following information:

• SERFF Filing ID

• Date Letter Sent

• Respond By Date 

• Message text with the following information:

• Objection Letter Status

• Salutation line – populated by Tracker with the filing manager’s 
name

• Introductory paragraph

• Comments for objections – the actual objection comments and the 
schedule items to which the objection comments apply

• Closing paragraph

• Reviewer Contact Info – populated by Tracker with the names of the 
reviewers assigned to the filing; the Primary Reviewer is displayed 
first, followed by any other reviewers
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• Attachments

3. When you are done reviewing the Objection Letter, click OK to close it.

You can respond to this objection letter by creating and submitting an Objection 
Response. See: Working with Objection Responses on page 334.

Working with Objection Responses
You must use an Objection Response to respond to an Objection Letter.

The procedures for working with Objection Responses are:

• Creating Objection Responses on page 334

• Editing Objection Responses on page 338

• Deleting Objection Responses on page 338

• Submitting Objection Responses on page 338

Creating Objection Responses
Complete the following procedure to create an Objection Response.

Method: Create an Objection Response

1. Navigate to the filing that contains the objection letter you want to respond 
to and click the SERFF tab.

2. Click the Correspondence subtab.

3. From the table, double-click the objection letter.

The Objection Letter screen opens. (For more information about objection 
letters, see Viewing Objection Letters on page 255.)

4. Click Create Response.

The Objection Response dialog displays.
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The Respond By Date field, the Created field, and the name of the primary 
reviewer are automatically populated. 

Note: The Created date for migrated filings will be blank.

5. Click Create (or Edit if you editing an existing introduction) next to the 
Introductory Paragraph box.

6. Enter an introduction for this response.

7. When you are done, click OK.

The text in the Introductory Paragraph is saved.

If this was a new introduction, the Create button changes to an Edit button.

8. Click Add Response.

The Objection Response Details screen opens.
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9. In the Response Comments text box, enter your response to one more 
objections.

10. The Applies To: section contains a grid listing each of the objections from 
the Objection Letter. The first three lines of the objection are displayed in 
the list. To see the entire objection, mouse over the objection; the full 
objection appears as a pop-up.

In the Applies To: list, select the check box for each objection to which your 
Response Comments apply.

11. To affiliate schedule items with this Objection Response:

a. In the Available Schedule Items list, expand an entry by clicking the 
plus sign (+) to the left of the name.

b. Double-click a specific schedule item to move it to the Selected 
Scheduled Items list. You can also use the > and < keys to move a 
selected schedule item from one list to the other.

12. When you are done, click OK to save your work or click Cancel to exit 
without saving.

You are returned to the Objection Response screen.

13. Repeat steps 8 to 12 to respond to the next objection.

14. When you are done entering all your objection responses, click OK.
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You are returned to the Objection Response screen.

If you want to delete an existing response, select the response, then click 
Delete Response.

15. You can now view a summary of your responses. On the Objection 
Response screen, click the View Summary button.

The Objection Response Summary screen opens. (The information in this 
screen is read-only.)

In the Objections section, all the objections from the state are listed. A 
selected check box next to an objection indicates if you created a response 
for that objection.

In the Selected Schedule Items section, a list of revised or additional 
schedule items associated with the objection responses also appears.

16. After you are done reviewing this screen, click OK.

You are returned to the Objection Response screen. 

17. Click Create next to the Closing Paragraph box, or if this was a new 
closing paragraph, click Edit.

18. Enter your concluding remarks for this response.

19. When you are done, click OK to save your work.

20. Click Close to exit the Objection Response screen.

You are returned to the Correspondence tab. Your objection response is 
added to the table, directly below the corresponding objection letter, with a 
status of Draft.
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You can now submit the Objection Response. 

Editing Objection Responses
You can edit an Objection Response that is in Draft status.

Method: Edit an Objection Response

1. Within the filing containing the Objection Response that you want to edit, 
click the SERFF tab.

2. Click the Correspondence sub-tab.

The Correspondence sub-tab displays.

3. Double-click the Objection Response that you want to edit.

4. Make any necessary changes. (For field descriptions, see Creating 
Objection Responses on page 334.)

Deleting Objection Responses
You can delete an Objection Response that is in Draft status.

Method: Delete an Objection Response

1. Within the filing containing the Objection Response that you want to delete, 
click the SERFF tab.

2. Click the Correspondence sub-tab.

3. Select the Objection Response that you want to delete.

4. Press the Delete key or click the delete button on the Tracker toolbar.

You are asked to confirm the deletion.

5. Click Yes to delete the Objection Response or click No to cancel.

Submitting Objection Responses
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After creating an Objection Response and responding to all the objections in it, 
you can submit it to the state.

Method: Submit an objection response

1. Click the Perform Activity button on the Tracker toolbar. 

2. From the list of available activities, double-click SERFF: Submit 
Objection Response to SERFF.

The SERFF: Submit Objection Response to SERFF dialog displays.

3. Review the content of the activity. If required, enter comments in the Memo 
field.

4. Select the Move to Filing package check box.

5. Click Perform to submit the Objection Response.

If there is more than one Objection Response in Draft status that is ready for 
submission, then Tracker sends them all, with the oldest Objection Response 
first.

A status message for the activity is displayed. 

6. Click OK.

The Objection Response is submitted. In the Correspondence tab:

• the Status of the Objection Response changes to Submitted

• the date the Objection Response was sent is displayed in Date Rec’d/Sent 
column 

If you perform the activity but do not select Move to the Filing Package and 
Submit to SERFF, the status on the Correspondence tab remains as Draft but the 
item is not editable. In order to enable editing, you will have to first delete the 
related activity, which unlocks the related item on the Correspondence tab, and 
then go in and make changes.

Notes:

After submitting an Objection Response:

• the SERFF status of the filing changes to Pending State Action

• the Objection Response is added to the Filing Package tab

• the state revises the Respond By Date in SERFF and the system receives a 
SERFF message with the updated Respond By Date. (On the 
Correspondence sub-tab on the SERFF tab, the Respond By Date on the 
Objection Letter screen is also updated.)

• If the Tracker Monitor is busy processing other activities, the status of the 
Objection Response will remain Queued until the Objection Response has 
been succesfully submitted. 
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Viewing Disposition Reports
A disposition report is the only type of SERFF report available. It advises the filer 
of the disposition of the filing, and is generated when the state closes a filing and 
changes the filing’s status to Closed–[State Specific].

Method: View a disposition report

1. Navigate to the filing with the Disposition Report and either

• click the SERFF tab then the Correspondence subtab

OR 

• click the Filing Package tab.

2. Double-click the entry with a Correspondence Type of Disposition 
Report.

The report opens.

3. When you have finished reviewing the report, click OK to close it.

Contents of Disposition Reports
Disposition reports may include the following information:

• SERFF Filing ID

• Disposition Date

• Approved Effective Date - New Business

• Approved Effective Date - Renewal Business 

• Disposition status – this status is unique to each state; possible values are 
Closed, Closed - Approved, Closed - Disapproved, Closed - Rejected, 
Closed - Acknowledged

• Company Name 

• Maximum and Minimum Approved Rate Change for each company in 
the filing

•  % Indicated Change

• Minimum % rate increase/decrease approved for each company in the 
filing

• Overall Percentage Rate Impact

• Written Premium Change

• No. of Policyholders Affected

• Written Premium amount

• Comments

• Attachments 
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Note: Following a disposition report, the state may send status updates that change the 
Approved Effective Date for new filings and the Effective Date for renewals. You 
can access status updates via the Message Center.”

Submitting an Additional EFT Payment
If the state allows EFT payments and the company is set up for EFT, after a filing 
has been submitted with an initial check or EFT payment, the following method 
can be used to make additional EFT payments.

Method: Submit an additional EFT payment

1. Navigate to the filing where you want to submit an additional EFT payment, 
and click the Filing Fee tab.

The initial payment is shown in the Payment History Details table. 

Note: If the initial payment was by check, the Check option will also be selected. If the 
initial payment was by EFT, only the EFT option will be available.
2. Select EFT as the payment method, and click Add Payment.

The EFT Fee Allocation dialog displays.

3. Enter the Fee Amount.
4. Enter any descriptive notes in the Comments field.
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5. Click Allocate.

The fee is added to the Fee Allocation table at the bottom of the dialog.

Note: If the fee amount you enter exceeds the maximum allowed for your EFT 
authorization level, a message will be displayed. In this case, you will not be able 
to proceed with the EFT payment for this filing. You will need to contact your 
Tracker Administrator to continue, or you will need to have another user with the 
appropriate EFT authority level complete the EFT information.
6. Click OK to save your work.

The filing fee you entered is displayed in the Payment History Details table 
at the bottom of the Filing Fee tab. (For more information about this table, 
see Viewing EFT Transaction Information at the Filing Level on page 294.)

7. Perform the activity SERFF: Submit Additional Fee.

Tracker submits the additional EFT payment via SERFF

Tip: You can use this method if your initial payment was by check and you decide to 
switch to using EFT instead before you send the check. Since Tracker has no way 
of knowing that the initial check was not sent, you should delete the check 
payment manually. 
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Working with Closed Filings

 For a filing that has a SERFF status of Closed, you can send a Note to Reviewer or 
receive a Note to Filer.

Sending a Note to Reviewer
For a filing that has a SERFF status of Closed, you can still create and submit a 
Note to Reviewer, if the state allows you to. You may need to do this, for example, 
if:

• the state rejected the filing and you want to ask the state to reopen it

• the state closed the filing with a status of disapproved because you failed to 
respond to an objection letter or request within the require time frame, and 
you want to reopen the filing to respond

• you want to amend the implementation date

• you need to change the Requested Effective Dates

Method: Create a Note to Reviewer on a closed filing

1. Navigate to the filing where you want to create a Note to Reviewer.

2. Click the SERFF tab.

3. Click the Correspondence sub-tab.

4. Click Note to Reviewer.

The Note to Reviewer dialog displays.
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5. Complete the Subject field.

6. Complete the Comments field with the information that you want to send to 
the state.

7. Click OK to save your changes.

The Note to Reviewer is added to the list of Correspondence with a Status 
of Draft. It is also listed on the Filing Package tab.

To submit the Note to Reviewer, see Submitting Notes to Reviewers on page 321.

Receiving a Note to Filer
For a filing that has a SERFF status of Closed, you can still receive a Note to Filer 
from the state.

An unread Note to Filer will be displayed in bold in the My SERFF Messages 
tab, as highlighted below:

 Related Topics

• Note to Filer on page 315

• Managing Messages in the Message Center on page 315
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Filing Summary for SERFF Filings

The Filing Summary is an excellent way to generate a comprehensive snapshot for 
SERFF filings. (For information on Filing Summary for paper filings, see Filing 
Summary for Paper Filings on page 452.)

There are two parts of the Filing Summary that can be optionally displayed and 
printed: Filing Details (both single company and CG versions), and Filing 
Correspondence.

This section contains:

• Filing Detail (SERFF Filings) on page 345

• Filing Correspondence on page 348

• Generating a Filing Summary on page 348

Filing Detail (SERFF Filings)
The Filing Detail part of the Filing Summary displays detailed information about 
the selected filing. The SERFF Filing Details tab displays most of this 
information.

In the header:

• SERFF Tracking Number

• State

• Filing Company

• State Tracking Number

• Tracker Filing ID or Company Reference # 

• TOI

• Sub-TOI

• Program Name (based on what was sent to SERFF or is in the Program 
Name field at the time the Filing Summary is generated)

• Project Name/Number (based on what was sent to SERFF or is in the 
Project Name/Number field at the time the Filing Summary is generated)

In the Filing Overview section:

• Company Name and Company Code

• Program Name (based on what was sent to SERFF or is in the Program 
Name field at the time the Filing Summary is generated)

• SERFF Tracking ID

• State

• TOI - include numbering & TOI name

• SERFF Status 

• State Tracking Number
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• Sub-TOI 

• Tracker Filing ID or Company Reference # 

• State Status

• Filing Type (based on what is selected when TOI/SubTOI selection made)

• Tracker Status

• Reviewer(s)

• Author (based on the Filing Manager)

• Disposition Date 

• Date Submitted (date successfully submitted filing via SERFF)

• Disposition Status

• Requested Effective Date

• Approved Effective Date

• Requested Renewal Effective Date

• Approved Renewal Effective Date

In the General Information section:

• Project Name (based on what was sent to SERFF or is in the Project Name 
field at the time the Filing Summary is generated)

• Status of Filing in Domicile

• Project Number (base on what was sent to SERFF or is in the Project 
Number field at the time the Filing Summary is generated)

• Domicile Status Comments

• Reference Organization (based on what was sent to SERFF or is in the 
Reference Organization field at the time the Filing Summary is generated) 

• Reference Number (based on what was sent to SERFF or is in the Reference 
Number field at the time the Filing Summary is generated)

• Reference Title – Publication

• Advisory Org. Circular – Publication

• SERFF Status Changed (date)

• State Status Changed (date)

• Deemer Date

• Tracker Status Changed (date)

• Related Filing ID (number and type)

• NAIC Filing Description

In the Company and Contact section:

• Filing Contact Information:
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• Filing Manager Name

• Filing Manager Title

• Filing Manager Email Address

• Filing Manager Address

• Filing Manger Phone Number 

• Filing Manager Fax Number

• Filing Company Information:

• Company Name

• NAIC Company Code

• State of Domicile

• Company Address

• NAIC Group Code

• Company Type

• Group Name

• State ID Number

• Company Phone Number 

• FEIN Number 

In the Filing Fees section, these fields display if required:

• Fee Required

• Fee Amount

• Retaliatory

• Fee Explanation

• Per Company

• Check Number

• Check Amount

• Check Date

• Company

• Amount

• Date Processed

• Transaction #

In the State Specific section:

• State Specific information
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Filing Correspondence
The Filing Correspondence section of a Filing Summary contains two parts: the 
Summary part, and the Filing Correspondence Details part.

The Summary part contains five sections:

1. Filing Correspondence

• Filing Correspondence Description

• SERFF Filing ID 

• Date

2. Supporting Documentation

• Requirement

• Status

• Rev

• Document Name(s)/Comments/Bypass Reason

• State Status

3. Public Access

• Public Access 

• Filing Package

• Request Conf

• Status

4. SERFF Form Schedule 

5. SERFF Rate/Rule Schedule 

The Filing Correspondence Details part contains the detail for each activity 
listed in the above Summary. Each activity’s detail is followed by the attachment 
from the activity’s Attach File field (if present), then the rest of the activity’s 
attachments (documents).

Generating a Filing Summary
Any user can generate a Filing Summary by following these steps.

Method: Generate a Filing Summary

1. To generate a Filing Summary for one filing, navigate to the Filing level for 
the desired filing.

OR

To generate a Filing Summary for multiple filings in a filing group, navigate 
to the Filing Group level for the desired filing group and multi-select the 
desired filings.
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2. Click the Filing Summary button on the tool bar.

The Filing Summary dialog displays.

3. Select the desired options for the Filing Summary. At least one option must 
be selected.

4. Click Generate Summary.

The system generates and opens the PDF documents (1 for each filing 
selected).
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Chapter 9
Understanding Filing Letters

This chapter deals with letters in Tracker and how to work with them.

A filing letter is composed of a number of elements. Most of them are generated 
automatically by the Tracker system. You must enter additional information 
during the filing preparation process.

Before creating a filing letter, you should have finished entering all the rate, rule, 
and form information for the filing, and all filing comments (see The Comments 
Tab on page 213 for details). If, after creating and previewing the letter, you 
become aware of missing elements or discrepancies, you can go back to the filing, 
make any necessary changes or additions, and generate the letter again.

This chapter describes:

• Available Letter Types on page 352

• Filing Letter Comments on page 354

• Creating Letters on page 356



UNDERSTANDING FILING LETTERS

352 TRACKER P&C VERSION 6.6 USER GUIDE

Available Letter Types

The following types of filing letter are described:

• Long Filing Letter on page 352

• Alternate Long Filing Letter on page 352

• Short Filing Letter on page 352

• Follow-Up Filing Letter on page 352

• Correspondence Letter on page 352

• Withdrawal Letter on page 352

• Objection Letter on page 353

Long Filing Letter
The long filing letter is lengthy and comprehensive. It is used for the initial filings.

Alternate Long Filing Letter
The alternate long filing letter is a slightly different version of the long version 
described above.

Note: When you begin using Tracker, experiment with the letter generation function and 
generate samples of each so that you become familiar with each of the various 
letter formats, and can use the letter that suits your needs best for each filing 
situation.

Short Filing Letter
The short filing letter is short and to the point. It is used for simpler filings, such as 
informational filings.

Follow-Up Filing Letter
The follow-up letter is a form letter used to follow-up on outstanding filings.

Correspondence Letter
The correspondence letter is used for communicating with State Departments of 
Insurance regarding filings that have already been submitted and are pending 
approval.

Withdrawal Letter
The withdrawal letter is used for indicating to a State Department of Insurance 
regarding that you want to withdraw a previously submitted filing.
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Objection Letter
The objection letter is used to reply to a State Department of Insurance following 
the receipt of an objection about a submitted filing. For more information, see 
Viewing Objection Letters on page 332.
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Filing Letter Comments

Depending on what has been specified in your filing, you may need to enter some 
of the following comment information as part of the filing letter creation process.

• General Forms Comment

Use this comment to make a statement about the forms and endorsements 
included in the filing.

• Rule Comments

Use this comment to make a statement about the rules included in the filing.

• Rate Comments

Use this comment to make a statement about the rates included in the filing.

• General Closing

You can include a general closing statement in your filing letter to 
summarize comments made in the body of the letter or to add information 
such as an appeal for fast approval. This statement precedes the final 
statement in the letter. The final statement, which includes your phone 
number, is generated automatically.

• Certification of Compliance

Use this comment section to enter a Certification of Compliance statement if 
required. Certification statements are state-specific. Your submission may or 
may not require that one be included in a filing letter. Even if one is not 
required, you may decide to include a certification statement as an assertion 
that the letter is in compliance with state regulations and laws.

• Attachment

Use this comment section to list any attachments that are being included 
with this filing, such as special exhibits, actuarial displays, filing 
memorandums, and so on

• Filing Fee Comment

Use this comment section to note whether a filing fee accompanies the 
filing, and if so, in what form and amount. Many states require that a fee 
accompany each filing submission; this information can be found in the 
Regulatory Specialist section of your Tracker system.

• Special Language

Use this comment section to enter any state-specific or state-required 
language. Examples are specific legal text, or text that needs to be translated 
into a language other than English to meet state filing requirements.
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Note: See The Comments Tab on page 213 for more information.
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Creating Letters

You should ensure that all rate, rule, and form information and all filing letter 
comments (see The Comments Tab on page 213 for details) have been completed 
in the filing record before generating the filing letter.

Note: Filing letters will usually be generated as part of the Generate Complete Filing 
activity, so it is not required that the Generate Letter activity be performed before 
the Generate Complete Filing activity.

Method: Create a letter

1. Navigate to the filing where you want to create a letter.

2. Click the Perform Activity toolbar button  to open the Activity List 
box.

3. Select the Generate Letter activity (or another of the letter-generating 
activities; see Standard Tracker Activities on page 232 for details).

4. Click Perform to open the related new Perform Activity dialog box.

5. Enter information in the applicable fields:

• Use the Description field to enter a brief description of the activity 
(such as “draft long filing letter”).

• The Date field will automatically be filled in with today’s date.

• The Performed By field will automatically be filled in with your name.

• Indicate the Priority of the activity by clicking in one of the Low, 
Medium, or High selection buttons (the default priority is Medium).

• Select the required Letter Type from the drop-down list to the right of 
the field.

• Click or un-click the View, Print, Draft, and Print One Copy 
checkboxes as required.

If you check the View checkbox, the generated letter will be presented 
in a native application (such as Microsoft Word) window for viewing 
(you may then use Word’s print command to print the letter, if desired).

If the Print checkbox is checked, the letter will automatically be printed 
following generation.

If you check the Draft checkbox, the letter will be generated, but will 
not be saved for future viewing in the activity record.

If you check the Print One Copy box, only one copy of each document 
in the letter will be printed.
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Use the View/Draft check combination to generate and preview draft 
filing letters. If you want to generate and save a letter, and have it 
generate and print as part of the final Complete Filing generation, make 
sure that you un-check the Draft option.

Generated (non-draft) letters will be saved, and will be accessible later 
from the activity detail record.

6. Click Perform. The filing letter is generated. During the generation process, 
a Document Generation window appears, tracking the generation in 
progress.

7. The document will then open in Microsoft Word (if specified). Here you can 
view and print the filing letter, as required.

Warning: Editing a Filing Letter: Changes made to a generated letter in Microsoft Word 
will not be saved, and will not appear in any final generation of the complete 
filing.

If you want to make changes to a generated letter, do so while the word 
processor window is open and then select Save As from the File menu to 
save the changed letter document file to a location on your hard drive or 
system.You can then replace the letter in the Edit Activity window. Click 
Replace and choose the file. 

8. If it is open, close the Microsoft Word document window.

9. Click OK to finish.

The activity will be saved and listed on the filing’s Activity tab. The letter 
will remain available via the corresponding activity detail record.
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Chapter 10
Working with Publications

In Tracker, the term publication refers to all bulletins, circulars and legislative 
documents issued by state insurance departments, and related regulatory bodies 
and advisory organizations such as the ISO (Insurance Services Office) or the 
NCCI (National Council on Compensation Insurance)

This chapter introduces you to the Tracker publications tracking function, and 
describes how to enter new publications into the system, and how to work with 
them to create filings and monitor your filing processes.

This chapter describes:

• The Main Publications List Window on page 360

• Adding New Publications on page 362

• Adding (Removing) States for an Existing Publication on page 364

• The Publication Record on page 365

• Creating a New Filing from a Publication Record on page 369

• Linking Publications to Filings on page 371

• Adding a Copy of a Publication on page 373

• Publication Reports on page 374
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The Main Publications List Window

The Main Publications list window is your access point to all the publication 
currently in your Tracker system. This screen is composed of two main elements: 
a Publications tab listing all the publications in the system, and an upper field 
display.

Note: To access the Publications list window, on the menu bar, select View > 
Publications.

When a publication listed on the Publications tab is selected or highlighted, basic 
information relevant to that publication appears in the publication header. This 
provides you with a quick method of browsing through and viewing information 
pertaining to the publications in your system.

You can browse through the other Publication details records in the system by 
going to any one record and going back and forward through the records using the 
Back and Forward buttons.

From the main Publications list window, you can access detailed information 
about any single publication in the system by double-clicking on that publication 
on the Publications tab.

Note: See also The Publication Details Tab on page 365.

This chapter also describes:

• Adding New Publications on page 362

The Suspended Button
At the Filing Group level and on the Publications list window, a Suspended 
button appears on the right-hand side of the screen above the tabs. It is used to 
show only those records having a future dated (or Suspended) activity associated 
with them. This helpful feature allows you to view only those records which 
require your immediate attention, rather than having to sift through hundreds or 
thousands of records to find the ones you want.
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The Suspended button is activated if it is depressed (so that it appear to be pushed 
in). It can be activated or inactivated by clicking on it with your mouse (one click, 
another click off). When you log in to Tracker, or access the filing group or 
Publications sections of the system, the Suspended button is always activated by 
default. You will need to remember to check it, and unclick it (deactivate it) when 
you are at these levels if you want to see any newly added or non-suspended 
records in the system.
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Adding New Publications

The following method describes how to add new publications.

Method: Add a new publication

1. At the Top, Filing Group, or Filing level, select Insert > Publications from 

the menu bar, or click the Publication button on the Tracker toolbar. 

The New Publication dialog displays.

2. On the New Publication dialog, enter the following information:

• The Publication Number

• The Publication Date (the date on which the publication was issued)

• The Organization that issued the publication

• The filing Content Type to which the publication applies (Loss Cost/
Rate, Rule, or Form)

• The Type of publication (Line Circular, Premium Comparison, 
Statistical Plan)

• The Status of the publication (Administrative, Advisory, Approved, 
Filed, To Be Effective)

• The Line of Business to which the publication applies

• A brief Description of the publication

• The State(s) for which the publication applies. Note that the States field 
allows the selection of multiple states.

3. When finished, click OK. 
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The new publication record will be added to your Publication list window, 
and a related Publication Details record will now be available.
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Adding (Removing) States for an Existing 
Publication

The following method describes how to add or remove states for an existing 
publication.

Method: Add or remove states for an existing publication

1. On the Publication Details main screen, select Insert > Edit States.

The Add States dialog displays.

2. From the Available States list field, select the states which you want to add 
to this publication record, using the left and right Move/Move All buttons.

OR

From the To Add list field, select the states which you want to remove from 
this publication record, using the directional move buttons.

3. Click OK to close the dialog box and save your changes.
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The Publication Record

There is a detailed Publication dialog for every publication record in your 
Tracker system. Each of these dialogs have four tabs:

• Details, with a set of detailed information about the publication record. See 
The Publication Details Tab on page 365.

• Links, with a list of other/previous publications in Tracker linked to this 
publication. See The Publication Links Tab on page 366.

• Filing References, with a list of Filing References (linking this publication 
to its resultant filings.) See The Publication Filing References Tab on page 
367.

• Activities, with a list of activities performed in relation to this particular 
publication record. See The Publication Activities Tab on page 368.

The Publication Details Tab
The Publication Details tab contains fields where detailed information regarding 
the publication can be stored.
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Entering and Editing Publication Detail Information
The following information can be added or changed at any time following the 
creation of the publication record:

• The Received Date indicating the date on which your company received the 
publication.

• The Rate Effective Percent as prescribed by the publication.

• An Attachment pertinent to the publication (such as an electronic version 
of the actual publication). You can type in the desired path (to a maximum of 

255 characters), or browse (using the  button) to select the path of the 
attachment. After specifying a path you can later double-click in the 
attachment field to open the attached document.

• The Advisory Organization’s Proposed Effective Date for the contents of 
the publication.

• The Advisory Organization’s Approved Effective Date for the contents of 
the publication.

• Four custom User Date fields, which can be customized to suit the needs of 
your company. See Performing Custom Table Tasks on page 87 for details.

• Five Advisory Organization Numbers.

Note: Click the Save button when you have finished adding or editing the publication 
detail information to ensure that your information is saved.

The Publication Links Tab
The Links tab lists publications which have been linked to the current publication. 
Publications are generally linked if they are strongly related, have a bearing on 
one another, or are parts of a series of publications (a new publication record 
which replaces an old one would be linked to its predecessor).
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Adding a Publication Link
To create a link between one publication and another publication in the system, 
use the following method.

Method: Add a publication link

1. Open the detailed dialog for the Publication where you want to create a link 
and click Insert > Add New Link.

The Linking Publication dialog displays.

2. In the Link to Publication # field, enter the publication number of the 
publication to which you want to link, or click Search to search for the 
desired publication number in the system.

3. Click Next to open a new Link Publication dialog box if you want to link 
another publication to the current one,

OR 

Click OK to finish.

All specified links will be created and the dialog closes.

The Publication Filing References Tab
The Filing References tab lists all of the filings which have been created from, or 
in reference to, this publication. From here, you can access the filing details for 
each filing listed.

Note: Any filings that are linked to a publication will automatically be listed on the 
Filing References tab.

A filing referenced by a publication can be displayed by locating the filing on the 
Filing References tab, and double-clicking it. The filing’s dialog displays.
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The Publication Activities Tab
In the Tracker system, an activity is any action related to or performed upon a 
filing group, filing, or publication record. This can be anything: from the creation 
of a memo or a note to yourself; the recording of a phone call to or from a state 
insurance department; or the generation of a filing. All can be recorded and kept 
as a history within the activity function. The publication level activity functions 
are composed primarily of passive, information tracking and communication 
activities.

For complete instructions about performing, posting, and working with the 
Tracker Activity function, please see Working with Activities on page 229.

The Publication level Activities tab lists all activities that have been performed 
upon (or are pending performance upon) this publication record. From this tab 
you can access the activity details for any of the activities listed.
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Creating a New Filing from a Publication Record

You can create a new filing or filings directly from within a Publication dialog. 
When a filing is created this way, Tracker automatically adds that filing to the 
publication’s Filing References tab, and adds the publication record to the new 
filing’s Publication tab.

Method: Create a new filing from a publication

1. From a Publication dialog, click the New Filing(s) button  to open the 
Select Filing Group dialog box.

2. Select an existing filing group from the list, and click OK to open the New 
Filing(s) dialog. Go to step 7.

OR

To create a new filing group, click New to open the New Filing Group 
dialog.

3. Select a Program Name from the drop down list.

4. Check the Filing Group Code to see that it is what you want. If it is not, 
click in the Override check box and enter the filing group code you want.

5. Check that the filing group Name is what you want; change it if necessary.

6. Enter a filing group Description, Manager, and Date.

7. Click the New Filing(s) button to open the New Filing(s) dialog.
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8. Enter the required information for the filing: Description, Date, Filing 
Type, Filing Manager, and Content Type (check Rate, Rule, Form, or a 
combination). 

Note: The Content Type, Line of Business, and State(s) information will be pre-
selected according to the information in the originating publication record; you 
may alter this if necessary.

9. From the Available list field on the left, choose the desired company/state/
line of business combination(s) for this filing using the left and right 
movement buttons. 

The selected combination(s) appears in the Queued for Filing field.

10. When you are satisfied with all the information displayed, click Create. 

A status box will open to display the filing creation process as it progresses; 
when the status box indicates that the process is done, click Close. The 
newly created filing(s) appear in the Filing Reference tab of the publication 
from which they were created, and the information for the publication 
appears in the related filing(s)’ Publication tab.
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Linking Publications to Filings

The following method provides the instructions for linking a publication to an 
existing or new filing. Completion of these steps permits the Reference 
Organization and Reference # information to be passed to the applicable 
Department of Insurance with the SERFF filing.

Method: Link a publication to an existing or new filing

1. Navigate to the filing you want to link to a publication.

2. Click View > View Publications.

3. If you do not see any publications listed on the Publications tab, click 
Suspended.

4. Double click on the applicable publication.

5. To add a filing reference to an existing filing: 

a. Click Insert > New Filing Reference.

The New Filing Reference dialog displays.

b. In the Filing Number text box, type in your complete filing number. If 
you do not know the filing number, click Search and search for your 
filing. When you double-click a filing in the Search Results, the Search 
window closes and the filing number automatically populates the Filing 
Number text box.

OR

To add a filing reference and create a new filing:

a. Click Insert > New Filing Reference.

The Select Filing Group dialog displays.

b. To use an existing filing group, select filing group from the list, click 
OK, and follow the steps in  Adding New Filings on page 126, beginning 
at step 2.

OR

To create a new filing group, click New and follow the steps in Adding a 
New Filing Group on page 120, beginning at step 2.

6. Click Next to add additional filing references to this publication, or OK to 
exit.

The publication’s Filing References are shown on the Filing References tab 
of the publication’s window. 

A filing with publications will have a Publications tab where the 
publications are listed.
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Once the publication has been linked to your filing, you can update the Reference 
# field located in the Referencing Filing section of the SERFF Filing Details 
subtab on the SERFF tab. Use the default Reference Organization or overwrite 
with your own value.
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Adding a Copy of a Publication

Often a publication will be sent that simply updates or revises an existing 
publication. Tracker allows you to update and link series of publication records 
quickly and easily using the Copy Publication function. The information from the 
old publication record is copied to a new publication record under the new 
publication number, and the records are linked for easy tracking and referral. Any 
necessary changes can then be made to the new record and then saved in the 
system.

Method: Add a new version (copy) of an old publication

1. On the Publication list window, select the publication you want to copy and 
click Insert > Copy Publication, or click the Copy Publication button on 

the toolbar. 

The Publication dialog displays.

2. Enter the Publication Number of the new publication.

3. Check the Create Link? check box to create a link between the old 
publication and the new one. The new publication will be linked to the old 
one and will also carry any additional links or filing references that the old 
publication did.

4. Click OK.

The new Publication Details screen opens.

5. Make any changes to the information on the new Publication Details 
record, as required, and click Save to save the new record.
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Publication Reports

There are two standard reports in Tracker which you can use to better keep track 
of the publications in your system: the Publications Details Report under the 
Status tab, and the Publications Summary Report under the Historical tab. For 
more information on using the Tracker reports functions, please see Searching, 
Reporting, and Filing Summary on page 423.
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Chapter 11
Working with Filing Profiles

This chapter describes how to work with filing profiles sent from Launcher into 
Tracker.

This chapter contains information about:

• Understanding Filing Profiles on page 376

• Viewing the Lists of Filing Profiles on page 377

•  Viewing and Editing Filing Profiles in Tracker on page 379

• Accepting, Suspending, or Rejecting Filing Profiles on page 396

Note: For information about how to create a project in Launcher, see the Launcher User 
Guide and Launcher Online Help.
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Understanding Filing Profiles

Filing profiles involve Tracker and Launcher, a separate application. Launcher is a 
collaborative product development application available separately from Oracle.

Filing profiles are used to pass filing information and attachments (forms, rates, 
rules, and other supporting documentation) from Launcher into Tracker and then 
initiate one or more filings in Tracker.

Using Launcher and filing profiles is faster and easier than using Tracker to 
manually enter the required filing information and add the attachments. Instead, 
filings are already automatically set up when the filing profile is accepted in 
Tracker.

Filing profiles are listed in the My Profiles and All Profiles tabs: see Viewing the 
Lists of Filing Profiles on page 377.

Overview of the Filing Profile Process
The following diagram gives an overview of filing profile process in Tracker and 
Launcher:

1. A Launcher user creates a new filing profile in a Launcher project.

2. A Launcher user submits the filing profile to Tracker.

3. A Tracker user reviews the filing profile information, making any necessary 
changes.

4. If the Tracker user thinks the filing profile contains problems, the user can 
reject the filing profile and send it back to Launcher for further review and 
changes. The Launcher user then sends the filing profile back to Tracker.

Steps 2 through 4 repeat until all the filing profile issues have been resolved.

5. Once the filing profile is ready, and after all the required filing profile 
information has been completed, the filing profile can be accepted, and the 
final filing information can be entered.
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Viewing the Lists of Filing Profiles

Note: You can view and work with filing profiles only if you have been given the 
required permission by your Tracker Administrator.

The My Profiles and All Profiles tabs list all the active filing profiles that have 
been sent from Launcher into the filing queue in Tracker.

Note that:

• the My Profiles tab displays only the filing profiles in the queue that you are 
associated with

• the All Profiles tab displays all the filing profiles in the queue

You can view any filing profile using these two tabs.

Method: View the lists of filing profiles

1. Log in to Tracker.

The My Profiles and All Profiles tabs appear at the top level.

2. To view a list of all of the submitted filing profiles affiliated with your user 
profile, click the My Profiles tab.

3. To view a list of all the submitted filing profiles in the system, click the All 
Profiles tab.

Tip: You can use the drop-down menu to View All the profiles or view only the 
Unassigned and Outstanding profiles.

Note: If several minutes have passed after you have displayed the My Profiles or All 

Profiles tab, click the refresh button  to ensure that you are viewing the 
current list of filings.

Note that on both the My Profiles and All Profiles screens:

• the number of New, Suspended, Outstanding, and Unassigned profiles are 
displayed at the top of each screen

• filing profiles are listed in reverse chronological order, with the newest 
filing profiles listed first

• new and unviewed filing profiles are displayed in bold
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• after you view a filing profile, it is no longer displayed in bold, except if 
your security access level is only View Filing Profiles, in which case the 
filing profile remains bold even after you view it

Related Topics
• Fields on My Profiles and All Profiles Tabs on page 378

• New Filing Profile Notification on page 378

•  Viewing and Editing Filing Profiles in Tracker on page 379

• Understanding Filing Profiles on page 376

• Accepting, Suspending, or Rejecting Filing Profiles on page 396

Fields on My Profiles and All Profiles Tabs
The following fields appear on the My Profiles and All Profiles screens:

• Date Received – the date and time the profile arrived into Tracker from 
Launcher

• the Type of filing profile – this can be I (Initial) or N (New); for details, see 
Filing Profile Types on page 380

• the Filing Description from Launcher – to see the entire description 
displayed as a tooltip, place your cursor over this field

• the most recent Comments entry from Launcher for the filing profile – to 
see the entire comment displayed as a tooltip, place your cursor over this 
field

• the Status of the filing profile: New, Suspended, Outstanding or 
Unassigned

New Filing Profile Notification
If Tracker receives a new profile from Launcher for any user, the filing profile 
icon changes to:

If you click this button, the icon reverts back to the “No new profile(s) in queue” 
icon.

Method: View new filing profiles

Click the My Profiles tab. If you were already viewing this tab, click the refresh 

button  to ensure that all filing profiles are displayed.

Any recently arrived filing profiles that are affiliated with you will be displayed.
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 Viewing and Editing Filing Profiles in Tracker

If you have been given the required permission by your Tracker Administrator, 
you can accept, reject and suspend filing profiles. Otherwise, you can only view 
filing profiles.

Please note:
• There are two types of filing profiles: New and Initial. You can only edit 

certain fields in each type. For more information, see Filing Profile Types on 
page 380.

• Mandatory fields are indicated with an asterix (*). Ensure that you have 
completed these fields on all tabs and any secondary dialog boxes, otherwise 
you will not be able to save your work.

Viewing and editing filing profiles involves:

• Viewing Filing Profile Details on page 381

• Viewing Companies, LOBs, and States on a Filing Profile on page 382

• Working with Filing Profile Comments on page 384

• Working with Program/Filing Group Information on a Filing Profile on 
page 388

• Working with Filings on a Filing Profile on page 390

Related Topics
• Viewing the Lists of Filing Profiles on page 377

• The Process Filing Profile Dialog on page 379

• Understanding Filing Profiles on page 376

• Accepting, Suspending, or Rejecting Filing Profiles on page 396

The Process Filing Profile Dialog
When you open a filing profile, the Process Filing Profile dialog displays. You 
use this dialog to view or edit filing profile information.
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The Process Filing Profile dialog contains the following tabs:

• Details 

• Program/Filing Group Setup

• Filing Setup

Related Topics
•  Viewing and Editing Filing Profiles in Tracker on page 379

• Understanding Filing Profiles on page 376

Filing Profile Types
There are two types of filing profiles: Initial and New. You can edit more 
information in an Initial filing profile than a New one.

Initial Filing Profile Type (I)
An initial filing profile is the first filing profile that has been sent to Tracker from 
a Launcher project. Tracker has not yet accepted this profile for the project.

The letter I in the Type column on the My Profiles and All Profiles tabs indicates 
an Initial filing profile.
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New Filing Profile Type (N)
A New filing profile is any subsequent filing profile that has been sent to Tracker 
from a Launcher project. This project would already contain an initial filing 
profile.

The letter N in the Type column on the My Profiles and All Profiles indicates an 
New filing profile.

Viewing Filing Profile Details
You can view (and in some cases, edit) filing profiles received from Launcher if 
you have been given the required permission by your Tracker Administrator.

While working with a filing profile, you can Accept, Suspend, or Reject it. For 
details, see Accepting, Suspending, or Rejecting Filing Profiles on page 396.

Method: View the details of a filing profile

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.
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2. On the Details tab, in the Filing Profile section, the following fields are 
displayed:

• Type: indicates whether this is an Initial or New filing profile: see 
Filing Profile Types on page 380 for details

• Level: the level of the filing profile: this will be Filing Group

• Initiator: the user in Launcher who initiated this filing profile

• Description: a description of the filing profile

Viewing Companies, LOBs, and States on a Filing 
Profile
The CLS table on the Details tab of a filing profile lists combinations of 
Company, LOBs and States that apply to that filing profile. (CLS is a short form 
for Company, Line of Business, and States.)

Method: View a CLS combination on a filing profile

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.

2. On the Details tab, in the CLS section, double-click a CLS combination in 
the table, or highlight a CLS then click View CLS.
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The View CLS dialog box opens. This dialog box contains two tabs: 
Attachments and Dates.

CLS – Attachments Tab
The Attachments tab on the View CLS dialog box in a filing profile displays the 
Company, LOB, and States.

The Attachments tab also displays the following information for both Filing 
Group Level Attachments and Filing Level Attachments:

• Number Type – you must select Form # or Advisory Form #

• Content

• Form/Rate/Rule Number

• Title

• States

CLS – Dates Tab
The Dates tab on the View CLS dialog box in a filing profile displays the 
Company, LOB, and States.
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The Dates tab also displays Dates and States for the following dates:

• Requested Effective Date

• Requested Renewal Effective Date

• Custom Dates

Working with Filing Profile Comments
You can work with filing profile comments if you have been given the required 
permission by your Tracker Administrator.

A filing profile comment can include the reasons why a filing profile was rejected 
in Tracker.

Working with filing profile comments involves:

• Viewing Filing Profile Comments on page 384

• Adding Filing Profile Comments on page 386

Viewing Filing Profile Comments
The Comments table on the Details tab of a filing profile displays a list of 
comments with the following information:

• the text of the Comment

• the User who created the comment
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• the Launcher Group the user belongs to (if the comment was entered in 
Launcher)

• the Date/Time the comment was created

Method: View a filing profile comment

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.

2. Click the Details tab.

3. In the Comments section, double-click a comment. Alternatively, highlight 
a comment, then click View Comment.

The comment is displayed. (You cannot edit this comment.)
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4. When you are done viewing this comment, click OK.

Adding Filing Profile Comments
You can a comment to a filing profile if you have been given the required 
permission by your Tracker Administrator.

Method: Add a comment

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.
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2. Click the Details tab.

3. Click Add Comment.

4. In the Add Comment dialog box, enter a comment. There is a 4,000 
character maximum.

Important: Enter your comments carefully. You cannot change or delete your comments after 
you have entered them.

5. Click OK to save the comment, or click Cancel to discard your comments.
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Working with Program/Filing Group Information on a 
Filing Profile
You can work with Program/Filing Group information if you have been given the 
required permission by your Tracker Administrator.

Method: Open the Program/Filing Group Setup dialog box

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.

2. Click the Program/Filing Group Setup tab.

The Program/Filing Group Setup dialog displays.
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For field descriptions, see Program/Filing Group Setup Fields.

Program/Filing Group Setup Fields 
The Program/Filing Group Setup contains the following sections:

• Program Section on page 389

• Filing Group Section on page 390

• Filing Section on page 390

Program Section
This Program section contains program information that applies to all the filings 
in this filing profile. 

This Program section contains the following fields:

• the Program Type indicates whether this is an Existing Program or a New 
Program
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• the name, Code and Description of the Program

Filing Group Section
The Filing Group section contains information that applies to the filing group in 
this filing profile.

The Filing Group section contains these fields:

• the Filing Group Type indicates whether this is an Existing or New filing 
group

• the Filing Group field contains the ID and Description of the filing group

• the filing group Description, Name, Manager, and Date received from 
Filing profile

• the Custom field that has been previously configured

• the Filing Group # – if the Override box is not selected, Tracker 
automatically assigns a Filing Group #; alternatively, you can select the 
Override box and enter a Filing Group # manually

• the NAIC Filing Description – the description entered here will be applied 
to all the filings in this filing group

Filing Section
The Filing section contains information that applies to all filings in this filing 
group.

The Filing section contains these fields:

• the Filing Type, Filing Description, Start Date, and Filing Manager

• the Custom field that has been previously configured

• the Company Reference #

Note: If you had previously entered values in the Edit Filing screen, and then try to 
change the values in the Filing section, or the NAIC Filing Description in the 
filing group section, you will be asked which values you want to keep. For details, 
see Overriding Filing and Filing Group Values in a Filing Profile on page 394.

Working with Filings on a Filing Profile
You can work with filings on a filing profile if you have been given the required 
permission by your Tracker Administrator.

Working with filings in a filing profile involves:

• Viewing Filings on a Filing Profile on page 391

• Editing Filings on a Filing Profile on page 393

• Overriding Filing and Filing Group Values in a Filing Profile on page 394
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Viewing Filings on a Filing Profile
You can view detailed information about the filings on a filing profile.

Method: View a filing in a filing profile

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.

2. Click the Filing Setup tab.
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3. The Filing Setup dialog box contains the following fields:

• CLS

• Company

• LOB 

• States

A table displays the following information:

• State

• Filing Type

• Filing Description

• Start Date

• Filing Manager

• Custom

• Company Reference #

• NAIC Filing Description

Related Topics
• Editing Filings on a Filing Profile on page 393
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• Overriding Filing and Filing Group Values in a Filing Profile on page 394

Editing Filings on a Filing Profile
You can edit detailed information about the filings on a filing profile if you have 
been given the required permission by your Tracker Administrator.

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.

2. Click the Filing Setup tab.

3. Double-click a filing to open it. Alternatively, select a filing, then click Edit 
Filing.
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4. In the Edit Filing screen, you can view or make any necessary changes to 
the following fields:

• State – you cannot change this field

• Filing Type

• Filing Description

• Start Date

• Filing Manager

• Custom

• Company Reference #

• NAIC Filing Description

5. To save your changes, click OK.

6. After completing all the required fields (marked with asterisks), you can 
click Accept to accept this filing profile into Tracker. For more information, 
see Accepting Filing Profiles on page 396.

7. A confirmation message appears indicating that the filing profile was 
successfully created or modified. You are asked where you want go next. 
Make a selection then click OK.

You are taken to the location you selected.

Overriding Filing and Filing Group Values in a Filing Profile
You can edit the values for a specific filing using the Edit Filing screen. However 
if you do this, and then later return to the Program/Filing Group Setup tab, the 
following message will appear if you try to change a value in the Filing section:

Are you sure you want to overwrite previous selections made on the Filing 
Setup tab with your current selection?
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You have the following choices:

• click Yes to overwrite the filing value (entered on the Edit Filing screen) 
with the filing group value you just selected

OR

• click No to keep the filing value (entered on the Edit Filing screen) and 
discard the filing group value you just selected
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Accepting, Suspending, or Rejecting Filing 
Profiles

While working with a filing profile, you can Accept, Suspend, or Reject it.

This section describes:

• Accepting Filing Profiles on page 396

• Suspending Filing Profiles in Tracker on page 397

• Rejecting Filing Profiles in Tracker on page 398

Accepting Filing Profiles
You can only accept a filing profile in Tracker

• after entering all the required information as described in  Viewing and 
Editing Filing Profiles in Tracker on page 379

AND

• if you have been given the required permission by your Tracker 
Administrator

If you accept a filing profile, then the filing is created in Tracker, based on the 
data in the filing profile. You can continue to work with the filing as you work 
towards submitting it to the appropriate state DOIs.

Method: Accept a filing profile in Tracker

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.
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2. Ensure you have completed all the required information as described in 
 Viewing and Editing Filing Profiles in Tracker on page 379.

3. On the Profile Processing Screen, click Accept.

Tracker creates the filings based on the filing profile.

Suspending Filing Profiles in Tracker
At any time while you are working on a filing profile, you can click Suspend to 
cancel all your changes, if you have been given the required permission by your 
Tracker Administrator.

Method: Suspend a filing profile in Tracker

Warning: When you suspend a filing, all your changes are discarded. However, the filing 
profile will remain on My Profile or All Profile tabs.

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.
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2. On the Profile Processing Screen, click Suspend.

You are asked where you want go next. 

3. Make a selection then click OK. 

You are taken to the location you selected.

Rejecting Filing Profiles in Tracker
While working on a filing profile, you can reject it if you have been given the 
required permission by your Tracker Administrator.

Rejecting a filing profile sends it back to Launcher to be reviewed and modified. 
You must therefore enter the reason why you are rejecting the profile. The person 
updating this filing profile in Launcher will review your reason for rejection of the 
filing profile and can modify the filing profile accordingly so that it can be 
accepted.

Method: Reject the filing profile in Tracker

1. If you do not already have a filing profile open, go to the top level of 
Tracker, click the My Profiles or All Profiles tab, then double-click a filing 
profile to open it.

The Process Filing Profile dialog displays.
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2. On the Profile Processing Screen, add a comment explaining the reason 
you are rejecting this filing profile. (For details, see Adding Filing Profile 
Comments on page 386.)

3. Click Reject.

The profile is immediately rejected. (No confirmation message appears.) 
The profile is returned to Launcher and a notification is created in Launcher 
indicating that this filing profile has been rejected. You are asked where you 
want go next. 

4. Make a selection then click OK.

You are taken to the location you selected.
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Chapter 12
Working with the Regulatory 

Specialist

This chapter introduces and explains the Regulatory Specialist component of 
Tracker. The Regulatory Specialist contains all the state and line of business 
specific regulatory information used by Tracker to ensure that your filings meet 
every requirement.

This chapter describes:

• The Regulatory Specialist on page 402

• Regulatory Specialist Tabs on page 405

• Regulatory Specialist Reports on page 416
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The Regulatory Specialist

The Regulatory Specialist database contains important information regarding state 
statutes and regulations as defined by the individual state Departments of 
Insurance.

Note: Canadian provincial filing requirements, if any, are not supported in the 
Regulatory Specialist.

The Regulatory Specialist window contains the following tabs:

• File Statute on page 405

• General on page 407

• Filing Forms on page 409

• Dept. Addresses on page 411

• Contacts on page 411

• RS Custom Fields on page 413

• SERFF on page 414

Related topics:
• Using the Regulatory Specialist on page 402

• Updating and Changing Information in the Regulatory Specialist on page 
404

Using the Regulatory Specialist

The Regulatory Specialist can be accessed from any point in the system at any 
time.

Method: Use the Regulatory Specialist

1. Select View > Regulatory Specialist.

The Regulatory Specialist dialog displays.
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If you access the Regulatory Specialist while working within a filing, the 
tabs will automatically be populated with information pertaining to the filing 
you are working in. If you were not working within a filing, or you want to 
view other information, adjust the values in the Settings section for Line of 
Business, Type of Filing, and Filing Content as applicable:

• State – the State to which this information applies. There is one record 
for each of the 50 states, as well as Puerto Rico, the US Virgin Islands, 
Guam, American Samoa, and the District of Columbia.

• LOB – The Line of Business to which this information applies.

• Filing Content (Filing Forms and Dept. Addresses tabs) – the content 
of the filing, such as Rate or Form, or any combination of these.

2. Wait for a few seconds while Tracker locates and displays the information.

3. View the required information. If you double click on some fields, a dialog 
box containing more information on that field will display.

4. To search for information within Regulatory Specialist, complete the steps 
described in Performing Tracker Searches on page 424.

5. To examine a filing form in more detail:

a. On the Filing Forms tab, double-click a filing form in the list.

A Model Document Memo window opens describing the filing form.

b. To view an example of the form, click Preview.

The form is generated, and Microsoft Word opens displaying the 
example form. You can print the form if you want. When finished, close 
Word and the Model Document Memo window.

6. When finished, close the Regulatory Specialist Window.
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Updating and Changing Information in the Regulatory 
Specialist
One of the major benefits of using Tracker is that Oracle maintains and updates 
the information in Regulatory Specialist. All of the information contained within 
the File Statute, General and Filing Forms tabs is maintained and updated by us 
as changes occur. (See User Profiles on page 75 for an explanation of the update 
process, including how frequently updates are provided.) The information in 
Regulatory Specialist (with the exception of the Contacts information) cannot be 
changed within Tracker. If you find an error in the regulatory information, or feel 
that any of it needs to be changed or augmented, please contact Customer Support 
so that your suggestion can be explored and included in the next subscription 
update if required.
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Regulatory Specialist Tabs

Information in Regulatory Specialist is organized into seven tabs:

• File Statute on page 405

• General on page 407

• Filing Forms on page 409

• Dept. Addresses on page 411

• Contacts on page 411

• RS Custom Fields on page 413

• SERFF on page 414

File Statute
The File Statute tab contains information regarding state filing statutes and 
related basic regulatory information such as filing mechanics and effective date 
rules. 

The sections of this tab are:

• Settings on page 405

• Filing Statute on page 405

• Filing Exemptions on page 406

• Filing Mechanics on page 406

• Effective Date Rules on page 407

Settings
This section contains fields you use to filter the output from Regulatory Specialist.

State
This field identifies the state to which this information applies. There is one 
record for each of the 50 states, as well as Puerto Rico, the US Virgin Islands, 
Guam, American Samoa, and the District of Columbia.

LOB
This field identifies the Line of Business to which this information applies.

Filing Statute
This section contains fields with information relevant to filings for the chosen 
state and LOB.

Rate
This field identifies the Rate filing statute for this state and LOB.
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Rule
This field identifies the Rule filing statute for this state and LOB.

Form
This field identifies the Form filing statute for this state and LOB.

Filing Exemptions
This section contains fields with information relevant to filing exemptions in the 
chosen state, and for the chosen LOB. 

Rate
This field identifies the rate filing exemptions for this state and LOB, if any.

Rule
This field identifies the rule filing exemptions for this state and LOB, if any.

Form
This field identifies the form filing exemptions for this state and LOB, if any.

Filing Mechanics
This section contains fields with information relevant to special requirements for 
filings in the chosen state, and for the chosen LOB. The special requirements deal 
with such things as required formats for filings, and filing fees.

Combination Filing
This field identifies whether this state allows combination filings, that is, whether 
rates, rules, and forms can be submitted in a single filing. Possible values are: Yes, 
No, and Cross Reference Required.

Workers Compensation Filing Requirements
This field identifies Workers Compensation filing requirements for this state and 
LOB which depart from standard Property and Casualty filing requirements, if 
any.

Microfiche Requirements
This field identifies whether this state requires that filings be submitted on 
microfiche or in an alternate media format.

Company Group Filing
This field identifies whether this state allows company group filings, that is, the 
same filing for multiple companies submitted under a single filing letter.
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Form Restrictions
This field identifies whether there are form restrictions associated with making 
filings for this state, that is, whether there are restrictions on use of specific policy 
language, such as Named Driver Exclusions, and so on.

Filing Fee
This field identifies filing fees and/or retaliatory fees required by this state, if any.

Effective Date Rules
This section contains fields with information relevant to dates involved in the 
filing. 

Lead Time
This field identifies the number of days required for submission of a filing in 
advance of its proposed effective date.

Delay Time
(For use only in association with states employing a use & file statute) This field 
identifies the number of days after use within which a filing must be submitted.

Adoption Time
This field identifies the number of days that the automatic adoption of an advisory 
organization filing can be delayed without making a deviation or exception filing.

Effective Date Rules
This field identifies whether this state requires effective dates to be stated in a 
particular fashion.

Deemer Provisions
This field identifies state deemer provisions.

Hearing Procedures
This field identifies whether a company can be forced to retroactively withdraw a 
filing that has been disapproved as a result of a formal hearing, or whether a future 
date must be specified for the company to cease use of the disputed filing’s rate(s), 
rule(s), or form(s).

General
Regulatory Specialist contains a variety of general information. The General tab 
contains fields with information about assembly requirements, readability 
requirements, and policy language restrictions that are relevant to the chosen state 
and LOB. 

The sections in this tab are:
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• Settings on page 408

• Assembly on page 408

• Special Requirements on page 409

Settings
This section contains fields you use to filter the output from the Regulatory 
Specialist.

State
This field identifies the State to which this information applies. There is one 
record for each of the 50 states, as well as Puerto Rico, the US Virgin Islands, 
Guam, American Samoa, and the District of Columbia.

LOB
This field identifies the Line of Business to which this information applies.

Assembly
This section contains fields relevant to how filings must be assembled before 
being submitted.

Certification of Compliance
This field identifies whether this state requires a formal certification statement in 
the filing.

Final Printing Requirements
This field identifies whether there are state requirements for submission of the 
final printed forms.

Index of Attachments
This field identifies whether a formal index of attachments is required.

Notice of Domiciliary State Approval
This field identifies whether this state requires filings to certify that the same 
filing has been approved in the company's state of domicile.

Number of Filing Cover Letters
This field identifies the number of copies of a filing cover letter that must be 
submitted.

Number of Attachments
This field identifies the number of full sets of filing attachments (exception pages, 
forms, actuarial exhibits, and so on.) that must be submitted.
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Order of Assembly
This field identifies whether this state specifies a particular order of assembly for 
each filing.

Special Requirements
This section contains fields which detail any special requirements needed for the 
filing.

Claims Made
This field identifies whether this state restricts the use of claims made policy 
provisions.

Declarations
This field identifies special requirements for declarations pages to be filed 
(including computer issued “free form” declarations), if required.

Flesch Scoring
This field identifies readability requirements, including lines affected, required 
Flesch test scores and other readability criteria.

Number of SASE
This field identifies the number of Self-Addressed Stamped Envelopes required 
with the filing, if any.

Pay Plans
This field identifies special requirements for the filing of payment plans used in 
that state, if any.

(a) Rates
This field identifies special requirements (for example, special (a) rates) for 
handling rate submissions.

Policy Jackets
This field identifies special requirements for policy jackets, if required.

Premium Change Limits
This field identifies whether this state places restrictions on the amount of 
premium increase or decrease that can be taken within a stated time period.

Filing Forms
Regulatory Specialist contains information about every state filing form 
(including filing forms, checklists, NAIC transmittal documents, and so on) 
currently required by state Departments of Insurance. The Filing Forms tables 
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contain records for each state, line of business, and type of filing. Forms can be 
previewed from the Filing Forms tab.

The sections in this tab are:

• Settings on page 410

• Table of Filing Forms on page 410

Settings
This section contains fields you use to filter the output from the Regulatory 
Specialist.

State
This field identifies the State this information applies to. There is one record for 
each of the 50 states, as well as Puerto Rico, the US Virgin Islands, Guam, 
American Samoa, and the District of Columbia.

LOB
This field identifies the Line of Business this information applies to.

Type of Filing
The Type of Filing to which this information applies, such as Advisory, Deviation, 
Independent, Informational, Loss Cost, or any combination of these.

Filing Content
This field identifies the content of the filing, such as Rate or Form, or any 
combination of these.

Table of Filing Forms
This section contains a table of filing forms relevant to the state, LOB, Type of 
Filing, and Filing Content selected in the Settings section of the Filing Forms tab. 
The table columns are Filing Form, Description, and Form Obsolete Date.

Filing Form
This column displays a code that uniquely identifies every form within Tracker.

Note: Because state Departments of Insurance do not always assign formal numbers to 
forms, each filing form in Tracker is assigned a unique eight digit code beginning 
with INS.

Description
This column displays the title of the form, as assigned by the state DOI.

Form Obsolete Date
This column displays the date on which this form became obsolete, if any.
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Dept. Addresses
This tab of Regulatory Specialist contains information about state Departments of 
Insurance, including names, addresses, phone numbers, and e-mail and Web site 
addresses, as well as the titles of current insurance commissioners, reviewers, and 
so on.

The addresses you send your filings to may depend on the type of filing being 
submitted. Tracker’s Regulatory Specialist can accommodate multiple 
Department of Insurance addresses. Regulatory Specialist will choose the 
appropriate address based on the type of filing that has been created. The chosen 
address will automatically be added to the letter that is generated during the 
Generate Complete Filing activity.

Tip: If you are looking up the address for the department handling Workers’ 
Compensation filings, make sure that you select Workers’ Compensation as the 
Line of Business.

For information on the fields on the Dept.Address tab, see Address/Contact 
Information on page 412.

Contacts
On the Contacts tab of Regulatory Specialist, you will find the same type of 
information as on the Dept. Addresses tab, but in this section you can enter the 
information yourself and it will not get overwritten with each monthly 
subscription update.

Note: Information on the Contacts tab is for your use only. Tracker will never use this 
information when creating a filing or a filing package.
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Settings
The settings selected in this section determine which contact information Tracker 
displays on the tab.

State
This field identifies the State this information applies to. There is one record for 
each of the 50 states, as well as Puerto Rico, the US Virgin Islands, Guam, 
American Samoa, and the District of Columbia.

LOB
This field identifies the Line of Business this information applies to.

Filing Content
This field identifies the content of the filing, such as Rate or Form, or any 
combination of these.

Address/Contact Information
The following describes the fields on the Dept. Addresses and Contacts tabs. 
Both tabs contain almost exactly the same fields. The differences between the two 
tabs are noted in the field headings below.

Name (Contacts tab only)

This field identifies the Name of the person to whom this information applies.

First Name/Last Name
This field identifies the full name of the commissioner, director, chief, supervisor, 
or contact.

Title
This field identifies the formal title of the person shown in the previous fields.

Department
This field identifies the full name of the Insurance Department.

Attention
This field identifies the name of the individual or department within the state DOI 
to whose attention the filing should be directed.

Address
This field identifies the street address of the Insurance Department.

City
This field identifies the name of the city that the filing should be sent to.
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Zip Code
This field identifies the zip code the filing should be sent to.

Phone and Extension
These two fields identify the main phone number and relevant extension of the 
Insurance Department or contact.

Alt. Address, Alt. City, Alt. Zip Code, Alt. State
These fields list an alternate street, city, and zip code address for this department 
or contact (such as a mailing address or post office box).

Fax 
This field identifies the facsimile number if the Insurance Department has a 
published fax machine number.

Office Hours
This field identifies the hours that the Insurance Department office is open.

Web Site
This field identifies the URL for the Web site of the Insurance Department.

E-mail
The e-mail address is shown if the Department of Insurance has an e-mail address.

Notes
Any additional notes users want to add regarding the insurance department or this 
contact in particular are entered here. Information in this field is not affected by 
Regulatory Specialist updates.

RS Custom Fields
This tab contains ten custom free-format fields which you can use to capture filing 
information unique to your organization, and to supplement the regulatory 
information provided by Oracle.

For each state, ten custom fields are provided, but there are no LOB-specific 
custom fields. Therefore, if you need to record information for specific LOBs, you 
should enter it in the custom field.

In addition to the ten custom fields, you can also include an attachment path and 
website address with links to a document and website related to the information in 
the corresponding custom field. Clicking on these paths or URLs will open the 
document or website.
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Entering or Editing Custom Field Data
Your ability to enter data in the new fields is controlled by a permission option 
within the Security Access menu in System Defaults. This permission must be 
enabled for your security access level in order for you to be able to enter or edit 
data in the custom fields. If the permission is not enabled, you will only be able to 
view the data in the fields. Consult your Tracker Administrator regarding the 
applicable permission setting for your security access level.

Tab Name and Field Names
You can give the new RS Custom Fields tab its own name, and also assign names 
to each of the ten custom fields: see RS Custom Field Labels on page 40.

SERFF
The SERFF tab allows you to see which TOIs, sub TOIs and filing types a state is 
accepting for SERFF filings. This information is provided in real time. When you 
click the SERFF tab and select the state, Tracker connects with the Filing Rules 
server at the NAIC and returns the TOI, sub TOI and types applicable to that state. 
It also displays whether the state allows confidentiality requests, the filing fee 
information for that state (including whether the state is currently accepting EFT), 
and whether the state allows NTRs on closed filings.

1. Select View > Regulatory Specialist.

2. Click the SERFF tab.

3. Expand the TOI and sub TOI to see what kinds of SERFF filings are 
supported for that TOI and sub TOI. You will also be able to see filing fee 
information for that state— including whether the state is currently 
accepting EFT—the state’s preference for allowing NRTs on closed filings, 
and whether the state allows confidentiality requests.
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Regulatory Specialist Reports

A number of reports are available to summarize the information provided by the 
Regulatory Specialist. These Regulatory Specialist reports provide summary 
regulatory information for the various states, lines of business, and State 
Departments of Insurance in Tracker. For example, you can produce a report that 
lists detailed regulatory information for a state/line of business combination that 
you have looked up in the Regulatory Specialist section of the system.

Note: These reports are available only through the Regulatory Specialist screens and not 
via the general reports function.

For more information about the Tracker Reports function, please see Searching, 
Reporting, and Filing Summary on page 423.

For instructions regarding the generation of a Regulatory Specialist report, see 
Generating a Regulatory Specialist Report on page 420.

The following regulatory specialist reports are available in Tracker:

• Filing Requirements Summary Report on page 416

• Detailed Filing Requirements Report on page 417

• State Contact Listing Report on page 419

• Detailed State Contacts Report on page 419

Filing Requirements Summary Report
The Filing Requirements Summary Report allows you to print basic 
information provided by the Regulatory Specialist for a selected state and line of 
business. This data includes filing statute details, general filing information, 
actuarial information, and information regarding required filing forms.

This report displays the following fields:

• State

• Line of Business

• Filing Statute - Rate

• Filing Statute - Rule

• Filing Statute - Form

• Filing Exceptions - Rate

• Filing Exceptions - Form

• Filing Exceptions - Rule

• Combination Filings - whether they are allowed or not

• Workers Compensation Filing Requirements

• Microfiche Requirements

• Company Group Filings
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• Form Restrictions

• Lead Time required

• Delay Time

• Adoption Time

• Deemer Provisions

• Effective Date Rules

• Hearing Procedures

• Number of Filing Cover Letters required

• Order of Assembly

• Number of Attachments

• Index of Attachments

• Notice of Domiciliary State Approval required

• Certification of Compliance required

• Final Printing Requirements

• Pay Plans

• Declarations

• (a) Rates

• Flesch Scoring

• Claims Made

• Premium Charge Limits

• Policy Jackets

• Exhibit Requirements

• Type of Data Required

• Experience Period

• Special Requirements

• Filing Form ID

• Filing Form Description

• Filing Form Obsolete Date

Detailed Filing Requirements Report
The Detailed Filing Requirements Report allows you to print detailed 
regulatory information provided by the Regulatory Specialist for a selected state 
and line of business. This data includes filing statute details and general filing 
information. This is a more detailed version of the Filing Requirements 
Summary Report described above. It includes any additional information 
available for the fields included.



WORKING WITH THE REGULATORY SPECIALIST

418 TRACKER P&C VERSION 6.6 USER GUIDE

This report displays the following fields:

• State

• Line of Business

• State Department of Insurance (DOI) Contact Name

• DOI Contact Title

• DOI Address

• DOI City

• DOI Zip Code

• DOI Phone Number

• Filing Statute - Rate

• Filing Statute - Form

• Filing Exceptions - Rate

• Filing Exceptions - Rule

• Filing Exceptions - Form

• Filing Statute - Rule

• Combination Filings - whether they are allowed or not

• Workers Compensation Filing Requirements

• Microfiche Requirements

• Company Group Filings

• Form Restrictions

• Lead Time required

• Delay Time

• Adoption Time

• Deemer Provisions

• Effective Date Rules

• Hearing Procedures

• Number of Filing Cover Letters required

• Order of Assembly

• Number of Attachments

• Index of Attachments

• Notice of Domiciliary State Approval required

• Certification of Compliance required

• Final Printing Requirements

• Pay Plans
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• Declarations

• (a) Rates

• Flesch Scoring

• Claims Made

• Premium Charge Limits

• Policy Jackets

• Exhibit Requirements

• Type of Data Required

• Experience Period

• Special Requirements

• Filing Form ID

• Filing Form Description

• Filing Form Obsolete Date

State Contact Listing Report
The State Contact Listing Report provides a summary of all State Department of 
Insurance contacts you have entered in Tracker for a specific state.

This report displays the following fields:

• State

• Name of Contact

• Title

• Department

• Address

• City

• Zip Code

• Phone Number

• Fax Number

Detailed State Contacts Report
The Detailed State Contacts Report provides detailed information about the 
State Department of Insurance contacts for a given state.

This report displays the following fields:

• State

• Name of Department Contact

• Title
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• Department

• Attention

• Address

• City

• State

• Zip Code

• Phone Number

• Fax Number

• Email Address

• Office Hours

• Comments

Generating a Regulatory Specialist Report
The Regulatory Specialist reports are generated automatically when you click of 
the reports buttons on one of the Regulatory Specialist screens. Which report you 
generate depends on which tab you have selected, and which button you click.

Method: Generate a Regulatory Specialist report

1. To generate the Filing Requirements Summary Report, select either the 
File Statute tab or the General tab, and ensure that you have selected the 
state and line of business for which you want to generate the report. Click 

the Basic Report button  to generate the report.

To generate the Detailed Filing Requirements Report, select either the 
File Statute tab or the General tab, and ensure that you have selected the 
state and line of business for which you want to generate the report. Click 
the Detailed Report button  to generate the report.

To generate the State Contact Listing Report, select either the Dept. 
Addresses tab or the Contacts tab, and ensure that you have selected the 
state for which you want to generate the report. Click the Basic Report 

button  to generate the report.

To generate the Detailed State Contacts Report, select either the Dept. 
Addresses tab or the Contacts tab, and ensure that you have selected the 
state for which you want to generate the report. Click the Detailed Report 
button  to generate the report.

2. Tracker generates the report and a preview of the generated report appears in 
a Crystal Reports viewer window.
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3. View the generated report carefully to ensure that it meets your needs. 
If it does not meet your needs, close the preview window and select a 
different state, LOB, tab, or report button. If it is OK, proceed to the next 
step.

4. Click the Print button.

Your default printer prints your report, or click the Export button to save or 
email the report in your choice of formats.
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Chapter 13
Searching, Reporting, and Filing 

Summary

This chapter describes how to perform searches in Tracker, use the Tracker 
Reports function—including each of the standard reports that come with the 
system and instructions on how to produce a variety of reports—and display a 
Filing Summary.

This chapter describes:

• Performing Tracker Searches on page 424

• Tracker Reports on page 427

• Working with Reports on page 428

• Report Descriptions and Types on page 436

• Filing Summary for Paper Filings on page 452
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Performing Tracker Searches

You can search Tracker to locate a specific filing, activity or other item.

The following procedure describes the general steps required to perform a Tracker 
search

Method: Perform a Tracker search

1. Click the Search button  to open the Search dialog.

2. Enter the following information into the Context section fields (select from 
the drop-down list where available):

• In the Search for field, enter the type of information you want to find.

• In the In field, enter the range limit in which you want to search for 
those records.

3. Enter the following information into the criteria fields (select from the drop-
down list where available):

• In the Field field, enter the name or type of field you want to search for 
or search by.

• In the Criterion field, enter the desired relationship between the Field 
chosen above and its specific content, chosen next (for example, if you 
want to search for certain text in a field, your criterion choice would be 
contains).

• In the remaining criteria fields (which will vary depending upon the 
criteria specified above), enter the appropriate specific information. For 
example, if your criterion field is contains, here you would specify the 
text you want the field to contain. For example, if you are searching in 
the Notice of Domiciliary State Approval fields for entries containing 
the words not required, you would enter ‘Not Required’ into the This 
text field.

4. Click Add to add the criterion you have just specified to the Criteria 
Selected list field.

5. Repeat steps 2 to 4 to add up to five criteria statements to the Selected 
Criteria list.
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6. When you are satisfied with the search criteria you have specified, click 
Search. The results of your search appear in Search Results. 

Note: If no records are found matching your search parameters, a message appears 
stating: No entries were found using the selected criteria.

7. In Search Results, you can double-click an item from the list to view it, or 
select the item and click View Selection.

OR

Click Print to open a page of the search results in your browser 

OR

Click New Search to return to the Search Parameters tab of Tracker 
Search to define a new search.

OR

Click Close to exit Tracker Search. 
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Related Topic
• Searching for a Company Group Filing on page 143

• Performing Activity Searches on page 257
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Tracker Reports

Tracker is equipped with a flexible report generation feature which allows you to 
produce a variety of standard reports based on date, sort, and criteria 
specifications you set yourself.

There are different types of Tracker reports. Each type serves a particular function 
in helping you to track your overall compliance filing process. For complete 
descriptions and details of all the available Tracker reports, see Report 
Descriptions and Types on page 436.

For details on the steps required to define and generate reports, see Working with 
Reports on page 428.
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Working with Reports

In this section, the steps used to define and generate reports are described. 
Although there are many types of reports, the procedures used to work with them 
are similar.Related topics
• Accessing the Reports Function on page 428

• Producing a Report on page 429

• Customizing the Report Name on page 430

• Defining the Date Range of a Report on page 431

• Defining the Selection Criteria of a Report on page 431

• Selecting Multiple Items in Report Parameters on page 431

• Defining the Sort Order of a Report on page 433

• Viewing a Generated Report on page 434

• Scrolling Through the Pages of the Report on page 434

• Viewing a Report at Different Sizes on page 434

• Printing a Report on page 434

• Saving Report Settings on page 435

• Exporting Reports on page 435

Accessing the Reports Function

Method: The reports function can be accessed at any time via the View 
menu.Access the Reports function

1. On the menu bar, select View > Reports.

The Reports dialog displays.
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Producing a Report
This section outlines all of the steps involved in producing and printing a report in 
Tracker. Further explanation and instructions for individual steps within this 
process follow.

Important: If you want to abort the generation of report after it begins, click the Stop Loading 
button.  Clicking the close window button instead will result in error messages 
the next time the report is generated.

Method: Produce a report

1. Access the Reports dialog.

2. On the Reports dialog, click the tab that represents the type of report you 
would like to produce.

3. Select the report you want to produce from the list of available reports.

Note: If you double-click the report or select a report and click Preview, Tracker will 
produce a report using default values. (If you have used that report before, your 
most recently used values will be used.)

4. To adjust the report values, click the Parameters button to open the selected 
report’s parameters dialog. The default parameter values are displayed. If 
you have used that report before, your most recently used values will be 
displayed.

Note: The example below is for the Forms Summary Listing; the parameters dialog for 
each report will be slightly different.

5. If the report uses date ranges, you can optionally enter From and To values 
for the Start Date and the File Date. Only records that fall within this date 
range will be shown on the report. 

Note: Date fields will not appear when the report does not require a date range.
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6. Define the Selection Criteria for the report. The fields displayed are 
appropriate to the selected report. For each field, either specify a value or 
select *All. (When a field’s value is set to *All, the field will not be used as 
a criteria for selecting records to include in the report.)

7. Define the Sort Order of the report. Beside each of the selection criteria 
fields is a number. In the Sort Order field, enter the number corresponding 
to the field by which you want the report to be sorted.

8. If displayed, customize the report’s Report Settings. Examples of Report 
Settings parameters used in some standard reports include the following:

• Suppress parts of the report

• control Page Breaks

• control use of an Additional Summary

Custom reports may include additional Report Settings parameters.

9. To generate the report with the chosen values, click OK. 

Tracker generates the report you have specified using your dates, criteria, 
and sort order, and a preview of the generated report appears in a Crystal 
Reports viewer window. (Note: Move your cursor off the screen to suppress 
the tooltip that displays.)

Note: Alternatively, to close the report parameters dialog (and save your selected criteria 
values), click Close. The report parameters dialog closes. Tracker returns to the 
Reports dialog.

10. Examine the generated report carefully. If you need to make changes, close 
the report window and redefine the report criteria.

If you do not need to make changes, proceed to the next step.

11. Click  Print Report.

The report is printed to your default printer.

Note: If your report does not print as expected, check your Printer Settings for correct 
formatting. Tip: Most reports are best printed and viewed in Portrait 
Orientation, printed on one side of the page only.

Customizing the Report Name
On some reports, you can adjust the report name. The parameter selection screen 
will retain one custom name per individual user, in addition to the default name 
for future reports. However, if you select the default name after creating a custom 
name and run the report under the default name, the custom name is deleted. Also, 
if you already have one custom name and create a second one, the second custom 
name replaces the first one.
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Defining the Date Range of a Report
When you define the date range of a report, you are simply specifying the time 
period that will be covered in the report. For example, if you were generating a 
Filings Report and you wanted it to list all filings in the system that were created 
between January 2001 and December 2003, you would input a From date of “01/
01/2001” and a To date of “12/31/2003”. The generated report would include only 
filings created within that time frame.

If you do not choose to enter a date range, Tracker will generate the report using a 
From date of 01/01/1990 and a To date of 01/01/2100.

Please note:
• Some reports do not require the specification of a date range. No date range 

entry fields will appear when they are not required.

• You can input the From and To dates using the drop-down calendars 
provided via buttons to the right of these date fields, or you may type in the 
date, remembering to use the format specified by your company.

Defining the Selection Criteria of a Report
The Selection Criteria report function allows you to filter (or choose) which 
records will appear in your report. The list of available selection criteria is specific 
to each standard report. A choice of *All usually available as the default.

Selecting Multiple Items in Report Parameters
Some of the reports in Tracker allow you to select multiple items for a given 
report parameter. This functionality allows you to, for example, select multiple 
states, lines of business, or filing managers as parameters to create a single report.

The following reports support this functionality:

• Current Filing Status Detail Report

• Forms Current Status Detail Report

• Aging Detail Report for Outstanding Filings

• Activities Detail Report

• Current Production Status Detail Report

• Production Activity Detail Report

• Average Filing Approval Time Summary Report

• Filing Fees Detail Report

• Regional Filing Status Report

• SERFF Transaction Fee Report
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Method: Select multiple items in report parameters

1. On the menu bar, select View > Reports.

The Reports dialog displays.

2. Click the Status tab.

3. Select the report you want to work with and click Parameters. (The Current 
Filing Status Detail Report is used for this method.)

The report parameters dialog displays.

4. Click the button  at the right side of the parameter.

The items dialog displays.
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5. Select multiple items within a parameter by pressing and holding the Ctrl 
key while clicking on each item you want to use with that parameter.

6. When you have finished selecting items, click OK in the items list.

7. Repeat steps 4 to 6 until you have finished setting parameters, then click OK 
in the main parameters dialog.

The report is generated based on the parameters you have selected.

Note: There is a limit of 20 individual selections per parameter. For example, you can 
only select 20 states for a given report.

Defining the Sort Order of a Report
Defining the Sort Order for a report allows you to choose the order in which 
records will be presented on the final, generated report. There are two steps 
involved in choosing your sort order.

First, you need to decide which of the Selection Criteria you want to use to sort 
your report: in a Filings Report, for example, you may want to organize your 
report by Filing Number, by Date Created, by State, or by LOB, depending upon 
the purpose of your report. Note the number located beside the selection criterion 
you have chosen.
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Second, you need to enter that number into the Sort Order field. Text and 
numeric sorts will present records in ascending order (such as by state or by the 
manager’s name starting at A and working to Z, or by filing number starting at the 
lowest number and working to the highest).

Viewing a Generated Report
After you have created and generated a report, the report appears in a preview 
window for you to view the results.

This is a typical standard report (the Forms Listing Report):

Scrolling Through the Pages of the Report
While viewing the preview of the generated report, you can scroll through the 
pages of the report using the  Back, Back to First , Forward , and 

Forward to Last  buttons found at the top of the preview window.

Viewing a Report at Different Sizes

Use the Sizing field  located at the top of the preview window to 
change the magnification view of the report. Use the drop down list to select a 
magnification, or enter a percentage manually.

Printing a Report
You can print a report right after you have previewed it to see that it meets your 
needs. This can be done from the preview window.

Method: Print a report

1. In the report Preview window, view the previewed report. Check to see that 
it includes all the information you intended.
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2. Click the Print Report button. 

The report prints on your default printer.

Saving Report Settings
Whenever you change report settings or criteria, your changes will be saved by 
the system. The next time you access that particular report dialog, the settings will 
be as you last left them.

Exporting Reports
You can export reports in any of several formats, to any of several destinations. 

Note: If you have a MAPI-compliant program like Outlook or Outlook Express already 
installed, you can export to email. Select PDF as the Format and MAPI as the 
destination. Citrix users will require Outlook or Outlook Express installed on the 
Citrix Server before they can use this feature.

Method: Export a report

1. In the report Preview window, click the Export Report button. 

The Export dialog displays.

2. Choose the export Format you want.

3. Choose the Destination for the exported data. 

4. Click OK.

The data is exported in your chosen format to the destination.
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Report Descriptions and Types

The reports available in Tracker are:

• Status Reports on page 436

• Historical Reports on page 444

• Management Reports on page 445

• Custom Reports on page 449

• Other Reports on page 451

See also Tracker Reports on page 427.

Status Reports
Status Reports provide current information about the status of the filings in your 
system. For example, you can produce a report that lists current information about 
every filing associated with a particular filing manager.

Method: Access a status report

On the menu bar, select View > Reports.

On the Status tab, the following status reports are available in Tracker:

• All - Current Filing Status Detail Report on page 436

• Current Filing Status Detail Report on page 437

• Filing Approval Notification Report on page 437

• Filing Details Report on page 439

• Filing Group Status on page 440

• Forms Current Status Detail Report on page 441

• Forms Summary Listing on page 442

• Objection Report on page 443

All - Current Filing Status Detail Report
The All - Current Filing Status Detail Report displays a listing of current filings 
and their status with state DOI. 

This report displays the following information:

• Filing Group Number

• State

• LOB

• Company
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• Filing Content

• Filing Manager

• Status

• File Date

• Approval Effective Date

• Description

Current Filing Status Detail Report
The Current Filing Status Detail Report displays filings by filing group, and 
shows the status of each filing within a filing group, the total number of filings for 
each status within a filing group, as well as the total number of filings in each 
status for the complete report.

This report displays the following information:

For each filing group:

• Program Code and Description

• Filing Group Number and Description

For each filing:

• State

• Line of Business

• Company

• Filing Content (Rate/Rule/Form)

• Filing Manager

• Filing Status

• Start Date

• File Date

• Objection Date

• Resubmission Date

• Approval Effective Date

• Disapproval Date

• Withdrawal Date

• Summary of Filings within a Filing Group, subtotalled by status

Filing Approval Notification Report
The Filing Approval Notification Report provides detailed instructions and 
information for the filing(s) specified. Use it to track and communicate 
information about approved filings.
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This report displays the following fields:

• Program Code and Description

• Filing Group Number and Description

• Filing Description

• Line of Business

• Filing Type

• Content

• State

• Filing Manager

• Company

• Approval Date

• Approved Effective Date

• Special Instructions (if any)

• Forms (if any) with the following information for each form:

• Title

• Form #

• Edition

• Replaced Form #

• State Variation

• Impacts Rates

• Requirement

• Rates (if any) with the following information for each rate:

• Title

• Rate #

• Edition

• Page #

• Replaced Page #

• Rules (if any) with the following information for each rule:

• Title

• Rule #

• Edition

• Page #

• Replaced Page #
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Filing Details Report
The Filing Details Report provides a detailed description of the status of a 
selected filing.

This report includes the following fields:

Filing

• Program

• Name

• Filing Group

• Group Description

• Filing Description

• Company Code and Description

• State

• Sequence Number

• Filing Type

• C. O. Reference Number

• Line of Business

• Content

• Manager

• Status

• DOI#

Status Dates

• Start

• Approved Effective

• Disapproved

• Objection

• Respond By

• Filed

• Approveal Received

• Resubmitted

• Request Effective Date

• Approved

• Withdrawn

• Deemer

• Days
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Print/Mail/Automation Status Dates

• Schedule Mail

• Actual Mail

• Print Status

• Rate Built

• EDP

• Rate Effective

Miscellaneous

• Filing Fee

• Check#

• Check Date

• Tracker Reference Number

• Custom

Activities

• Date

• Description

• Suspense

• Completed

• Performed By

• Memo

Publications

• Publication Number

• Adv. Org

• Effective Date

• Type

• Status

• Description

• Filing Reference Numbers 1–5

Filing Group Status
The Filing Group Status report displays a listing of filing groups and the status of 
filings.

The report displays the following information

• Program Code and Description

• Filing Group Name and Description
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• Special Instructions

For each filing:

• Company

• LOB

• State

• Content

• Seq#

• Manager

• Status

• Filed Date

• Effective Date

• Special Instructions

The Summary Status of filings includes this information:

• Number of Start

• Number of Pending

• Number of Approved

• Number of Disapproved

• Number of Closed

• Number of ReOpened

• Number of Withdrawn

• Number of Archived

• Number of Objection

• Number of Exempt

Forms Current Status Detail Report
The Forms Current Status Detail Report shows the status of all the forms that 
have been filed. You can either display all forms, or forms with selected statuses 
only. 

The report is grouped at two levels: the first level is by form number, and the 
second level is by form (not filing) status. Within each form number group is an 
entry for each instance of that form in the system, and details (including the filing 
status) of each filing with that form number.

Note: Usually the form and filing status will be the same, but not always. For example, 
there may be a situation where the form has been approved but the filing has not.

Each grouping by form number displays the following information:

• Form Number
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• Filing Group Number and Description

• Edition Date

• Form Type

Each instance of the form number displays the following information:

• State

• Line of Business

• Company

• Filing Status

• Filing Manager Initials

• Start Date

• File Date

• Objection Date

• Resubmit Date

• Approval Eff Date

• Disapproval Date

• Withdrawal Date

Forms Summary Listing
The Forms Summary Listing displays a list of filings and the forms they contain.

The report displays the following information for each filing:

• Tracker Filing Number

• Filing Description

• Company

• Program Code

• Program Name

• Filing Group Number

• Filing Group Description

• State

• Line of Business

Each form contained within the filing is then displayed with the following 
information:

• Form Number

• Edition

• Title

• Form Type
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• Requirement

• Impact Rates – indicates whether this form will impact rates

• Replaced Form

• Comments

Objection Report
The Objection Report provides a list of all filings in Objection and Resubmit 
status recorded in the system for the date range specified.

This report displays the following fields:

• Filing Group Number and Description

• State

• Line of Business

• Company

• Filing Content

• Status

• Filing Manager

• Objection/Disapproval Date

• Respond By Date

• Resubmit Date

• Objection/Response (obtained from the Activities and Memo fields)

Rate/Rule Details Report
The Rate/Rule Details Report shows a summary of all rate/rules in Tracker.

This report displays the following fields:

• Rate/Rule Number

• Advisory Organization

• Type

• Rate/Rule Title

• Exception Page Number

• Edition

• Attachment

• Replaced

• Page Number

• Edition

• Memo
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Applicability

• Company Code

• LOB

• State

• Filing Group Number

• Name

• Status

• Effective Date

Historical Reports
Historical reports provide information about approved and implemented programs 
and filings. For example, you can produce a report that lists every approved filing 
for a particular line of business.

Method: Access a historical report

On the menu bar, select View > Reports, then click the Historical tab.

The following Historical reports are available in Tracker:

• Activities Detail Report on page 444

• Publication Summary Report on page 445

Activities Detail Report
The Activities Detail Report displays existing activities in Tracker at a detailed 
level. Activities are grouped by filing group and by filing.

This report displays the following information:

• Program Code and Description

• Filing Group Number and Description

• Filing:

• State

• Line of Business

• Filing Content (Rate/Rule/Form)

• Company Code and Description

• Filing Manager

• Filing Status

• Activities:
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• Activity Description and Level (FG indicates Filing Group level 
activity, FL indicates Filing level activity)

• Activity Memo

• Activity Status

• Suspense Date

• Completion Date

• Due Date

• Performed By

Publication Summary Report
The Publication Summary Report displays a list of publication records, as 
specified, together with their internal detailed company adoption information. Use 
this report to monitor publications in your system as they are adopted.

This report displays the following fields:

• Publication Number

• Publication Date

• Description

• Type

• LOB

• Content

• Status

• Proposed Date

• Approved Date

• States

Management Reports
Management Reports provide information that managers will find useful, such as 
statistical totals and averages for the number of filings, approval percentages, the 
number of days expended, and so on.

Method: Access a management report

On the File menu, select View > Reports, then click the Management tab.

The following management reports are available in Tracker:

• Aging Detail Report For Outstanding Filings on page 446

• Current Production Status Detail Report on page 446

• Filing Evaluation Report on page 447
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• Manager Production Report on page 448

• Production Activity Detail Report on page 448

Aging Detail Report For Outstanding Filings
The Aging Detail Report For Outstanding Filings shows information on filings 
that are still outstanding. By default, filings are grouped first by period, then by 
Program, then by Filing Group. You can set the report to display outstanding 
filings from a date of your choice by typing it in the field, or by selecting one of 
the following:

• Start Date

• Filing Date

• Most Recent Date of Start Filing, Objection, or Resubmit Date

Each Filing Group displays this information:

• Program Code and Description

• Filing Group Number and Description

Each filing displays this information:

• State

• Line of Business

• Company

• O/S Days

• Filing Content (Rate/Rule/Form)

• Filing Manager

• Filing Status

• Start Date

• File Date

• Objection Date

• Resubmit Date

Current Production Status Detail Report
The Current Production Status Detail Report shows the production activity at 
up to two levels of grouping and sorted up to two ways.

Grouping can be done by company and filing manager, with summaries if you 
want. Within a grouping, you can sort by status and Filing Group. The summaries 
show the number of filings with the states of Start, Pending, Objection, Approved, 
Disapproved, Withdrawn, or Closed.

This report displays the following information:

• Filing Group Number and Description
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• Filing Manager

• State

• Line of Business

• Company Code(s)

• Filing Status

• Filing Content

• Start Date

• File Date

• Objection Date

• Resubmit Date

• Approval Date

• Disapproval Date

• Withdrawal Date

Filing Evaluation Report
The Filing Evaluation Report provides management information about filings 
under development. It lists information about filings, grouped by filing group.

This report displays the following information:

• Program Name

• Filing Group Name, Description, Number, and Manager

Each filing listed includes the following information:

• Company

• Line of Business

• State

• Content

• Sequence Number

• Type

• Manager

• Status

• Start Date

• Filed Date

• Approval Date

Under the heading of Days To:

• Filed (number of days between Start Date and Filed Date)
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• Approved (number of days between Start Date and Approved Date / number 
of days between Filed Date and Approved Date)

• Effective (number of days between Start Date and Effective Date / number 
of days between Filed Date and Effective Date)

• Disapproved (number of days between Start Date and Disapproved Date / 
number of days between Filed Date and Disapproved Date)

• Withdrawn (number of days between Start Date and Withdrawn Date / 
number of days between Filed Date and Withdrawn Date)

Manager Production Report
The Manager Production report lists the monthly production for each selected 
Filing Group Manager.

For each month with activity, the report lists the following:

• # Started and %

• # Pending and %

• # Exempt and %

• # Objection and %

• # Disapproved and %

• # Withdrawn and %

• # Approved and %

• # Closed and %

• # Other and %

• # Total and % 

Production Activity Detail Report
The Production Activity Detail Report lists the activities performed within a range 
of Suspense Dates and Completion Dates. The activities listed can be grouped by 
the different type of activities and by the Filing Manager.

For each grouping, the report lists the following:

• State

• LOB

• Company Code(s)

• Filing Content (Rate/Rule/Form)

• Filing Status

• Activity Memo

• Activity Status

• Suspense Date
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• Due Date

• Completion Date

• Performed By

Custom Reports
The Custom Reports tab contains a selection of specialized reports. This tab also 
contains reports that have been created specifically for your company.

Method: Access a custom report

On the menu bar, select View > Reports.

On the Custom tab, the following reports are available in Tracker:

• Average Filing Approval Time Summary Report on page 449

• Filing Fees Detail Report on page 449

• SERFF Transaction Fee Report on page 450

Average Filing Approval Time Summary Report
The Average Filing Approval Time Summary Report lists the average number 
of days taken by the state DOI to approve SERFF, paper filings, and filings of 
either type. The report displays the average for all filings for each state. By 
adjusting the Group By parameters, the report can display the results for each 
filing group within each state as well.

Filing Fees Detail Report
The Filing Fees Detail Report report lists detailed filing fee information with 
summaries within a specified date range: Transaction Date/Check Date or Filed 
Date. The listing can be grouped by up to two of the following: Company, Filing 
Group, LOB, Program. Totals can be displayed as well.

This report displays the following information:

• Transaction Date

• State

• Filed Date

• Line of Business

• SERFF Tracking ID

• Tracker Filing ID

• TOI

• Sub TOI

• Type (Initial or Additional)
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• Amount

• EFT Transaction ID

• Authorized By

• Total Number of Transactions

• Total Amount

Regional Filing Status Report
This report provides the filing status for all filings by state or region. You can 
group the results by Company, LOB, or state, and totals will be displayed for each 
group.This report includes the following information:

• State

• Company

• LOB

• Company Ref #

• Filing Description

• Status

• Filed Date

• Effective Date

• Last Activity Description

• Last Activity Date

SERFF Transaction Fee Report
The SERFF Transaction Fee Report list all filings that have been submitted to 
SERFF, allowing you to track and reconcile the transaction fees charged by the 
NAIC.

This report does not distinguish between single company filings and CG filings. 
Any company involved in any filing during the reporting period is included on the 
report and listed in the Company column. 

Note: If two filing managers have exactly the same initials, when you select either using 
the report parameters, both filing managers will appear on the report. To prevent 
this, in the user profile of one of the filing managers, change the initials so the two 
are not exactly the same.

This report displays the following fields:

• Company/NAIC Code

• Filed Date

• Filing Manager 

• State
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• LOB

• Filing Content

• SERFF Tracking ID

• Tracker Filing ID

• TOI

Other Reports
The following reports are not part of the general reports and are available only to 
certain users:

• Administrative Reports on page 451

• Regulatory Specialist Reports on page 451

Administrative Reports
Administrative Reports provide administrative level information about the 
companies, users, and programs in your system. For example, you can produce a 
report that lists authority information for every company in your system.

Note: These reports are available only through the Administration menu and not 
through the general reports function, and are accessible only to users having the 
requisite security clearance (usually Administrator level or higher).

For more detailed information on Administrative Reports, please see 
Administrative Reports on page 106.

Regulatory Specialist Reports
Regulatory Specialist Reports provide summary regulatory information for the 
various states, lines of business, and State Departments of Insurance in your 
system. 

Note: These reports are available only through the Regulatory Specialist screens and not 
through the general reports function.

For more detailed information on Regulatory Specialist Reports, please see 
Regulatory Specialist Reports on page 416.
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Filing Summary for Paper Filings

The Filing Summary is an excellent way to generate a comprehensive snapshot of 
paper filings. (For information on Filing Summary for SERFF filings, see Filing 
Summary for SERFF Filings on page 345.)

There are two parts of the Filing Summary that can be optionally displayed and 
printed: Filing Details (both single company and CG versions), and Filing 
Correspondence.

This section contains:

• Filing Detail (Paper Filings) on page 452

• Filing Correspondence on page 454

Related topic: 
Generating a Filing Summary on page 348

Filing Detail (Paper Filings)
The Filing Detail part of the Filing Summary displays detailed information about 
the selected filing.

In the header:

• Tracker Filing ID / Company Reference # 

• State

• Filing Company (first filing company for CG filings)

• State Tracking Number

• LOB

• Filing Type

• Filing Explanation (based on Filing Description field)

• Program Name (based on what is in the Program Name field at the time the 
Filing Summary is generated)

• Project Name/Number (based on what was in the Projuct Name/Number 
field at the time the Filing Summary is generated)

• Filing Group Name

In the Filing Overview section:

• Company Name and Company Code (All companies for CG filings)

• Program Name (based on what is in the Program Name field at the time the 
Filing Summary is generated)

• Tracker Filing ID / Company Reference #

• State

• LOB
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• Filing Status

• State Tracking #

• Filing Statute

• Filing Type 

• Filed Date

• Filing Explanation (based on Filing Description field)

• Filing Manager

• Requested Effective Date

• Approved Effective Date

• Requested Renewal Effective Date

• Approved Renewal Effective Date

In the General Information section:

• Program Name (based on what was in the Program Name field at the time 
the Filing Summary is generated)

• Status of Filing in Domicile

• Project Number (base on what was sent to SERFF or is in the Project 
Number field at the time the Filing Summary is generated)

• Domicile Status Comments

• Reference Organization (based on what was sent to SERFF or is in the 
Reference Organization field at the time the Filing Summary is generated) 

• Reference Number (based on what was sent to SERFF or is in the Reference 
Number field at the time the Filing Summary is generated)

• Reference Title – Publication

• Advisory Org. Circular – Publication

• SERFF Status Changed (date)

• State Status Changed (date)

• Deemer Date

• Tracker Status Changed (date)

• Related Filing ID (number and type)

• NAIC Filing Description

In the Company and Contact section: (for each company in CG filings)

• Filing Contact Information:

• Filing Manager Name

• Filing Manager Title

• Filing Manager Email Address
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• Filing Manager Address

• Filing Manger Phone Number 

• Filing Manager Fax Number

• Filing Company Information:

• Company Name

• NAIC Company Code

• State of Domicile

• Company Address

• NAIC Group Code

• Company Type

• Group Name

• State ID Number

• Company Phone Number 

• FEIN Number 

In the Filing Fees section, these fields display if required:

• Fee Required

• Fee Amount

• Retaliatory

• Fee Explanation

• Per Company

• Check Number

• Check Amount

• Check Date

• Company

• Amount

• Date Processed

• Transaction #

Note: If the fees are spread across multiple companies in a CG filing, the check or EFT 
information is listed for each company underneath each other in a table format.

In the State Specific section:

• State Specific information

Filing Correspondence
The Filing Correspondence section of a Filing Summary for paper filings contains 
a Summary part, and a Filing Correspondence Details part.
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The Summary part displays these items for each correspondence activity:

• Filing Correspondence Description

• Tracker Filing ID/Company Ref #

• Date

The Filing Correspondence Details part contains the detail for each activity 
listed in the above Summary. Each activity’s detail is followed by the attachment 
from the activity’s Attach File field (if present), then the rest of the activity’s 
attachments (documents).
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Chapter 14
Viewing Filings and 

Attachments for Schedule Items 
in the DMS

If you have a document management system (DMS), you can view the following 
within the DMS:

• a listing of filings showing each filing’s status

• a listing of schedule items associated with a filing

• the status of each attachment

Note: The only attachments that are shown in the DMS are attachments that are stored in 
the DMS. Attachments that are stored in a file systems will not display.

The types of schedule items that can be displayed in the DMS are as follows:

• rates

• rules

• forms

Using the search capabilities of the DMS, you can search for filings or rates, rules, 
and forms that match your search criteria.

This chapter describes:

• The Search Interface on page 458

• Searching for Filings on page 460

• Searching for Rates, Rules, and Forms on page 463

• Viewing Rate, Rule, and Form Statuses on page 465

• Clearing Search Parameters on page 466

Note: The screens on your system may differ from those shown in this guide.
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The Search Interface

The following kinds of search mechanisms exist in the search interface for filings 
and schedule items:

• Drop-Down Menus on page 458

• Drop-Down Menus with Manual Text Entry on page 458

• Date Search Menus on page 459

Drop-Down Menus
Drop-down menus contain a list of all available entries from the existing data for 
the given search parameter.

In the above example, all available filing statuses are entered automatically in the 
drop-down menu and can be used as the choice for that search parameter. 

Drop-Down Menus with Manual Text Entry
Some drop-down menus allow you to enter a search string as part of the search 
parameter.
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In the above example, you can search for the Filing Description by entering text 
found at the beginning of the description.

Date Search Menus
Some search parameters involve the dates of statuses associated with filings or 
attachments.

In the above example, you can search for filings with a Start Date of January 1, 
2009.
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Searching for Filings

You can search for filings using a variety of criteria. This method is a convenient 
way to see the status of a filing or filings.

Method: Search for a filing

1. Log in to the DMS.

2. Under the heading Tracker, click Filings. 

The Search Tracker Database screen displays with the Search for Filings 
tab selected.

3. Enter any combination of criteria you want to use to narrow your search and 
click Search.

The Filings Search Result page displays.
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The status of each filing displayed is shown in the Status column.

Viewing Rates, Rules, and Forms
On the search results screen, you can view rates, rules, and forms associated with 
a filing by clicking on the folder icon  at the far right. You can also view the 
states and LOB for any rate, rule, and form.

Method: View rates, rules, and forms

1. On the Filings Search Results screen, click the folder icon at the far right of 
the filing. 

The contents of a folder containing all the attachments for that filing 
displays.
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2. To view the status of that attachment’s schedule item, click the arrow and 
select Tracker Status.

A list of the states and LOBs associated with this attachment’s rate, rule, or 
form appears.

3. Click the Details link to view the list of dates applicable to this rate, rule, or 
form.
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Searching for Rates, Rules, and Forms

Using the DMS, you can search for and view a filing’s rates, rules, and forms, 
view their attachments, and check their status.

Method: Search for rates, rules, and forms

1. Log in to the DMS.

2. Under the heading Tracker, click Forms, Rates, etc. 

The Search Tracker Database screen displays with the Search for Rates/
Rules/Forms tab selected.

3. Enter any combination of criteria you want to use to narrow your search and 
click Search.

The Filings Search Result page displays.
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Viewing Rate, Rule, and Form Statuses

The status of some rates, rules, and forms can correspond to multiple dates. The 
following table summarizes the relationship between statuses and dates:

When you view the status of a rate, rule, or form, in all cases the Corresponding 
Date from the above table will be displayed in the DMS.

You can view rate, rule, and form statuses by searching for rate, rule, and form. 
The status is displayed in the Status column.

Status Corresponding Date 
Conditions/Rules for Determining 
Date 

Disapproved Disapproved Date Same as Corresponding Date

Objection Objection Date Same as Corresponding Date

Start Start Date Same as Corresponding Date

Withdrawn Withdrawn Date Same as Corresponding Date

Approved Approval Date Approval Date has been entered, 
Deemer Date has not

Approved Approved Effective Date Approval Date and Approved 
Effective Date have both been entered

Approved Deemer Date Approval Date and Deemer Date have 
both been entered

Pending Filed Date The Filed Date will be displayed when 
there is a Start Date but no Objection 
Date or Resubmitted Date

Pending Resubmitted Date The Resubmitted Date will be 
displayed when there is a Filed Date 
and an Objection Date
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Clearing Search Parameters

After entering multiple search parameters, you might want to clear all parameters 
to enter new ones.

Method: Clear search parameters

On the search screen, click the Refresh button in your Web browser, or press F5. 
The current set of search parameters is cleared.
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Appendix A
Troubleshooting

This chapter reviews potential problems you might have with Tracker, and some 
possible solutions. If the methods described in this chapter do not resolve your 
problem, please contact Customer Support. (See  on page 32 for contact details.)

This chapter describes:

• Troubleshooting Tracker on page 468

• SERFF — Filing in Limbo on page 469
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Troubleshooting Tracker

This section describes troubleshooting the following areas:

• Viewing Activities in the Filing Package on page 468

• Deleting Activities in the Filing Package Tab on page 468

• Filing Forms Do Not Generate on page 468

• Updating Subscriptions or Services Causes Error Message on page 469

See also: SERFF — Filing in Limbo on page 469.

Viewing Activities in the Filing Package

Problem
Trying to view a document within an activity in the Filing Package tab displays 
the following error message:

This file does not have a program associated with it for performing this 
action. Create an association in My Computer by clicking View and then 
clicking Options.

Solution
You need to install Adobe Acrobat Reader 5 or higher to be able to view the 
document. Adobe Acrobat Reader is available at http://www.adobe.com.

Deleting Activities in the Filing Package Tab

Problem
Trying to delete an activity under the Activity Tab that has been moved to the 
Filing Package tab displays the following error message:

This activity has been moved to the filing package and cannot be deleted.

Solution
You do not have a user access level that allows you to delete activities from the 
Filing Package tab.

Filing Forms Do Not Generate

Problem
Trying to generate a filing form displays the following error message.

Error (2): Unable to generate document INS00562.
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Solution
This message appears only if the filing form is missing in the 
Tracker\Repository\Model Documents folder. Verify that your installation 
of Tracker had no errors. Contact Customer Support if you think the installation 
was correct.

Updating Subscriptions or Services Causes Error 
Message

Problem
You receive the following error message when trying to load a monthly update:

Wrong ‘Tracker Load’ file or the update period in the ‘Tracker Load file is 
different.

Unable to continue. Options or dates mismatch.

Solution
Check to make sure you are loading the correct monthly update. If not, you will 
receive the error message above.

SERFF — Filing in Limbo

Problem
A “filing in limbo” is a filing where the SERFF activity was successfully 
completed and moved to the Filing Package, but no log entry was received, nor 
has the SERFF status of the filing advanced. Here are two examples:

• SERFF: Generate/Submit to SERFF: After performing this activity, if 
Tracker receives a status update for this filing, the Move to Filing Package 
check box will remain locked. If no status message for the filing is received 
after four hours, the check box will unlock.

• SERFF: Submit Filing Amendment, SERFF: Submit Objection 
Response, and/or SERFF: Submit Note to Reviewer: After performing 
one of these activities, if the item is successfully submitted, the Move to 
Filing Package checkbox will remain locked. If the item is not successfully 
submitted, the checkbox will unlock after four hours.

Solution
After Tracker unlocks the Move to Filing Package check box, you can move the 
activity out of the filing package by clearing the check box and closing the 
activity. This results in one of two possible outcomes:

• If the filing is no longer in the queue, Tracker will change the status of the 
activity to FAILED. For Filing Amendments, NTRs and Objection 
Responses, Tracker will also change the status of these items under the 
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Correspondence tab to DRAFT. If you need to edit, change, or delete any 
data or attachments, you must delete the activity with which they are 
affiliated.

• If the filing is still in the queue, this error message will appear: “The activity 
could not be moved out of the filing package as it’s still in the queue to go to 
SERFF. Please check with your system administrator to ensure that the 
Tracker monitor is functioning properly.”

Note: You must not go back into a FAILED activity; you must perform the activity 
again.
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INDEX

Symbols
(a) rates, 409

Numerics
99999, creating filing groups past, 123

A
accepting filing profiles, 396
access levels

assigning user, 53
defining security, 52
titles, security, defining, 51

active activities
and status changes, 230
detail records, deleting, 244
overview, 230

activities
active

and status changes, 230
overview, 230

codes
table, 84

completing, 242
recurrent, 244

detail
active records, deleting, 244
passive records, deleting, 244
report, 444

filing package tab, 249
for multi-filing, performing, 259
in filing package

adding, 249
tab, deleting, 468

multi-filing, 259
On Approval option, 237
overview, 230
passive, 230
performing

basic, 235
method, 235

post activities, 230
posting, 238
reassigning, 105
records, editing, 241
recurring filing, creating, 98
search

options, 257
performing, 257

specific filing, 214

standard
SERFF, 234
Tracker, 232

suspense, 36
tab

filing, 214
filing group, 231
publication, 368

viewing in filing package, 468
activity codes

active, adding, 91
changing, 94
deleting, 97
obsoleting, 95
overview, 90
passive, adding, 90
reactivating, 95

ad hoc regulatory specialist updates, configuring, 41
address

field, 412
information section, 412

administration module, 25
administrative reports

generating, 108
overview, 451
types, 106

adoption time, 407
advisory organizations, 84
affiliation criteria, profile configuring, 48
aging detail report for outstanding filings, 446
All Profiles tab, fields, 378
All SERFF Messages tab, 316
alternate

address/city/zip code/state, 413
alternate long filing letter, 352
amendments, filing, see filing amendments
assembly

order, 409
section, 408

attaching documents, 253
attachments

adding or editing rule in filing group, 181
index of, 408
other, see other attachments
tab, CLS, 383
types, 84

attention field, 412
authenticating user IDs and passwords, 37
authorities listing report, 107
authority information
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entering company, 59
authority levels, EFT fee, 70
average approval time summary report, 449

B
browsing

filing records, 136

C
certification of compliance, 408
Changing, 220
check payments, filing fee, editing, 204
city field, 412
claims made, 409
closed filings, 343
CLS

Attachments tab, 383
Dates tab, 383

codes
activity

table, 84
company, 56
filing group, 122

combination filing, 406
comments

adding to filing letter, 213
filing profile, 384

adding, 386
viewing, 384

tab, 213
company

adding, 54
authority information

entering, 59
codes, overview, 56
deleting, 63
general information

entering, 56
group filing fees, allocating EFT, 294
group filings

adding, 142
and filing forms, 216
generating filing forms for, 144
in regulatory specialist, 406
overview, 142
searching, 143
viewing companies in, 142

in company group filings, viewing, 142
information, 54

overview, 54
records, accessing, 64

listing report, general, 106
programs

creating, 116
working with, 116

resource information, entering, 62
viewing on filing profile, 382
with authorities listing report, 107

company program
deleting, 118
editing, 117

compliance certification, 408
contacts

listing report, state, 419
section, 411

correspondence letter, 352
current

filing status detail report, 437
production status detail report, 446

custom
fields

data, entering or editing, 414
labels, defining and editing, 87
overview, 87

LOBs, mapping to standard, 99
reports, 449
tables

elements, deleting, 89
entering information into, 88
tasks, performing, 87
understanding, 83
viewing, 87
working with, 83

custom tables
changing information in, 88

D
date

ranges of reports, defining, 431
search menus, 459

Dates tab, CLS, 383
declarations, 409
deemer provisions, 407
defaults

system
settings, SERFF, 66

system, overview, 35
system, settings tab, 35

delay time, 407
department

addresses
section, 411

field, 412
description field, 410
detailed

filing requirements report, 417
state contacts report, 419
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displaying filings with suspense activities, 
configuring, 36
disposition reports

contents, 340
viewing, 340

DMS
using with Tracker, 27

document conventions, 20
documentation, supporting, filing requirements in 
filing, 280
documentation, Tracker, 29
documents, attaching to filings, 253
documents, replacing generated, 222
draft SERFF filings, generating, 308
drop-down menus

manual text entry, 458
overview, 458

E
edited documents, printing, 224
effective date rules

field, 407
section, 407

EFT
additional payments, 300

submitting, 341
company group filing fees, allocating, 294
fee authority levels, 70
filing fee details, adjusting, 299
paying filing fees via, 291
transaction

information, viewing in filing, 294
status, 300

e-mail, 413
error updating subscriptions or services, 469
exporting reports, 435

F
fax, 413
fee authority levels, EFT, 70
field labels, custom, 38
fields

custom, see custom fields
data, custom, entering or editing, 414
labels

defining and editing custom, 87
names, 414

file statute
section, 405

filing activities
creating recurring, 98
performing procedures, 246
specific, 214

filing amendments
creating, 327
deleting, 331
editing, 330
submitting, 332

filing approval
activity, performing, 254
notification report, 437

filing attachments, overview, 253
filing content

Contacts tab, 403
Filing Forms tab, 410, 412

filing correspondence, SERFF filing, 348
filing detail, filing summary, SERFF, 345
filing details

entering, 140
tab, 140

filing evaluation report, 447
filing exemptions section, 406
filing fee details, adjusting EFT, 299
filing fee field, 407
filing fees

allocating EFT company group, 294
check payments, editing, 204
detail report, 449
entering, 203
paid by check, entering, 203
paying via EFT, 291

filing form field, 410
filing form, generated, editing and replacing, 220
filing forms

and company group filings, 216
changing, 220
deselecting, 162, 179, 216
deselecting for printing, 162, 180, 217
editing, 216
generating for company group filings, 144
information, entering, 215
not generating, 468
order, changing, 219
printing before or after filing letters, 218
section, 409
selecting, 162, 179, 216

for printing, 162, 180, 217
tab, 215
viewing, 216

filing forms tab, 215
filing group tabs, viewing, 122
filing groups

adding, 120
code

entering, 122
overriding, 122

creating in multi-user environment, 123
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creating past 99999, 123
overriding values in filing profile, 394
program setup fields, 389
records, accessing, 122
section, 390
settings, changing, 121
viewing specific program, 121
working with, 120

filing header, 137
filing letters

alternate long filing letter, 352
comments

comments tab, 213
field descriptions, 354
overview, 249

comments, adding, 213
correspondence letter, 352
creating, 356
follow-up filing letter, 352
information in, 248
list of types, 352
long filing letter, 352
objection letter, 353
overview, 351
printing filing forms before or after, 218
sample, 246
short filing letter, 352
withdrawal letter, 352

filing mechanics, 406
filing method (rate), 84
filing module, 22
filing package

adding activities, 249
tab

and activities, 249
deleting activities from, 468

viewing activities in, 468
filing profiles

accepting, 396
comments, 384

adding, 386
viewing, 384

details, viewing, 381
editing, 379

filings on, 393
filings and, 390
initial type, 380
list, viewing, 377
new type, 381
notification, 378
overriding values in, 394
process, 376
program/filing group information, 388
rejecting, 398

suspending, 397
types, 380
viewing, 379

filings on, 391
filing records, accessing from filing group, 135
filing references tab, 367
filing requirements

report, detailed, 417
summary report, 416
supporting documentation in filing, 280
workers compensation, 406

filing resources
entering, 212
resources tab, 212

filing statuses
detail report, current, 437
searching, 460

filing statute section, 405
filing statutes, 226
filing summaries, generating, 348
filing summary

overview, 345
SERFF

filing correspondence, 348
filing detail, 345

filing tabs, 139
filing types, 84, 410

selecting for filings en masse, 267
selecting in filings, 276

filing updates, SERFF status, 313
filing values, overriding in a filing profile, 394
filings

adding new, 126
browsing, 136
closed, 343
combination, 406
creating from publication, 369
generating, 253
in limbo, 469
multiple, generating and printing, 260
printing, 253
section, 390
submitting to SERFF, 310
with suspense activities, configuring display, 36

filtering My Filings - All tab, 135
final printing requirements, 408
first name, 412
Flesch score, 409
follow-up filing letter, 352
form field

in Filing Exemptions section, 406
in Filing Statute section, 406

forms
adding or editing in filing group, 147
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current status detail report, 441
display section, 410
not generating, 468
obsolete date, 410
restrictions, 407
searching, 463
statuses, viewing, 465
summary listing report, 442
tab

filing group, 147
types, 85
viewing, 461

forms, enabling, 162, 179

G
general

company
information, entering, 56
listing report, 106

instructions, filing level, working with, 284
requirements, 407

generated
documents

printing one copy of, 223
reprinting all, 225

letters, editing, 221
reports, viewing, 434

generating
draft SERFF filings, 308
filing forms for company group filings, 144
filings, 253
multiple filings, 260

group
names, defining, 35

H
header, filings, 137
hearing procedures, 407
help, online

see online help
historical summaries, 444

I
index of attachments, 408
index, using in online help, 31
information records, accessing company, 64
initial filing profile type, 380

L
last name, 412
lead time, 407
letters

filing, information in, 248

generated, editing, 221
sample filing, 246

letters, see filing letters
line of business, see LOB
linking related filings, 193
Links tab, 366
LOB

change a mapping, 101
in

Contacts tab, 403
Filing forms tab, 410, 412
Filing Statutes tab, 405
General tab, 408

mapping
custom and standard, 99
overview, 87

multiple and SERFF filings, 100
multiple LOBs to a custom LOB, mapping, 102
viewing on filing profile, 382

log entries, SERFF, 311
logging in

overview, 111
login

password, changing, 113
Tracker, 112

long filing letter, 352

M
management reports, 445
mapping custom LOBs to standard LOBs, 99
messages

deleting, 318
managing, 315
SERFF, 311
types, 311

microfiche requirements, 406
modules of Tracker, 22
monitor settings, 45
multi-filing

activities, 259
posting activities for, 259

multiple LOBs and SERFF filings, 100
My Filings - All tab

accessing, 133
filtering, 135

My Profiles tab, fields, 378
My SERFF Messages tab, 316

N
name

Contacts tab, 412
first and last, 412

new filing profile type, 381
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notes field, 413
notes to filer

receiving, 344
SERFF, 315

notes to reviewer
creating, 319
deleting, 321
editing, 321
sending, 343
submitting, 321
working with, 319

notice of domiciliary state approval, 408
notification of new filing profiles

method, 378
number of

attachments, 408
filing cover letters, 408
SASE, 409

O
objection

letters
SERFF, 315

reports, 443
responses

creating, 334
deleting, 338
submitting, 338

objection letter, 353
objection letters

viewing, 332
objection responses

editing, 338
office hours, 413
online help

index, using, 31
navigating, 31
printing topics, 32
searching, 30
table of contents, using, 31
using, 30

order of assembly, 409
other attachments

adding or editing in filing, 198
adding or editing in filing group, 195
creating revised, 324
filing group tab, 195

outstanding filings, aging detail report, 446

P
passive activities, 230
passive activity detail records, deleting, 244
passwords

authenticating, 37
changing, 113

pay plans, 409
payments, additional EFT, 300, 341
phone number/extension, 413
policy jackets, 409
post activities, 230
posting activities

filing or filing group, 238
multi-filing, 259

premium change limits, 409
print status, 87
printing

edited documents, 224
filing forms before or after filing letter, 218
filings, 253
generated document, one, 223
multiple filings, 260
reports, 434
requirements, final, 408

Process Filing Profile dialog box, 379
production status detail report, current, 446
profile affiliation, configuring, 77
profiles

affiliation criteria, configuring, 48
user, see user profiles

programs
company, 116
creating company, 116
filing group

information in filing profile, 388
setup fields, 389

section, 389
viewing filing groups for, 121

provinces, displaying or hiding, 36
proxy

server settings, configuring, 71
proxy settings, 46
public access

setting values, 290
publication

status, 86
publications

adding copy of, 373
adding or removing states from, 364
creating filings from, 369
details

information, entering and editing, 366
main screen, 365
tab, 365, 366

link, adding, 367
overview, 24
references, adding, 227
reports, 374
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summary report, 445
tab

overview, 227
type, 86

R
rates

(a) rates, 409
details report, 443
exceptions, viewing or changing in filing, 170
filing

exemptions, 406
statues, 405

filing group tab, 164
information, entering in filing, 170
rate/rule

details report, 443
searching, 463
statuses, viewing, 465
viewing, 461

or changing in filing, 170
reassigning activities, 105
recurrent activities, completing, 244
recurring filing activities, creating, 98
references, adding publication, 227
Regulatory Specialist

Canadian Provincial Data, 402
regulatory specialist

accessing, 402
ad hoc updates, configuring, 41
custom fields

labels, changing, 40
tab, 413

information, updating and changing, 404
overview, 24
reports

generating, 420
overview, 451
overview and types, 416

sections, 402
update server, configuring Tracker to access, 45
updates, accessing, 44
updates, overview, 41

rejecting filing profiles, 398
related

filings, linking, 193
publications, 227

reports
administrative

overview, 451
types, 106

custom, see custom reports
date ranges, 431
descriptions and types, 436

disposition, 340
exporting, 435
function, 428
management, 445
other, 451
overview, 24, 427
parameters, selecting multiple items, 431
printing, 434
producing, 429
saving settings, 435
scrolling, 434
selection criteria, 431
SERFF, 315
sort order, 433
viewing generated, 434
working with, 428

requirements
bypassing for filings en masse, 273
bypassing in filings, 287
filing level

removing, 287
satisfying, 285

general, 407
previously bypassed, satisfying, 325
retrieving for filings, 280

en masse, 269
satisfying for filings en masse, 271
special section, 409
user added, see user added requirements
viewing in filing, 283

resources
filing, entering, 212
information for companies, entering, 62
tab, 212

Retrieving, 269
RS Custom Fields tab, 413
rules

adding or editing in filing, 186
and rule exceptions, 181
attachments, adding or editing filing group, 181
filing

exemptions, 406
statute, 406

filing group tab, 181
rule/rate details report, 443
searching, 463
statuses, viewing, 465
viewing, 461

S
sample filing letter, 246
SASE, 409
schedule items

form, rate, etc., revising, 323
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schedule items, state status updates, 314
schedules

form
viewing, 306

rate/rule
viewing, 307

scrolling reports, 434
search

activity options, 257
interface, overview, 458
parameters, clearing, 466

searching
company group filings, 143
filing statuses, 460
rates, rules, and forms, 463
Tracker, 424

searching the online help, 30
security access

levels
configuring, 51
defining, 52
titles, defining, 51

security, system, 50
selection criteria of reports, defining, 431
SERFF

activities, standard, 234
configuring Tracker for, 66
default system settings

configuring, 68
overview, 66

filing default options, 67
filing details fields, 303
filing summary, overview, 345
filings

details, viewing, 302
generating draft, 308
monitoring, 311
multiple LOBs, 100
reviewing, 302
working in filing, 276

filings, working with en masse, 267
help with, 26
integration, 26
log entries, 311
messages

content, 311
identifying new ones, 316
monitoring, 311
viewing, 317

messages, hide, 67
notes to filer, 315
objection letters, 315
overview, 264
reports, 315

schedule item attachment formats, configuring, 72
specific security settings, 50
SPI

log on ID, 66
password, 66

status filing updates, 313
submitted filings

procedures for working with, 319
submitting filings to, 310
subtabs, 265
tab

banner, 265
in filing, 265
in regulatory specialist, 414

transaction fee report, 450
troubleshooting, 469
URLs, 67

SERFF filings
monitoring, 311

services, error updating, 469
setting up Tracker first time, 34
settings

filing profile-specific security, 50
generic security, 50
proxy, 46

settings section
File Statute tab, 405
Filing Forms tab, 410, 412
General tab, 408

settings tab, system defaults, 35
short filing letter, 352
sort order of reports, defining, 433
special requirements section, 409
SPI, SERFF password, 66
standard

LOBs, mapping custom LOBs to, 99
SERFF activities, 234
Tracker activities, 232

state
adding from publication, 364
contact

detailed report, 419
listing report, 419

Contacts tab, 403
File Statute tab, 405
Filing Forms tab, 410, 412
General tab, 408
removing from

publications, 364
schedule item status updates, 314
specific values, entering in filing, 289
viewing on filing profile, 382

status
changes and active activities, 230
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reports, 436
SERFF filing updates, 313

sub TOIs
selecting

en masse, 267
in filing, 276

submitting
filing amendments, 332
filings to SERFF, 310
notes to reviewers, 321
objection responses, 338

subscriptions
error when updating, 469

summary
historical, 444
listing report, 442

supporting doc filing requirements, 280
supporting doc schedule items, creating revised, 324
suspending filing profiles, 397
suspense activities, configuring display, 36
system

defaults, overview, 35
defaults, settings tab, 35
security, 50
settings

SERFF default, configuring, 68
SERFF default, overview, 66

T
tab name for RS Custom Fields tab, 414
table of contents, using in online help, 31
tables

elements, custom, deleting, 89
tasks, 87

title, 412
TOI

selecting
en masse, 267
in filing, 276

Tracker
configuring

for SERFF, 66
regulatory specialist access, 45

DMS, using with, 27
documentation, 29
integration with SERFF, 26
modules, 22
searches, performing, 424
setting up first time, 34

training, 28
transaction

fee report, SERFF, 450
information, EFT, viewing in filing, 294
status, EFT, 300

troubleshooting, 468
troubleshooting SERFF, 469
types of filings, 410

U
updates

regulatory specialist, 41
updates, regulatory specialist, accessing, 44
updating

errors, 469
user

access levels, assigning, 53
IDs, authenticating, 37
listing report, 107
profiles

adding, 75
changing, 80
deleting, 81
overview, 75

user-added requirements, creating in filing, 288

W
web site field, 413
withdrawal letter, 352
workers compensation requirements, 406

Z
zip code, 413
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